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Getting Started.

Welcome to ArtRage.

In this manual you will find instructions for installing and unlocking your copy 
of ArtRage, a ‘How To Paint With ArtRage’ guide to get you started and teach 
you the basics of the product, and a full reference covering all the features of 
the product in detail.

If you want to learn more about the product, share paintings and tips, or find 
additional tutorials you can visit the ArtRage Forums.

Thank you for purchasing ArtRage, we hope you have a great time painting!

- The ArtRage Team.

Installing ArtRage.

Whether you have downloaded ArtRage or received it on CD you should have 
an Installer File that can be used to install the product on your computer.

If you have any problems installing ArtRage with these instructions please visit 
the ArtRage Support Page to request support. You may find that an instant 
solution to your problem can be found on that page.

For Mac OS X Users:

The ArtRage installation file is a Disk Image file (‘dmg’). Double click the file 
and a folder will appear containing the ArtRage Application and an 
Applications Folder shortcut.

Drag the ‘ArtRage 4’ application from the folder to the Applications icon to 
install it. Once the ArtRage application is in your Applications folder the 
software is ready to run.

For Windows Users:

This ArtRage installer file is a Windows Installer executable (‘exe’) file so 
when you double click it your operating system’s Windows Installer will open 
and present installation options for the product.

Follow the instructions in the installer to install the product. Once the installer 
has finished installing you can find ArtRage in your Start Menu.

Unlocking ArtRage

Before you can use ArtRage you will need to unlock it using your Serial 
Number. Your Serial Number is a 25 digit number that you should have 
received when you purchased the product.

If you purchased ArtRage from us online your Serial Number will be in the 
email that contains your product download link. If you received ArtRage on CD 
you will need to check the CD cover or the contents of the box it came in.

When you start ArtRage for the first time you will be presented with the Unlock 
Panel. If you follow the instructions on this panel, enter your Serial Number 
then click OK the product should be unlocked.

If you enter your Serial Number and it does not work please check the number 
you are entering carefully to make sure there are no mistakes. If you received 
the number in an email you can copy it from the email and paste it in to the 
panel using the button provided. If that still does not work please use the 
ArtRage Support Page to request support.

Getting Started
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Registering Artrage Online.

When you have successfully entered your Serial Number you will be asked if 
you want to register your copy of ArtRage in the Member Area.

Please Note: You only need to register your copy of ArtRage 
once! If you have already registered this version, you can just 
cancel the Register prompt.

Registering your product allows you to download the installer again in the 
future if you need it, and allows you to recover your Serial Number if you lose 
it. Product updates are only available to users who have registered their 
product.

If you are not connected to the internet when you are prompted to register, or 
if you want to register later you can do so using the ‘Register ArtRage Online’ 
option in the Help Menu.

Languages.

ArtRage is available in different languages. When you start the application it 
attempts to identify the language of your operating system and adapt to it 
automatically if it is supported.

If you find that ArtRage is not showing the correct language you can use the 
‘Select Language’ option in the ArtRage Help  Menu to select the language you 
want to use. By default ‘Auto Detect Language’ is active, this is the option that 
makes ArtRage find the language using your operating system settings.

Getting Support for ArtRage.

If you have any problems with ArtRage you can get technical support from the 
ArtRage Support Page. You can also use the ‘ArtRage Support’ option in the 
ArtRage Help Menu.

If you contact us for technical support please make sure to include clear 
details of what the problem is, when it occurred, and any error messages you 
saw. You should also include the operating system you are using and the 
exact version of ArtRage. This will help us provide answers rapidly.

You may also find that your question has already been answered. When you 
use the Support Page you will be provided with a set of answers that may be 
appropriate for your situation. Please read these carefully as they may provide 
an immediate solution.

You can also get support on the ArtRage Forums.

ArtRage Forums.

The ArtRage Forums are the home of the ArtRage user community. If you 
register for the forums you can join in discussion about the software and art in 
general, get tips and tricks for the product and upload your artwork for 
comment.

Getting Tutorials.

The forums are a great place to go if you are looking for tutorials. The Tips 
and Tricks forum is filled with helpful advice and users are happy to provide 
assistance if you need it.

You can also find tutorials on the ArtRage Website Tutorials Page.

Getting Started
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How to Paint with ArtRage.

So you have started ArtRage and you have a blank canvas on the screen - 
What do you do now? Fortunately it’s so easy to get started painting that the 
only problem you’ll have is deciding what to paint. This is what we call a 
‘happy problem’!

This section explains the basic features of ArtRage including the three most 
important ones: How to choose a tool and color, how to paint a stroke, and 
how to save your work. The methods you learn here should give you enough 
of an understanding of the tools and options in ArtRage that you can go 
exploring and discover the rest of the features in your own time.

ArtRage is like a well stocked artist’s toolkit - You don’t need to 
use everything in the kit to get good results so don’t worry about 
pressing every button and using every tool.

Painting on your computer is a bit different from painting on a real canvas with 
real paint, so here are some golden rules to remember when you get started:

1. Every time you start ArtRage, a blank canvas is created for you so you can 
start painting immediately.

2. Every time you lift the brush up it is automatically reloaded with paint so 
you don’t need to dip  it in anything to get more color before you paint a 
new stroke.

3. Every paint stroke you make can be undone if you don’t like how it looks, 
so don’t be afraid to try something and get it wrong a few times!

Finally, the most important rule of all: Don’t let the software get in the way of 
your creativity! Experiment with tools and colors and don’t worry about 
breaking anything, ArtRage won’t let you get into trouble as you play around!

Selecting a Tool.

All of your painting tools are stored 
in the Tool Picker on the left hand 
side of the ArtRage window.

Click one of the tool icons and that 
tool will be selected.

The currently selected tool is lit up. 
In the image to the left, the 
Watercolor tool has been selected.

Tip: There is always a tool selected, so when you first start the 
application you can just start painting.

In the left hand corner you can see a preview of the currently selected tool. 
You can also see the size of the tool head. Click and drag in this box to 
change the tool size, or single click in it to enter the size manually.

How to Paint with ArtRage
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Selecting Colors.

The other thing you need to know is how to select colors. Full information can 
found in the Colors section but here are the basics.

In the bottom right hand corner of 
your ArtRage window is your Color 
Picker. The Color Picker lets you 
pick what color you are going to 
apply to your painting. Picking a 
color on a computer isn’t quite like 
picking it in real life but it’s similar.

In real life you select the basic color 
you want then select another color 
to blend with it to make an exact 
color. In ArtRage you do something 
similar because the Color Picker is 
split in to two sections.

Around the outer edge of the Picker there is a rainbow spectrum of basic color 
(‘Hue’). Click and drag inside this rainbow to select the basic color you want to 
use. For example, if you want a Green of any kind you click in the green area 
of the spectrum.

The inner, large curve shows you the current basic color you selected and a 
range of brightnesses and intensities (‘Luminance’ and ‘Saturation’). Click and 
drag in this section to choose how bright or how grey you want your green to 
be.

When you click in either section, the small color sample in the bottom right 
corner of the Color Picker updates to show the exact color that will be loaded 
on your brush head when you paint the next stroke.

If you want your green to be a bit more yellow, you can click and drag in the 
rainbow spectrum towards the yellow tint. The large curve area updates when 
you do this? Now you can select the exact brightness of yellowy-green you 
want and the color sample updates to show the result.

So selecting colors involves:

1. Picking a basic color from the rainbow.

2. Picking how bright or grey you want it from the mixing area.

3. Watching the color sample so that you know what color you have selected.

Painting a Stroke.

Once you have selected a Tool and a Color, painting a stroke is simple: Just 
click and drag on the canvas! If you are using a mouse, hold down the left 
mouse button as you drag. If you are using a stylus on a graphics tablet you 
should only have to touch the stylus to the tablet and drag. If you are using a 
touch screen device, touch the screen with a single finger and drag.

As you drag, a stroke is created following the path you paint. When you 
release the mouse button, or lift the stylus or your finger from the drawing 
surface, the stroke ends.

Your tool is automatically refilled with paint every time you finish a stroke so 
you can just click and drag again to paint a new stroke of the same color.

If you hold down Cmd (Mac OS X) / Ctrl (Windows) when you 
click and hold to paint, a perfectly straight line will be generated. 
Hold down Shift as well and this line will rotate in 15 degree 
increments as you move the mouse.

Realistic Paint.

Paint in ArtRage isn’t just flat color, it has its own thickness and wetness and 
other properties that work like they do in the real world. This means you can 
work with paint on the canvas the way you would if you were working with real 
tools: Smearing thick paint around to create new colors through blending, and 
smudging dry paint to create blurred edges. Some tools even know how much 
paint is loaded on to the head, so they run out over the length of a single 
stroke!

How to Paint with ArtRage
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If you paint with a wet medium your paint can be blended with other wet paint. 
If you paint with a dry medium it won’t blend with other paint, but you can 
smudge it after you have finished painting.

Thick wet paint such as oil paint will also spread over the Canvas and run out 
as you spread it further. This means you can control whether you apply paint 
thickly in small areas, or draw it out over large areas to spread it thinner.

When paint blends its color may change depending on 
what you are blending it with. Two colors will blend to 
create a new one as you mix them, and if you keep 
blending, more of the new color will be created. As you 
smear paint over the canvas it thins out and will 
eventually go dry.Imagine smearing real oil paint: The 
thick blob  you started with gets thinner as you spread it 
over a larger area.

Wet tools that apply thin paint such as a wet marker 
pen or watercolor can still blend with other colors as 
they pass over them. Watercolor strokes will merge 
with other watercolor strokes as they get closer and 
the wet areas of the strokes touch.

If you paint a stroke of wet paint over a stroke of dry 
paint the two colors will not interact. Dry paint does not 
blend with other paint that passes over it.

Some paint tools have limited amounts of paint on 
them with each stroke. As you paint they may run out 
of pigment and the stroke will end. To ‘re-fill’ the tool, 
just start a new stroke and more paint will be loaded 
on to it.

Dry strokes won’t spread over your Canvas if you paint 
over them, but you can still use the Palette Knife tool 
to Smudge them, like using a finger to smudge a pencil 
line on paper.

Thick paint can be made dry too. If you paint a stroke 
of Insta-Dry Oil Paint you can paint another stroke on 
top and the colors won’t blend. Notice how the bristle 
lumps on the bottom stroke show through the bristle 
lumps of the top stroke.

Undo and Redo.

ArtRage has one big advantage over real painting: You don’t need to worry 
about making mistakes because you can Undo any action you have 
previously taken. The Undo option allows to completely erase the last action 
you took, even if you blended a stroke in with other paint. You can continue to 
Undo through as many actions as you like.

You don’t even need to worry about making mistakes when you Undo! The 
Redo option allows any action you just removed with Undo to be put back in 
to your painting, so you can change your mind after Undoing if you realize you 
wanted the change after all.

Undo and Redo allow you to experiment without fear of damaging your 
painting.

Saving Paintings.

When you have finished your painting, or you are ready to take a break, make 
sure to Save your work so that you can get it back later. Full information on 
how to do this is found in the Working with ArtRage Files section but for now, 
just select Save Painting from the File Menu and select a name for your 
painting. ArtRage has created a folder for your painting to be saved in so that 
you can find it later.

How to Paint with ArtRage
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Sharing Paintings.

ArtRage Painting Files (.ptg files) contain lots of information that most image 
applications don’t understand, like the thickness and wetness of your paint. 
This means that you can’t share your paintings with other people just by 
giving them a copy of the painting file unless they are also using ArtRage.

If you want to share your artwork online, or send images to friends who aren’t 
using ArtRage, you will need to save a copy of your painting file in a common 
image format. This is done using the Export Image option in the File Menu.

For full instructions on how you can export copies of your painting as an 
image file that can be viewed in other applications, see Importing and 
Exporting Images below.

Final Notes.

This section explained the basics of painting in ArtRage, but there is much 
more to discover. The rest of this manual goes through all of the features in 
detail and explains how they work. As you explore the product, just remember 
that you can Undo anything you do so don’t be afraid to try things out!

How to Paint with ArtRage
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The ArtRage Interface.

This section explains where you can find the tools and options you will need 
while painting, what the various types of control in the products are and how 
they work, and how to change the layout of your workspace.

The ArtRage Window.

When you open ArtRage a window appears that contains the Canvas and a 
number of objects that are arranged around the edge.

Around the edge of the window you will find a collection of control items: 
Large ‘Panels’ that contain sets of controls, and smaller ‘Pods’ that give you 
quick access to important functions without getting in the way of your painting.

Pods are placeholders for panels, click one and it expands to display the 
appropriate panel. Close the panel and the pod will appear again. ArtRage 
manages the layout of these items for you so you don’t need to worry about 
moving things around.

The empty area of the window is your Canvas, the surface you paint on. 
When you start ArtRage a new Canvas is created that is the same size as the 
window so you can start painting right away.

As you paint, any panels and pods on the screen will get out of the way of 
your stroke, so don’t worry if you are painting close to a corner, the controls 
will vanish as you approach to make sure you can continue working. They will 
reappear when you end the paint stroke.

Pods.

Each pod has its own specific functions, but there are two main things you 
can do with all of them:

1. Click to open the Panel the pod contains.

2. Click and hold to trigger a command menu containing common options for 
the controls the Pod represents, without needing to bring up the full Panel.

Some pods provide other forms of interaction. For example the Color Pod can 
be clicked and held down on to get a popup color picker, and the Tracing Pod 
will load a Tracing Image the first time it is clicked. These functions are 
detailed in the section for each Panel and Pod combination later in the 
manual.

Pods are gathered in to groups of similar functions:

1. On The Top: The Menu Pod contains the Menu Bar for making application 
wide changes.

2. On The Left: The Stickers, Stencils, Settings, Tools, and Presets Pods 
represent the things you use to change your painting.

The ArtRage Interface
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3. On The Right: The Layers, Tracing, Refs, Color, and Samples Pods 
represent color and helper functions.

Panels.

Panels contain most of the in depth functions in ArtRage. There are two types 
of Panels that can be opened when you click a Pod: Floating Panels that can 
be freely positioned anywhere on the screen, and Docked Panels that are 
attached to the edges of the screen by default.

Panels that are Floating have a grey title-bar at the top, while Panels that are 
docked have a Collapse Button that is used to close them.

Panels that are Floating have a grey 
title-bar at the top.

Panels that are docked have a 
Collapse Button that is used to 
close them.

There are three Docked Panels and they are visible by default when you first 
start ArtRage: The Menu Bar, the Tool Picker, and the Color Picker. These 
panels sit on the sides beside the other Pods and their position is managed 
automatically by ArtRage.

The other Panels are all Floating Panels, so they can be moved wherever you 
like, including a second monitor if you have one. Floating Panels can also be 
scaled and rotated so you can lay them out however you want.

The exact functionality of each Panel is covered in detail later on in this 
manual, but there are some controls that apply to all of them.

Manipulating Floating Panels.

The grey title-bar at the top  of any Floating Panel can be used to manipulate it 
in a number of ways, including moving it, changing its scale, and rotating it. At 
any point you can right click the title-bar to get a menu of options that allow 
you reset any changes you make. 

To manipulate a Panel with its title-bar:

1. Move the Panel: Click and drag on the title-bar and the Panel will move.

2. Scale the Panel: Hold down Command (Mac OS X) / Control (Windows) 
and click and drag on the title-bar and the Panel will scale. You can 
increase its scale to 200% or reduce its scale to 25% of its original size.

3. Rotate the Panel: Hold down Option (Mac OS X) / Alt (Windows) and 
click and drag on the title-bar and the Panel will rotate. If you also hold 
down Shift the panel will rotate in 15 degree increments.

4. Options Menu: Right click the title-bar to get a menu of options including 
a reset option to undo any changes you have made. The ‘Jauntify!’ option 
applies a random small rotation to your Panel to give it a jaunty angle!

5. Close the Panel: If the Panel has an ‘X’ button in its title-bar you can click 
this to close it.

Some Panels allow you to change their size by expanding 
or collapsing their area (as opposed to changing their 
overall scale).

These Panels have a Sizing Grip  at the bottom. To 
change the size of the Panel, click and drag the Sizing 
Grip  up  and down. Panels that can be resized in this 
manner have a minimum size to prevent them going too 
small.

The ArtRage Interface
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Manipulating Docked Panels.

Docked Panels are stuck to the edge of the ArtRage window like Pods, and 
when they expand or collapse the Pods around them shift to make best use of 
the available space. Because they are docked, these Panels are fixed in place 
and cannot be moved using a title-bar.

The Collapse Button at the corner of the Docked Panel allows you to close the 
Panel once it is open. Click once to close the Panel.

Right click the Collapse Button on a Docked Panel to get a menu of options 
for scaling the panel. A Docked Panel cannot be rotated, but it can still be 
scaled using this menu.

Docked Panels can also be disconnected from the edge and converted to 
Floating Panels. If you find that you want to place them somewhere else for 
ease of access, or just to get them out of the way, you can right click the 
Collapse Button and select the ‘Tear Off Edge’ option to tear the Panel off the 
ArtRage window and float it.

When a Docked Panel has been torn off, you can use its Close Button to 
move it, scale it, and rotate it as if it was the title-bar of a Floating Panel. The 
Close Button will not collapse the Panel if it is floating in this manner.

To reattach a Docked Panel to the ArtRage window, just right click the Close 
Button again and select ‘Stick To Default Edge’. This will return it to its original 
position.

The Canvas.

The Canvas sits underneath the Panels and Pods in the ArtRage window and 
is the area upon which you apply paint. When you start ArtRage the Canvas 
fills the window completely, but as you paint you may find you want to move, 
rotate, or zoom so that important bits of your painting are in the center of the 
screen. 

There are a number of ways to manipulate the Canvas, including shortcut 
keys and a Canvas Positioner that can be left open if you find you are making 

frequent adjustments. Detailed instructions on manipulating the Canvas can 
be found in the Canvas section.

The ArtRage Interface

15



Interface Controls.

There are a number of types of basic control used in the ArtRage interface. 
This section looks at each control type and the shortcuts you can use with 
them.

Buttons.

Click a button and it will perform the action indicated by its label. Buttons that 
open popup menus are marked with the Menu Icon.

Sliders.

Sliders allow you to click and drag to set their value, or click the text item to 
enter the value manually. If there is more than one slider on a panel you can 
press the Tab key while editing its value to select the next one, or Shift + Tab 
to select the previous.

Toggles.

Toggles are simple on/off switches. The current state of the control is 
indicated by the colored tint. Click anywhere on the toggle to change the 
state.

Popup Lists.

Some settings have a large list of potential values. Popup  List controls can be 
clicked to generate a popup  menu containing all the value options. The arrow 
on the right indicates that there is more information to be had by clicking the 
control.

Preset Blocks.

Some panels have areas that contain information about presets or other 
components of the panel. These blocks contain an image preview of the 
content, sometimes a name, and an arrow indicating that more information 
can be found by clicking. Click anywhere in the block for options related to its 
contents.

Type Selectors.

Type Selectors show a preview of a small range of settings. Click the setting 
you want and it will become active. The name of the setting you have chosen 
is indicated at the top right of the control.
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You can also right click the Type Selector to get a list of all of its options in 
popup menu form.

Tabs.

Tab  controls let you select settings that change the nature of the contents of 
the panel. Just click a tab  and the panel contents will update to reflect the 
change.

Tooltips.

Most items that do not have a text label in 
ArtRage have a Tooltip. Just hover the mouse 
over an item and a small text tip  will appear 
telling you what the item is.

You can adjust the time you need to hover before the Tooltip  appears in the 
Interface section of the ArtRage Preferences Panel. See Preferences for more 
information.

Collapsible Categories.

Some sets of controls in ArtRage are large enough that they are divided in to 
Collapsible Categories. Each category has a title and an arrow indicating if it 

is open or closed. Click anywhere in the grey title-bar of the category to open 
or close it.

Popup Color Picker.

Popup Color Pickers are used when you want to get 
quick access to a color without worrying about being too 
precise.

They let you quickly select the Hue, Luminance, and 
Saturation of a color with a single click and drag. They 
appear when the mouse button is pressed, and vanish 
when it is released.

When the Popup Color Picker appears, the Current 
Color sample is under the pointer. This is the color 
that is currently selected for whatever option 
spawned the picker.

Without letting go of the mouse button, drag around 
the color selection area of the picker. As you drag 
over the different areas the New Color sample 
changes to indicate the color that will be selected 
when the mouse button is released.

Dragging around the horseshoe ring in the color selection area changes the 
Hue of your color. Drag from there in to the diamond area and you can 
change the Luminance and Saturation. Typical color selections start with Hue 
selection, then the pointer slides to the diamond and the details of the color 
are selected.

If you want to undo your change, just drag the pointer over the Current Color 
sample and release the mouse button, the color will not change.

Holding down Shift while the Popup Color Picker is visible 
prevents the color changing as you move the mouse. This means 
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you can move your pointer around to a spot without making any 
changes if you wish, then release Shift and the New Color 
updates immediately.

Resource Pickers.

Many of the custom resources you can use in ArtRage, such as Stencils and 
Stickers, are chosen from a Resource Picker. Resource Picker panels present 
a list of specific types of resource sorted in to groups for ease of organization.

On the left of the picker is a list of available groups. Click a group  and the right 
hand side of the picker will update to indicate all of the available objects in 
that group.

Some Resource Pickers have special group  types such as Favorites. These 
groups are always listed at the top  of the panel and sit above the scrolling list 
of custom groups.

At the top of the Picker you will find buttons for adding groups and adding 
items to existing groups. These buttons may vary depending on the nature of 
the resource type.

Editing Resources.

Resources that you have added to the panel can be removed or renamed. 
Right click an item for a list of options available.

If the item has a lock icon next to it it cannot be edited, these 
items were installed by the application.

Cursors.

ArtRage lets you select from three different styles of cursor depending on how 
precise you want to be:

Tool Cursors: These cursors take on the appearance of 
the tool you are currently using. The tip  of the tool is where 
the tip of the cursor will apply paint.

Outline Cursors: These cursors show you the outline 
shape of the tool head where you are about to apply paint. 
Some tools that do not have Tool Cursors automatically 
use Outline Cursors.

Precise Cursors: These cursors are small crosshairs that 
show the precise point where your stroke will begin. When 
Outline Cursors are too small to display accurately, 
Precise Cursors are automatically used.

You can choose which type of cursor to use in the ‘Cursors’ section of the 
Preferences Panel.
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Working with ArtRage Files.

Paintings you create in ArtRage store a lot more information than normal 
image files, including how much paint there is on the Canvas and how wet it 
is. This means that ArtRage uses a special file format to ensure that this 
information isn’t lost when you save your work. These files (Painting Files or 
PTG files) can’t always be understood by other applications.

This section of the manual explains how to create ArtRage files, how to save 
them and how to reload them, print them, and export them in a format you can 
share with other people. Most of these options can be found in the File Menu.

Creating a New File.

When you open ArtRage it displays a fresh Canvas ready for paint but if you 
want to create one of a different size, or if you want to create a new file while 
you are working you can do so using the ‘New Painting’ option in the File 
Menu. When you select this option, the New Painting Panel appears. This 
panel lets you create a new painting and set up its properties.

The top  section of the panel is used to 
set the size of your new painting.

The bottom section is used to set the 
paper or canvas type you want to 
paint on, and load any Tracing Image 
you may want to work with.

The following sections explain how 
these various options work.

Painting Size.

ArtRage lets you choose a size for your painting either by selecting how large 
it will appear on the screen (Screen Size) or by how large it will be when you 
print it (Print Size). Clicking either Screen Size or Print Size changes the 
controls in the panel to reflect the correct options for the selected mode.

Regardless of the mode you select, the grey information stripe just beneath 
the controls will tell you what values the other mode will have for your 
currently entered values.

Printing size can be confusing if you’re not used to it. For more information on 
selecting sizes and how this relates to printing, see the section on File Size 
and Printing. 

Screen Size Mode.

To select a size in Screen Size mode, enter the width and height of the 
painting you wish to create in the Width and Height boxes. If you wish to use 
the size of the ArtRage window click ‘Use Window Size’. If you have loaded a 
Tracing Image you can also choose to use the size of that image.

When you are setting the size in Screen Mode you can also enter the Pixels 
Per Inch resolution that will be used for printing. Entering a value in this box 
does not change the size of your image, it changes the size the image will be 
when printed. In the grey information stripe you will see how big your painting 
is going to be when it is printed taking into account this value.

Size Presets.

Beneath the Screen Size / Print Size tabs is a Presets menu button. If you 
click that button you will be presented with a list of preset sizes. If you select a 
size preset its properties will be applied to the panel.

If you want to add a new size preset for your current settings select Add New 
Size Preset. You will be prompted to enter a name for the new preset. Enter 
the name you want and click OK.
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If you wish to manually add or remove files from your collection of Canvas 
Presets you can use the ‘Open User Size Presets Folder’ option to see the 
location on disk where your custom presets are stored.

If you are not sure what the settings mean or if you think you 
have made a mistake you can always select ‘Reset Size To 
Default’ from the presets menu.

Print Size Mode.

Selecting a size in Print Mode involves selecting the Units you wish to use 
from the ‘Measure In’ menu, and entering the size in the Width and Height 
boxes using those units.

For example, you might want a painting that will be 10 cm by 10 cm when 
printed. To do this you would select Centimeters from the ‘Measure In’ menu, 
and enter 10 in the Width and Height boxes.

You will also need to know the resolution you will be using to print. This is 
entered in the Pixels / Inch box. The term ‘PPI’ (‘Pixels per Inch’) or 
‘DPI’ (‘Dots per Inch’) is used to indicate how many dots are placed down in 
each inch of paper, and in general the higher the number goes the clearer the 
image is.

If you wish to print your image at 300 DPI, just enter 300 in the Pixels / Inch 
box and ArtRage will calculate how big it needs to make the Canvas.

Whenever you make a change to one of the values in the Print Mode controls 
the grey information stripe will update to tell you how many pixels wide and 
high ArtRage has to make your Canvas to match the print size you have 
requested. Please be aware that very large files take lots of memory and 
slower computers may have problems painting on them.

If you are new to print sizes see File Size and Printing later on in the manual.

Canvas and Tracing Section.

When you have selected the size you want your new file to be you can select 
a Canvas Texture and a Tracing Image for it using the controls below.

The Canvas preview shows you the texture and color you have selected for 
your Canvas. Click the preview to open the Canvas Texture Panel where you 
can select a new texture or create your own. For more information on this 
panel see Canvas Properties. The menu button beside the preview allows you 
to select a Canvas Texture Preset from the list of available presets if you wish.

The Tracing Image preview shows you the Tracing Image you currently have 
loaded for the new file. By default there is none, but if you click the preview or 
select ‘Load Tracing Image’ from the menu button next to it you can load an 
image. If you want to clear the image you can use the menu button next to the 
preview.

When you have finished setting up your new file, click OK to create it, or 
Cancel to cancel and return to your previous work.
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Saving a File.

Before you quit ArtRage or start working on a new painting you should save 
any work you have done on the previous painting to make sure you can get it 
back later. The ArtRage Painting file format allows you to save your painting 
so that it can be reloaded without losing any of its information.

To save a painting, just select ‘Save Painting’ from the File Menu. What 
happens when you select this depends on whether you have saved the 
painting before. If you have, the painting will automatically be saved and 
replace the previously saved version. If you have not, you will be asked to 
enter a name for the painting and choose where to save it.

If you wish to save a copy of your painting, without overwriting the previous 
copy, just select ‘Save As’ from the File Menu.

If you attempt to quit, create a new file, or load an existing file while you have 
a current painting loaded that has unsaved changes you will be asked if you 
wish to save before you continue. At this point you can either choose to save 
the changes you have made, discard the changes and continue, or cancel so 
that you can check your changes and save manually.

Files saved by ArtRage are of the type ‘PTG’, Painting files.

Always use Save to save your paintings, don’t be tempted to use 
Export as if it was Save, Exported files do not contain all the 
information needed to keep painting later on!

ArtRage can automatically save backups of your files whenever 
you save. To read about this feature, see Store Backup Files in 
the Preferences section of the manual.

Loading a File.

If you want to load a painting you have on disk you can select ‘Open Painting’ 
from the File Menu. This allows you to locate and select the file to load.

If you have loaded the file recently you may also be able to locate it in the 
‘Recent Files’ popup  under the File Menu. Select it there to load it if you can 
see it.

This option is for loading ArtRage Painting files only, to load a non ArtRage 
file, use the Import option as explained below.

You can also load a painting file by dragging it on to the ArtRage 
window.

Importing and Exporting - How to Share Your Paintings.

As mentioned previously, ArtRage Painting files contain lots of data that is not 
understood by normal image formats. A JPEG file for example doesn’t know 
about how wet your paint it or how many Layers you have in your document. 
This means that normal image applications can’t display ArtRage Painting 
files easily. The solution when you want to share images with someone else, 
post them online, or load images created in another application, is to use 
Import and Export.

Importing Images.

If you want to load a non ArtRage Painting file to work with select ‘Import 
Image File’ from the File Menu. When you select this option you are prompted 
to select a file to load. The file will be loaded in to ArtRage and a new Canvas 
will be created at the right size to contain it.

The image will appear on the Canvas and will be editable as if you had 
painted it in ArtRage.

Because you have Imported a file to create a new ArtRage Painting, you will 
be asked to enter a file name for it when you go to save. If you have edited 
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the image, make sure to save it as an ArtRage Painting file so that you can 
work on it later.

To overwrite the original image with your edited version, you would need to 
use the Export function described below.

Exporting Images.

Most applications do not understand the information stored in ArtRage 
Painting files. Not many applications recognize how much paint there is on a 
Canvas, or how metallic it is for example. This means that you can’t just load 
an ArtRage Painting file in to another application to view it, or send it to a 
friend to have them look at it.

The solution to this is to use the ‘Export Image File’ option in the File Menu. 
This option allows you to save a copy of your ArtRage Painting to disk in a 
format that other applications can understand. When you select the option you 
will be asked to enter a name for the copy, and select an image format to use. 
The copy of your painting is saved to disk and can be used as a normal image 
file.

Very Important: Do not use the Export function as if it was Save. 
You should always Save your paintings using the Save function 
so that you can reload them later without losing information. If the 
only copy of your painting is a JPEG or other normal image 
format then you have lost a lot of information!

Some file formats do not understand some properties of your Canvas. If you 
have made your Canvas transparent and you export to an image format that 
does not understand transparency (such as JPEG) the Canvas will be made 
completely opaque on export, displaying its standard color.

Photoshop Files.

ArtRage supports Adobe Photoshop  PSD files and can import and export 
them while maintaining many of their properties including layers, blend 
modes, and groups.

Text imported from a PSD file will appear in ArtRage as it did in Photoshop, 
and if you export the file as a PSD unedited text will remain correct when you 
open the file in Photoshop  again. If you edit text that was imported from a 
PSD file it may appear different when you return the file to the previous 
application.

Printing a File.

To print a copy of your ArtRage Painting use the ‘Print Painting’ option in the 
File Menu. This will open your computer’s normal print dialogue and allow you 
to set options as you wish.

On Mac OS X you will also be able to use the ‘Page Setup’ option in the File 
Menu to set up your print settings before printing.

File Size and Printing.

The difference between the size of your painting on the screen and the size of 
your painting when it is printed can be quite confusing. ArtRage helps you 
understand this by letting you work in either Screen Size or Print Size, but it 
may still help to understand why they are different.

Screen Pixels v. Printer Dots.

The image you see on your computer screen is made up  of tiny dots called 
‘pixels’. The number of pixels that are displayed on your screen depends on 
your computer and settings but there will generally be between 72 and 96 
pixels on your screen for every inch of space on the monitor. This can change 
if you have manually adjusted how many pixels are displayed on the screen or 
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if your computer has a high density display (such as a Retina Macbook Pro), 
but it’s a good rule of thumb.

When a printer prints an image, the image is made up  of a number of dots 
clustered together to form the colors and shapes you want, these dots are 
basically like the pixels on your screen. The printer generally places many 
more dots down in each inch of space than your monitor has pixels. To get a 
crisp, clean image your printer might put down between 120 and 600 dots for 
every inch.

So imagine you have created an image in ArtRage that is 72 by 72 pixels in 
size. On your screen it might be about an inch wide and an inch high 
(because your screen shows 72 pixels per inch). But if you print it and your 
printer prints 300 dots per inch, your printed image is less than one third of an 
inch in both directions, because you only had 72 dots to give it.

You could tell your printer to print 72 dots per inch, so your painting would be 
1 inch by 1 inch, but the quality wouldn’t be very good, 72 dots of ink isn’t 
enough to fill in an inch very well. You could also tell ArtRage to resize your 
painting so that it is 300 pixels wide and 300 pixels high. That would make it 
larger than an inch on your screen but your printer would print it as 1 inch in 
size. The trouble with that is that resizing your image is going to damage its 
quality, ArtRage has to guess at how to fill in the holes that are left when your 
pixels get stretched out to fit the new size and it will never be 100% perfect.

This means that if you are going to print the best time to decide what size you 
want to print at is when you create your file, before you have even painted a 
stroke.

Choosing a Size.

When you create a new file in ArtRage you are given the option of defining 
how large it is either by entering a Screen Size or a Print Size. Both options 
create the same basic result: A new painting that is a certain size on your 
screen, but the options allow you to work in the manner you wish.

If you want to create an image that is only usually going to be seen on a 
computer screen, just work in Screen Size and set the pixel size of the image. 
For example you might create an image that is 640 by 480 pixels in size, to 

show on a web  page. When you work in Screen Size you can see how big 
your image will be when it is printed. Better still, you can enter how many dots 
per inch you want the printer to print. So if you make a 300 by 300 pixel image 
that you want to be 1 inch in size when printed, you can just set the Pixels Per 
Inch value to 300. The number of pixels doesn’t change, because you are 
working in Screen Size, but you know how big it will be when printed.

If you want to create an image that you intend to print, work in Print Size. 
When you work in Print Size select the units of measurement you want to use 
and enter the size in those units. If you also enter the number of pixels per 
inch (the same as dots per inch here) then ArtRage will know how many pixels 
to create. For example if you tell ArtRage you want a 10 inch by 10 inch image 
that is 200 Pixels per Inch it knows that you have to have 2000 by 2000 pixels 
and creates the Canvas accordingly. You don’t need to worry about doing the 
calculation in your head.

Don’t forget: If you change your mind later you can always use 
the ‘Resize the Painting’ option in the ‘Edit’ Menu to change the 
size of your painting. It won’t be as high quality as if you had 
created it at the right size, but it will print at the right size.

Drag and Drop.

You can drag image files on to ArtRage from your computer. What happens 
when you do this depends on the type of file. A single ArtRage Painting file will 
be loaded when you drop it. A non ArtRage file will prompt to see if you wish 
to Import it, load it as a layer in the current painting, load it as a reference or 
load it as a tracing image.

If you drop  multiple files on to ArtRage and choose to load as a painting or a 
tracing image, only the first file alphabetically in the list of dropped files will be 
loaded as these options can only work with one image.
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The Menu Bar.

The Menu Bar sits at the top  of the ArtRage window and contains useful items 
that relate to the running of the application. In this panel you will find useful 
items like Undo and Redo, zoom level control for the Canvas, the Canvas 
Positioner, window options and the Quit button for the application.

On Windows the Menu Bar also contains all the application menus. On Mac 
OS X the operating system menu bar contains the application menus in their 
normal place.

If you are using ArtRage on Mac OS X on a desktop that does 
not have a menu bar at the top you can make the ArtRage Menu 
Bar display the application menus. This option appears in the 
Interface section of the ArtRage Preferences Panel.

The Menu Pod.

When the Menu Pod is visible, click it to bring up  the menu 
bar. Click and hold it and the ArtRage menus will appear as a 
popup for easy selection of menu items.

Contents of the Menu Bar.

When the Menu Bar is open it contains a series of buttons for menus and 
other options.

The button at the left of the Menu Bar is the Close Button. If your 
Menu Bar is docked, clicking this button will cause the panel to 

collapse back in to the Menu Pod. If your Menu Bar is not 
docked, you can click and drag this button to move the panel, or 
right click it for additional options.

Application Menus.

The Application Menus (File, Edit, Tools, View, and Help) give you access to 
all the main functionality in ArtRage.

Full information on what the menu items do can be found throughout this 
manual. More information can be found in the following sections:

1. File Menu:

a. Working With ArtRage Files.

b. Printing a File.

c. Package Files.

d. Scripts.

2. Edit menu:

a. Undo and Redo.

b. Resize and Crop.

c. Transformations.

d. Selections.

e. Image Adjustment.

f. Preferences.

g. Keyboard Shortcuts.

3. Tools Menu:
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a. Select Tool.

b. Presets.

c. Layer Options.

d. Stencil Options.

e. Tracing Options.

f. Reference Options.

g. Color Options.

h. Color Sample Options.

i. Toolbox Options.

j. Paint Symmetry.

4. View Menu:

a. Canvas Positioning.

b. Clear Canvas Mode.

5. Help Menu:

a. Help and Support.

Application Buttons.

The Menu Bar contains a series of buttons for common operations in ArtRage. 
These are:

Zoom Controls: Click the ‘+’ and ‘-’ buttons to zoom in 
or out. Click the percentage indicator to enter the 
zoom value you want. For more information see 
Navigating the Canvas.

Undo and Redo: Click the left arrow to undo the last 
action you performed, click the right arrow to redo it. 
For more information see Undo and Redo.

Canvas Positioner: Click this button to summon or 
dismiss the Canvas Mover. For more information see 
Canvas Positioner.

Hide: Shrinks the application to the task bar or dock.

Full Screen / Window: Click this button to make 
ArtRage take over the whole screen, or return to a 
Window if it is already filling the screen.

Close: Click this button to close ArtRage. If you have 
not saved your work you will be asked if you wish to 
do so before the application quits.
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Tools and Presets.

On the left side of the ArtRage window are controls for your painting tools. 
These include the Tool Picker for selecting tools, the Settings Pod for 
adjusting the settings associated with your current tool, and the Presets Pod 
for selecting presets for the current tool.

This section tells you everything you need to know about working with tools, 
and includes a detailed list of all of the settings and properties of the tools 
included in the application.

Pods.

The Tool Pod.The Tool Pod.

When the Tool Pod is visible click it to open the Tool Picker 
where you can select the tool you want to use. Click and hold 
it to bring up  a menu of available tools for easy selection. Click 
and drag left and right on it to change the size of the current 
tool, which is indicated at the top  left of the Pod. The icon 
displayed on the Pod indicates which tool is currently selected.

The Settings Pod.The Settings Pod.

When the Settings Pod is visible click it to open the Settings 
Panel where you can adjust the settings of the current tool. 
Click and hold it for a ‘Reset Tool’ menu option.

The Presets Pod.The Presets Pod.

When the Presets Pod is visible click it to open the Presets 
Panel for your current tool. Click and hold for a menu of 
available Presets.

The Tool Picker.

The Tool Picker on the left hand side of the ArtRage 
window is used for selecting which tool will be active 
when you click and drag to paint a stroke on your 
Canvas.

Each tool has its own icon in the Picker and the 
currently selected tool is lit up  so that you can see 
what it is.

To select a tool, click its icon and it will light up  to show you that it has been 
selected. If you want to know what a tool is, just hover the mouse pointer over 
it and after a short time a Tooltip will appear to tell you.

At the bottom left corner of the Tool Picker is a preview of the paint stroke that 
will be generated by the current tool, and an indication of how large it will be. 
You can change the size of the tool by left clicking and dragging in this area. If 
you want to enter the size manually, left click in the size area without dragging 
and you will be prompted for a percentage size.

You can change the size of the current tool by holding down Shift 
and clicking and dragging on the Canvas. You can also make 
your tool larger than 100% size either when Shift click dragging 
on the Canvas or by typing a value up to 500% in to the size 
prompt when you click the size area of the Tool Picker.
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The Settings Panel.

Each tool has a collection of settings that can be 
adjusted to alter the appearance of the stroke made 
when the tool is used. If you want to edit the 
settings of the current tool click the Settings Pod 
and the Settings Panel appears.

The appearance of this panel changes depending 
on which tool you have selected. When you select a 
tool the contents of the Settings Panel change to 
display the settings available for that tool.

A detailed description of the settings for each tool 
can be found in the ‘Tools’ section below.

The Preset Block.

At the top  of the Settings Pane is a control that indicates which Preset (if any) 
you currently have selected. Presets are combinations of settings that are 
applied to the tool to make it behave in a specific manner. For example you 
might have a ‘drybrush’ preset that causes the Oil Brush tool to reduce 
loading and thinners to dry its paint out.

The Preset Block at the top of the panel allows you to quickly select presets 
for the currently selected tool. To select a preset, click the Preset Block and a 
menu will appear containing options:

1. Reset Current Tool: If you ever need to reset the tool to its default 
settings, select this option.

2. Stylus Controls: Options that allow you to change how a stylus input 
device works with the current tool. For more information see Stylus 
Controls.

3. Preset Options: Items that allow you to open the Preset Collection panel 
to select presets, or add new presets.

4. A List of Presets: The final items in the menu are a list of presets currently 
available for the tool you have selected. These are divided in to groups. 
Select an item from one of the groups and those settings will be applied to 
the current tool.

Presets are an easy way to recall settings you have used 
previously. For more information see the section on Presets.

Pressure.

The Pressure Setting is available to most tools and does the same thing for 
each one.  Pressure indicates how hard you are pressing the tool down as 
you work. If you are using a mouse or graphics tablet with no pressure 
sensitivity this sets the level of pressure the tool applies. If you are using a 
pointing device that is pressure sensitive this value adjusts the pressure of 
your stroke, allowing you to increase or decrease the effect of the pressure 
you are applying manually.
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Oil Brush.

The Oil Brush lets you paint with a variety of styles of oil or acrylic paint. The 
Oil Brush is great for putting down strokes of paint for blending. It can also be 
good for creating texture because the bristles of the brush leave trails in the 
stroke.

Features of the Oil Brush include:

1. Smearing: Wet oils will smear and blend as you paint over them. If you 
paint a stroke over a previous oil stroke the colors will blend and the 
strokes merge. You can also smear oil strokes with the Palette Knife.

2. Texturing: The bristles of the brush leave a trail in the oil stroke giving it 
the appearance of depth and texture.

3. Runout: If you have a lightly loaded brush the color will run out as you 
paint, thinning down until it leaves a dry stroke on the surface of the 
Canvas.

4. Cleaning: If you turn off Auto-Clean, your brush head will remain dirty after 
each stroke so the last color you had on it will be applied when you next 
paint.

The Oil Brush interacts with the texture of your Canvas. 
As the paint thins and dries out at the end of a stroke you 
will see that it sticks to only the high points of the 
Canvas.

Settings:

Thinners:Thinners:

Allows you to add Thinners to your paint. As you increase 
this value the paint you are applying gets thinner so the 
stroke will go further before running out. Thinner paint is 
also more transparent and the bristles of the brush leave 
fewer marks as the paint gets thinner. Thinner paint is 
harder to smear because there isn’t much volume to 
spread around, but you can still smudge a thin stroke 
with the Palette Knife.

Tools and Presets

28



Loading:Loading:

Indicates how much paint has been picked up  by the 
brush head before the stroke begins. The higher the 
value the more paint there is so your paint will spread 
further if you turn Loading up  high. If you set Loading 
to 100% the paint will never run out in a single stroke.

Insta-Dry:Insta-Dry:

If this is turned on your paint will dry as soon as it 
touches the Canvas.

Dry paint does not blend with other paint on the canvas 
so color and texture will be unaffected as you paint over 
it.

Auto Clean:Auto Clean:

If this is turned on your brush will be cleaned 
automatically between strokes. If it is turned off you 
will need to clean the brush manually using the Water 
Glass that pops up next to the Color Picker. For more 
information see the Colors section.

Aspect:Aspect:

This controls how round or square the brush head is.

If the brush is using a Round head and the value is 
100%, the brush head will be a perfect circle, reduce the 
value and the brush head ‘squashes’, becoming more 
elliptical.

Rotation:Rotation:

Controls the default rotation angle of the brush head.

This is more visible if you have a narrow aspect brush. 
Rotation is also controlled dynamically as you paint, this 
setting just assigns the default value.

Stiffness:Stiffness:

This controls how stiff the bristles of the brush head are.

The stiffer the bristles, the less flexible the brush head is 
and the less the pigment will be ‘pushed’ in to the dents 
in the canvas.

Square Head:Square Head:

The Oil Brush usually uses a rounded brush head but if 
you turn this on the brush head becomes square, giving 
a more blocky start and end to the stroke.
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Watercolor.

The Watercolor tool lets you paint with a variety of watercolor styles using a 
soft bristled brush on wet or dry paper. Because it is a wet medium the 
Watercolor tool is ideal for creating subtle, blended color washes and detail. 
The control you have over the amount of wetness of your brush and the 
Canvas beneath it lets you produce a wide variety of results.

Features of the Watercolor tool include:

1. Soft Blending: Strokes of watercolor merge as they get close and their 
wet edges touch. This creates smooth blended colors with soft edged 
transitions. The feel of the stroke is organic, spreading slightly as wet areas 
of the Canvas interact.

2. Internal Blending: As you create areas of color the brush will pick up  and 
move around pigment that is already on the Canvas, creating areas of 
darker or lighter transparency.

3. Wetness and Dryness: Watercolor strokes vary in appearance greatly 
depending on the wetness of the area they are entering and the wetness of 
the brush head. This allows you to create firm edged areas of color then 
apply soft blended strokes inside those areas where the Canvas is already 
wet.

4. Run Out: Lightly loading the Watercolor tool can give short dagger-like 
strokes that dry rapidly and darken towards the end as the water dries up 
and the pigment is applied more thickly.

5. Cleaning: If you turn off Auto-Clean, your brush head will remain dirty after 
each stroke so the last color you had on it will be applied when you next 
paint.

Watercolor is a complex medium and there are a large number of settings that 
can be used to control the results you see when you paint. ArtRage 
understands both the color of the pigment you are applying and how much 
water is on your brush, and simulates these two things as you work with the 
tool. A basic understanding of what is happening when you paint with this 
medium can help  explain how its settings work. There are some golden rules 
that should help explain what is happening:

1. The water on the brush allows the pigment to spread, so a dry brush (one 
with less Thinner) applies paint more thickly because there is less water to 
spread it around.

2. Because the pigment spreads in water, a wet Canvas will draw pigment out 
beyond the area of the stroke. This is why strokes of watercolor merge and 
blend smoothly as they meet.

3. If the Canvas is not wet, the edge of the wet stroke where it meets dry 
Canvas generates a slightly darker rim as pigment gathers there, unable to 
go further.

4. Highly thinned watercolor is really just water, so you can use it to thin out 
paint that has already been applied.
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Watercolor strokes interact with the texture of your 
Canvas, flowing more readily in to the dips in the surface 
and gathering there. The rougher your Canvas, the more 
obvious this effect will be.

Settings:

Thinners:Thinners:

Allows you to add water to the brush to thin the paint that 
is applied. The higher the value the more water there is 
and the further the stroke will paint. High Thinners also 
decrease the density of the pigment giving you a more 
transparent stroke. 100% Thinners removes all pigment 
from the stroke and lets you apply pure water to the 
Canvas to thin previous paint down.

Loading:Loading:

Indicates how much paint has been picked up  by the 
brush head before the stroke begins. The higher the 
value the more paint there is so your paint will spread 
further if you turn Loading up  high. If loading is low the 
end of the brush will start to dry out as you paint, and the 
pigment will be applied more densely until finally the 
stroke breaks up and no more is applied. If you set 
Loading to 100% the paint will never run out in a single 
stroke.

Color Bleed:Color Bleed:

This setting is only available if Insta-Dry is turned off. It 
controls how fast the paint on the brush spreads in to 
paint that is already on the Canvas as you work, so high 
values mean that your current paint stroke will blend 
deeply in to previous strokes while lower values will 
prevent the color on your brush blending too heavily in to 
the color on the Canvas.

Paper Wet:Paper Wet:

If this is turned on the Canvas will be treated as if it is 
wet when you paint and your strokes will expand beyond 
the area of the brush, and have softer edges. If this is 
turned off the Canvas is treated as if it was dry so your 
strokes are not softened.

Insta-Dry:Insta-Dry:

If this is turned on your strokes are dried as soon as they 
touch the Canvas. This means they will not blend in to 
other strokes as you paint. They will still blend into their 
own area.

Auto Clean:Auto Clean:

If this is turned on your brush will be cleaned 
automatically between strokes. If it is turned off you will 
need to clean the brush manually using the Water Glass 
that pops up  next to the Color Picker. For more 
information see the Colors section.
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Palette Knife.

The Palette Knife provides a blending and smearing tool that takes a number 
of different forms to produce a variety of effects. In its simplest form, the tool is 
a flat bladed knife that can be used to smear around paint that has been 
applied to the Canvas. If you want to soften the edge between two paint 
strokes or create an entirely new color using existing paint then the Palette 
Knife is the right tool to use.

The Palette Knife does not apply paint to your Canvas unless Loading is 
above 0%, so if it is not and you have nothing to smear the tool will do 
nothing.

The Palette Knife has the following features:

1. Smear & Smudge: The Palette Knife will smear paint where there is lots 
on the surface, spreading it out as it goes. If there is not much paint on the 

surface the Palette Knife smudges what is there, like a finger on a pencil 
line.

2. Blade Types: The Palette Knife can be used as a flat blade or along its 
edge to create a different shape of smear.

3. Blending Types: The Palette Knife can be used to blur paint or apply wet 
droplets to blend and break down paint already on the Canvas.

The Palette Knife interacts with the texture of your Canvas. As the paint thins 
during smearing you will see that it sticks to only the high points of the 
Canvas.

Settings:

The Type of knife you have selected controls any other settings that are 
available. Types are selected from the Tab Control at the top  of the Settings 
Panel:

Types:

There are five types of Palette Knife available: Two different blade types, and 
three special effect types. These are:

Flat Blade: Uses the flat of a knife blade to smear paint on the 
canvas.

Edge Blade: Uses the edge of a knife blade to smear 
fine lines in paint on the canvas.

Soft: A digital effect that draws paint along the canvas 
around the cursor.
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Blur: A digital effect that blurs the paint underneath the 
cursor.

Wet: A digital effect that simulates sprinkles of water 
dispersing the paint on the canvas.

The settings for each type are listed below:

Flat and Edge Types:Flat and Edge Types:

Flat and Edge types control how the blade of the knife is 
positioned as you use it. Flat blades create wider profile 
strokes that are even across their width. Edge blades 
create sharper strokes that have more effect at one side 
of the stroke.

The following settings are available when using the Flat 
and Edge types.

Loading: Indicates how much paint has been picked up  by the knife before 
the stroke begins. The higher the value the more paint there is so your paint 
will spread further if you turn Loading up  high. If you set Loading to 100% 
the paint will never run out in a single stroke. 

Loading: Indicates how much paint has been picked up  by the knife before 
the stroke begins. The higher the value the more paint there is so your paint 
will spread further if you turn Loading up  high. If you set Loading to 100% 
the paint will never run out in a single stroke. 

Auto Clean: This setting is only relevant if Loading is set higher than 0%. If 
this is turned on your knife will be cleaned automatically between strokes. If 
it is turned off you will need to clean the knife manually using the Water 
Glass that pops up  next to the Color Picker. For more information see the 
Colors section.

Auto Clean: This setting is only relevant if Loading is set higher than 0%. If 
this is turned on your knife will be cleaned automatically between strokes. If 
it is turned off you will need to clean the knife manually using the Water 
Glass that pops up  next to the Color Picker. For more information see the 
Colors section.

Lock Rotation: If this is turned on, the angle of the knife head will not 
change as you paint. If it is turned off, the knife will rotate the follow the 
direction of your stroke.

Lock Rotation: If this is turned on, the angle of the knife head will not 
change as you paint. If it is turned off, the knife will rotate the follow the 
direction of your stroke.

Rotation: If Lock Rotation is turned on this slider appears and allows you to 
define the angle of the knife during painting.
Rotation: If Lock Rotation is turned on this slider appears and allows you to 
define the angle of the knife during painting.

Soft Type:Soft Type:

The Soft Type turns the Knife in to a smoother stump 
type blending tool that can be used to drag paint around 
smoothly on the surface of the Canvas.

The following settings are available when using the Soft 
type.

Smudge: Controls how much the paint on the Canvas is moved around as 
you apply a stroke. The higher this value goes the further the paint is 
moved by your stroke.

Smudge: Controls how much the paint on the Canvas is moved around as 
you apply a stroke. The higher this value goes the further the paint is 
moved by your stroke.

Blur Type:Blur Type:

The Blur Type makes the Knife blur paint that is on the 
Canvas rather than spread it around. You can hold the 
cursor over an area and the blur will continue to apply 
without the cursor moving.

The following settings are available when using the Blur 
type.

Softness: Controls how much blur is applied to the paint on the Canvas. 
The higher this value goes the more the paint blurs.
Softness: Controls how much blur is applied to the paint on the Canvas. 
The higher this value goes the more the paint blurs.
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Wet Type:Wet Type:

The Wet Type turns the Palette Knife in to a water 
sprinkler that sprinkles droplets on to the Canvas causing 
the paint to spread and expand, thinning as it goes. The 
droplets sprinkle automatically as you hold down the 
mouse button so you do not need to move the cursor to 
continue applying more.

The following settings are available when using the Wet 
type.

Falloff: Controls how far the droplets can fall from the center of the stroke 
as you paint with the tool. The higher this value, the further they can spread 
from the center point, affecting a wider area of paint.

Falloff: Controls how far the droplets can fall from the center of the stroke 
as you paint with the tool. The higher this value, the further they can spread 
from the center point, affecting a wider area of paint.

Drip Size: Controls the size of the individual droplets that are applied by the 
tool. The higher this value, the larger each droplet will be. Tiny droplets 
created a more speckled effect on the Canvas.

Drip Size: Controls the size of the individual droplets that are applied by the 
tool. The higher this value, the larger each droplet will be. Tiny droplets 
created a more speckled effect on the Canvas.

Drip Spike: Controls how spiky the droplets are when they hit the surface 
of the Canvas. The higher this value the more ragged the droplets appear 
as they strike and the more ragged the paint appears when it spreads.

Drip Spike: Controls how spiky the droplets are when they hit the surface 
of the Canvas. The higher this value the more ragged the droplets appear 
as they strike and the more ragged the paint appears when it spreads.

Drip Spread: Controls how much the paint is spread through the area of 
each droplet. The higher this value the further the paint travels and the 
harder the edge of the droplet becomes. Low values cause very little spread 
of the paint so the result is a smoother droplet.

Drip Spread: Controls how much the paint is spread through the area of 
each droplet. The higher this value the further the paint travels and the 
harder the edge of the droplet becomes. Low values cause very little spread 
of the paint so the result is a smoother droplet.

Color Drag: Controls how far the paint color on the Canvas is dragged with 
the droplets as you move. If this value is high, the color will move with your 
stroke for a distance before running out. If this value is low, the color will not 
spread far from its original point as you drag around.

Color Drag: Controls how far the paint color on the Canvas is dragged with 
the droplets as you move. If this value is high, the color will move with your 
stroke for a distance before running out. If this value is low, the color will not 
spread far from its original point as you drag around.

You can make great clouds with the 
Wet Blender. Lay down some lines 
of white with the Paint Tube and see 
how the blender smoothes them out!
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Airbrush.

The Airbrush allows you to spray a fine mist of paint. The spray coats the 
surface of the Canvas, tinting it without flattening any paint that was already 
there and without blending with any color beneath.

The Airbrush has the following features:

1. Dryness: The spray from this tool is thin and dries really quickly. This 
means that if you run the Palette Knife over it after spraying you won’t get 
smearing and blending, the paint on the Canvas will be smudged instead.

2. Shape: The Airbrush provides control over the shape of your stroke, 
supporting tilt information from tilt sensitive input devices to create conical 
sprays, and allowing you to create dagger strokes by tapering the stroke 
over its length.

3. Flow: The Airbrush can be set to keep  spraying as you hold the tool still, 
so you can make it really transparent and remain in one area to get subtle 

tints that vary over the length of the stroke. Pressure also adjusts flow 
speed, allowing you to manually adjust the density of the mist that is 
sprayed while you paint.

Settings:

Blend Mode: The Airbrush allows you to adjust the color of the spray by 
applying a blend mode as the paint is sprayed on the Canvas. Unlike Layer 
Blend Modes, the blend mode used by the Airbrush is applied to the paint as it 
lands on other paint, it does not change the color of the paint if it is landing on 
a blank area of Canvas. The Blend Mode will also only apply to paint on the 
current Layer, it does not change the color of the paint as it passes over paint 
on a different layer. For more general information on what Blend Modes look 
like when they are used, see the section on Layers.

Tilt Angle:Tilt Angle:

This setting controls the default angle the Airbrush is 
considered to be tilted at when you use it. Tilting the 
airbrush changes the shape of the spray and the 
higher this value is set the more conical the spray 
becomes.

Setting Tilt to 0% creates a circular ‘direct down’ 
spray. If you are using a stylus that provides tilt 
information this value can be set to increase the 
amount of tilt your stylus will apply as you work.

Taper Length:Taper Length:

This setting allows you to tell the Airbrush to taper its 
stroke over time. If the value is set to 0% the stroke 
will not be tapered at all. If the value is set higher 
than 0% the stroke will taper. The higher the value 
the longer the time before the stroke tapers.
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Opacity:Opacity:

Controls the basic opacity of the spray and indicates 
the maximum opacity each stroke can be. If you want 
to create subtle tints, set this value below 100% and 
you will not be able to apply a fully opaque spray no 
matter how long you spray each individual stroke. 
Strokes can still become more opaque as they 
overlap each other. 

Hardness:Hardness:

Controls how sharp  the edge of the Airbrush spray is. 
The higher the value, the sharper the edge of the 
spray area becomes.

Drip Spread:Drip Spread:

Controls how much spatter there is from the Airbrush. 
Set this value above 0% to cause the tip  of the 
Airbrush to create droplets. The higher the value, the 
wider the droplets spray through the area of the 
stroke.

Autoflow:Autoflow:

If this setting is on the Airbrush will continue to spray 
paint while the cursor is held still. If this setting is off 
the Airbrush will only spray when you move.

When the spray continues on its own it can build up 
to form a larger patch of paint if you hover over a 
single spot on the canvas. Turning Autoflow off 
prevents this and allows you to make more 
consistent strokes.
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Ink Pen.

The Ink Pen is a precise, solid line pen that can be used for illustration or 
detailing without blending with other paint on your Canvas. The Ink Pen 
comes in round or chisel-tip  forms and also allows you to automatically 
smooth your lines, removing some of the irregularities that can appear when 
using a mouse or stylus.

The Ink Pen has the following features:

1. Dryness: Inked lines dry immediately so they do not interact with other 
paint on your Canvas. They will not blend or change their shape as you 
use them over other paint.

2. Shape: The shape of the pen head can be adjusted, changing from square 
to round and adjusting how much of a chisel tip it has. This changes the 
thickness of the stroke depending on direction as you draw, rather like a 
calligraphy pen.

3. Smoothing: The ink pen can adjust your strokes after you paint them to 
make them smoother. This helps reduce the wobbles that can occur when 
using a mouse or stylus.

Settings:

Blend Mode: The Ink Pen allows you to adjust the color of the ink you are 
drawing with by applying a blend mode as it is applied to the Canvas. Unlike 
Layer Blend Modes, the blend mode used by the ink is applied as it lands on 
other colors already on the Canvas, it does not change the color of the ink if it 
is landing on a blank area of Canvas. The Blend Mode will also only apply to 
ink that overlaps color on the current Layer, it does not change the color of the 
ink as it passes over color on a different layer. For more general information 
on what Blend Modes look like when they are used, see the section on 
Layers.

Aspect:Aspect:

Controls how flat the tip  of the pen is. A 100% aspect 
means that the tip  is entirely circular or square 
depending on other settings. A 50% aspect creates 
an elliptical or rectangular tip. A 0% aspect means 
that the tip has been flattened down to a single line.

Rotation:Rotation:
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Allows you to change the default rotation of the pen 
tip. If you have 0% rotation the pen tip  lies 
horizontally by default. As you change the value the 
default position rotates. So a low aspect circular tip 
with 50% rotation would look like a vertical ellipse.

Opacity:Opacity:

Controls the basic opacity of the ink and indicates the 
maximum opacity each stroke can be. If you want to 
create subtle lines, set this value below 100% and 
you will not be able to apply a fully opaque ink no 
matter how many times you drag over an area in an 
individual stroke. Strokes can still become more 
opaque as they overlap each other.

Smoothing:Smoothing:

Controls how much smoothing is applied to your 
stroke after it is complete. Smoothing can be used to 
make strokes flow more smoothly or remove small 
irregularities in their shape. Higher values apply more 
smoothing to your stroke and can significantly 
change its basic shape and size as ArtRage 
calculates a smoothed version of the path you took.

Taper Length:Taper Length:

Controls how much the ink stroke tapers along its 
length. If this slider is set above 0%, when you finish 
a stroke it will be reconstructed with a taper starting 
at both end and finishing part way along the stroke 
depending on the slider value.

A value of 100% means that the taper will meet in the 
middle.

Taper Bias:Taper Bias:

If Taper Length is set above 0% this controls where 
the widest point of the taper will appear. If the value 
is 50%, the widest point will be in the middle of the 
stroke. If the value is 100% the widest point will be at 
the end of the stroke. If the value is 0% the widest 
point will be at the start of the stroke.

The effect of changing this slider varies heavily 
depending on how much the Taper Length slider is 
set to.

Square Head:Square Head:

If this is on the pen tip  is square. If it is off the pen tip 
is circular.
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Antialias Edge:Antialias Edge:

If this setting is turned off the edges of the stroke will 
not be antialiased. This removes partially transparent 
pixels from the edge of the stroke and can create a 
jagged look but can be useful if you are inking for a 
print medium that is high resolution and has 
problems when printing partially transparent areas.

Pencil.

The Pencil Tool gives you a range of difference pencil types including soft and 
hard, and precise mechanical pencils. The pencil tool is good for detailed line 
work and soft shading when you sketch using the side of the lead. If you have 
a pressure sensitive stylus the darkness of the lines you make can also be 
adjusted while you draw.
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The Pencil Tool has the following features:

1. Dryness: Pencil strokes apply dry color to the Canvas so they do not 
smear, but they can be smudged using the Palette Knife.

2. Hardness: The tip  of the pencil is hard so the lighter you press with a 
pressure sensitive stylus the lighter the stroke you will make. In addition, if 
you draw with the pencil over an area of thick paint the tip  of the pencil will 
cut through the paint and leave a flat trail.

3. Shape: The head of the pencil is conical so if you increase the Tilt value 
setting you can draw with the flatter, wider side of the lead.

4. Smoothing: Precise Pencils can adjust your strokes after you draw them 
to make them smoother. This helps reduce the wobbles that can occur 
when using a mouse or stylus.

5. Tilting: If your Stylus supports Tilt, the Pencil will tilt to match it as you 
draw, allowing you to adjust whether you are drawing with the tip  or side of 
the nib for easy shading.

The Pencil interacts with the texture of your Canvas. If you draw lightly on a 
rough Canvas you will see the texture of the Canvas show through as the 
Pencil touches only the higher parts of its surface.

Settings:

Softness:Softness:

Controls how soft the lead of the pencil is. Higher 
value, softer lead breaks up  more easily so leaves 
more on the Canvas as you draw, leading to a darker 
line and a more powdery look. Harder leads break up 
less so create lighter, more precise lines.

Tilt Angle:Tilt Angle:

If the Pencil’s ‘Precise’ setting is turned off you can adjust 
the Tilt Angle. The higher this value, the more the pencil 
is considered to be tilted when you draw, giving softer, 
wider strokes as you sketch with the side of the lead 
rather than the tip.

Smoothing:Smoothing:

This setting is only available when the Pencil’s ‘Precise’ 
setting is turned on.  It controls how much smoothing is 
applied to your stroke after it is complete. Smoothing can 
be used to make strokes flow more smoothly or remove 
small irregularities in their shape. Higher values apply 
more smoothing to your stroke and can significantly 
change its basic shape and size as ArtRage calculates a 
smoothed version of the path you took.

Precise:Precise:

If turned on this setting switches the pencil to a precise 
mode that simulates mechanical pencils. Precise pencils 
ignore the texture of the Canvas and create smooth, 
accurate lines that can be smoothed. Precise Pencil lines 
still vary in their opacity based on pressure as they are 
drawn.
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Paint Roller.

The Paint Roller lets you paint solid block strokes of flat paint on to the 
Canvas. This tool is great for filling in large areas with a flat color without it 
looking fake, as it takes into account the texture of the Canvas and can blend 
colors as it applies paint to the surface.

The Paint Roller has the following features:

1. Smearing: As the roller applies paint it smears other paint on the Canvas 
beneath it to blend and spread paint around.

2. Runout: If you have a lightly loaded roller the color will run out as you 
paint, thinning down until it leaves a dry stroke on the surface of the 
Canvas.

3. Cleaning: If you turn off Auto-Clean, your roller head will remain dirty after 
each stroke so the last color you had on it will be applied when you next 
paint.

4. Size: The roller can go much larger than the other tools in ArtRage so it’s 
great for applying large areas of color either to use as a background or to 
blend with more detailed tools.

The Paint Roller interacts with the texture of your Canvas. The harder you 
press when you use the Roller (or the higher your Pressure slider is set if you 
do not have a pressure sensitive stylus) the more paint is lifted off the surface 
as the roller passes and the texture of the Canvas below will show through.

Settings:

Thinners:Thinners:

Allows you to add Thinners to the paint that is applied. As 
you increase this value the paint you are applying gets 
thinner so the stroke will go further before running out. 
Thinner paint is also more transparent and is harder to 
smear because there isn’t much volume to spread 
around, but you can still smudge a thin stroke with the 
Palette Knife.
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Loading:Loading:

Indicates how much paint has been picked up  by the 
roller before the stroke begins. The higher the value the 
more paint there is so your paint will spread further if you 
turn Loading up high. If you set Loading to 100% the 
paint will never run out in a single stroke.

Auto Clean:Auto Clean:

If this is turned on your roller will be cleaned 
automatically between strokes. If it is turned off you will 
need to clean the roller manually using the Water Glass 
that pops up  next to the Color Picker. For more 
information see the Colors section.

Felt Pen.

The Felt Pen tool lets you draw with a range of marker pens of varying 
wetness and qualities, creating a number of different effects. From cheap, dry 
markers and highlighters through to expensive art pens that have wet brush-
tips, the Felt Pen is a great tool for applying color while sketching without 
applying texture such as the bristle strokes in the oil brush.

The Felt Pen has the following features:

1. Smudging: Even a wet felt pen doesn’t leave much actual paint on the 
Canvas so it won’t leave lumps and won’t smear. It can, however, be 
smudged using the Palette Knife.

2. Blending: Wet felt pen tips can blend with other colors as they pass over 
them, lifting some of the existing color off the Canvas and blending it in to 
the color of the pen.
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3. Build Up: Dry felt pens like highlighters don’t blend very well so as you use 
them to draw back and forth over other colors, or even their own stroke, 
they tend to build up and darken.

Using a white felt tip  pen is like using a water soaked felt 
nib. It will blend and thin existing color but it won’t apply 
white to the surface. Solid white requires a thicker paint 
such as Oil, or Chalk/Crayon if you want a dry medium.

The Felt Pen interacts with the texture of your Canvas. If 
you draw lightly on a rough Canvas you will see the 
texture of the Canvas show through as the tip  touches 
only the higher parts of its surface. Because it is really a 
wet medium the stroke sinks deeper in to the Canvas 
than something like Chalk or Pencil.

Settings:

Softness:Softness:

Controls how soft the tip  of the pen is. Softer pens will 
vary the size of their stroke more with pressure. If you 
are not using a pressure sensitive input device this 
setting won’t appear to do much unless you change the 
pressure slider.

Wetness:Wetness:

Controls how wet the tip  of the pen is and how much ink 
is deposited as you move.

Lower values create dry pens that break up  around the 
edges where the texture of the Canvas is lumpy and the 
tip is not in full contact.

Higher values cause the edges of the stroke to smooth 
out as the ink flows in to the dents of the Canvas Texture. 
Higher values also cause the felt pen to drag existing 
color from the Canvas as the pen moves over it.

Art Pen:Art Pen:

If this is turned on the felt pen is given a much higher 
quality stroke as the tip  quality is improved. Art Pens 
produce a bolder stroke that doesn’t build up over itself 
because the tip  deposits more color on the Canvas as it 
moves around. Art Pens also blend with other colors 
smoothly.
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Gloop Pen.

The Gloop  Pen is a special effect pen that produces expanding blobs of ink on 
the Canvas as you use it. Each stroke of the Gloop  Pen expands wetly from 
the nib  and ‘gloops’ in to itself as you draw, and there are settings that control 
exactly how it looks as it gloops.

Because it is a special effect tool, there are many different uses for the Gloop 
Pen. You can use it for everything from painting thought bubbles and organic 
outlines to making clouds and leaky ink pens.

The Gloop Pen has the following features:

1. Dryness: The Gloop  Pen is wet while you draw a stroke, but as soon as 
the stroke ends it becomes dry. This means that it cannot be smeared, but 
you can still smudge it with the Palette Knife.

2. Flow: The Gloop  Pen continues to produce ink as you hold the tool still so 
you can build up  larger strokes by dragging slowly or holding over one 
spot.

3. Glooping: While you work the ink that is produced will flow together with 
other ink from the same stroke to produce different results.

The Gloop Pen is special because the inside and 
edge area of its stroke can be independently 
controlled. As you draw, the settings you have 
applied to the inside and edge areas change the 
appearance of the stroke. If your settings create 
a very wide edge on the stroke you may not see 
the inside area until the area you have filled with 
ink is large enough.The Gloop Pen interacts with 
the texture of your Canvas, breaking up  at the 
edges based on the roughness beneath.

The Gloop Pen looks great without any roughness at the edges 
too, try turning off the Canvas Texture for the Layer you are 
drawing on. See the section on Layers. 

Trying out Presets is a great way to explore the complex features 
of the Gloop Pen.

Settings:

Blend Mode: The Gloop  Pen allows you to adjust the color of the ink you are 
drawing with by applying a blend mode as it is applied to the Canvas. Unlike 
Layer Blend Modes, the blend mode used by the ink is applied as it lands on 
other colors already on the Canvas, it does not change the color of the ink if it 
is landing on a blank area of Canvas. The Blend Mode will also only apply to 
ink that overlaps color on the current Layer, it does not change the color of the 
ink as it passes over color on a different layer. For more general information 
on what Blend Modes look like when they are used, see the section on 
Layers.
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Opacity:Opacity:

Controls the overall opacity of the stroke as it is applied. 
Lower values produce more subtle tints on the Canvas.

Outer Blur, Edge Width, Inner Blur: These three settings control the 
appearance of the stroke at its edge. The Gloop Pen creates a stroke that 
has an inner fill and editable rim that expands to surround the area you 
draw.

Outer Blur, Edge Width, Inner Blur: These three settings control the 
appearance of the stroke at its edge. The Gloop Pen creates a stroke that 
has an inner fill and editable rim that expands to surround the area you 
draw.

Outer Blur: This controls how soft the outer edge of the 
rim is. The higher this value the softer the outer edge of 
the rim becomes.

Edge Width: This controls how thick the solid rim is as it 
forms around the stroke area. The higher this value the 
thicker the line produced around the edge of the stroke.

Inner Blur: This controls how soft the inner edge of the 
rim is. The higher this value the softer the inner edge of 
the rim becomes.

Fill Opacity:Fill Opacity:

Controls the opacity of the ink that fills the area of the 
stroke. The higher this value the more opaque the ink 
becomes. If you set this value to 0% only the stroke rim 
will be visible as you draw.
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Sticker Spray.

The Sticker Spray takes sheets of Stickers and lets you spray them directly on 
to your Canvas rather than having to place each one manually. The range of 
effects that can be created with this tool are limited only by the range of 
stickers you have available. It can create masses of leaves for trees, flocks of 
birds, beaches full of pebbles, and even special effect strokes that mimic 
other painting tools.

The section on Stickers explains in detail the variation settings of the Sticker 
Spray and how Stickers are used. This section covers the basic settings of the 
Sticker Spray and how you can use it.

The Sticker Spray has the following features:

1. Sticker Placement: Rather than create a single stroke when used, the 
Sticker Spray places numerous stickers down on the Canvas as it is used.

2. Flow: The Sticker Spray can be adjusted to spray constantly while in use, 
or to spray only as you move.

The easiest way to start using the Sticker Spray is to explore the 
various presets provided with ArtRage.

Settings:

Sheet: Allows you to select which sticker sheet to use for the spray. Sticker 
sheets can be selected from your Sticker Collection. See the section on 
Stickers for more information.

Spray Rate: Controls how fast new stickers are sprayed on to the Canvas as 
you work with the sticker spray. The higher the settings, the more stickers will 
be sprayed for a denser result.

Autoflow: Sets whether the spray of stickers is continuous or only occurs 
when you move. If turned on, stickers will be sprayed constantly while the 
mouse button is held down. If turned off, stickers will only be released on to 
the Canvas as you drag, like sticky tape from a dispenser roll.

Shadow: If turned on, each sticker will be given its own shadow as it is 
sprayed. If turned off, the stickers will not have shadows. For more information 
on this panel see the section on Stickers.

Auto-Flatten: If turned on, stickers will be sprayed to the surface as simple 
images, each sticker will be sprayed on to the layer as paint. This preserves 
the volume, gloss, and other properties of the sticker but it will not be editable 
after spraying. If turned off, every sticker that is sprayed is an individual, 
floating sticker object that can be scaled, rotated, moved, and edited in other 
ways post spraying.

If you don’t think you will want to edit your stickers after spraying, 
consider turning Auto-Flatten on, spraying thousands of stickers 
can take up quite a lot of memory if they are all editable!
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Variation Symmetry: When the Sticker Spray is used with paint Symmetry 
turned on, you can either have this setting turned on, in which case all 
variable properties of the spray are affected by symmetry, or turned off in 
which case on the path of your stroke is affected by symmetry.

In the example above, the Sticker Spray is set to vary the size of the 
dominoes based on their Y Position: The higher the domino is placed up  teh 
canvas, the smaller it gets.

The left hand image was created by making a single stroke from the middle to 
the top  left with Variation Symmetry turned off: The mirrored strokes in the 
other segments all respect the absolute value of the Variation.

The right hand image was created in exactly the same way, but with Variation 
Symmetry turned on. The Variation is applied to the stroke we painted, and 
the automatically mirrored strokes copy the variation that was applied to it.

Spray Variation: Click this to access the Spray Variation Panel which allows 
you to control a large number of properties of the spray. For more information 
on this panel see he section on Sticker Spray Variation.

Shadow Settings: Allows you to set the properties of the shadow that will be 
applied to stickers as they are sprayed. For more information on this panel 
see the section on Stickers.

Pastel.

The Pastel Tool lets you draw with wax or chalk pastels of varying softness, 
producing strokes of varying boldness depending on the pressure of the 
stroke and interacting with the grain of the Canvas to produce textured 
results.

The Pastel Tool has the following features:

1. Waxiness: Strokes of Wax Pastel are almost dry, but not quite. This means 
that as you draw over them small amounts of color can be picked up  from 
previous strokes and the wax can build up  slightly on the surface of the 
Canvas.

2. Dryness: Chalk Pastel strokes are dry so they do not smear, but they will 
smudge if you use the Palette Knife.

3. Hardness: The tip  of the Pastel is hard so the harder you press the bolder 
the stroke becomes. Light strokes will only apply to the high parts of the 
Canvas, because the tip doesn’t deform to push in to the dents.
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The Pastel interacts with the texture of your Canvas. If you draw lightly on a 
rough Canvas you will see the Canvas Texture show through as the tip 
touches only the higher parts of its surface. 

Settings:

Type: The Pastel can be set to use Wax or Chalk. The two are very similar but 
Wax Pastels will blend and smear slightly as you work with them. Chalk 
Pastels are dry and blur slightly but do not smear.

Softness:Softness:

Controls how soft the pastel is. Softer wax will apply 
more easily to the Canvas. The higher the softness, the 
bolder the stroke will be at light pressures.

Cloner.

The Cloner is a special effect tool that allows you to replicate paint already on 
your canvas by setting a Source point then painting in to a new area. The 
Cloner can be used to repeat existing detail on the canvas such as flowers in 
a field, or duplicate patterns and colour blends that you have already applied.

The Cloner has the following features:

1. Replication: The Cloner precisely recreates paint from its source area at 
the cursor. This means that it will replace any paint already on the canvas 
at that point without blending. It also means that the Cloner will replicate 
any paint wetness or texture from its source area.

2. Head Control: The Cloner allows you to soften the edges of its brush head 
to help blend the replicated paint in with paint already on the canvas. It also 
allows flow control like the Airbrush.

3. Clone Source: All Cloner operations need a source, which is the point 
from which the Cloner takes paint to replicate.

Settings:

Blend Mode: The Cloner allows you to adjust the color of the paint you are 
drawing with by applying a blend mode as it is applied to the Canvas. Unlike 
Layer Blend Modes, the blend mode used by the Cloner is applied as it lands 
on other colors already on the Canvas, it does not change the color of the 
paint if it is landing on a blank area of Canvas. The Blend Mode will also only 
apply to paint that overlaps color on the current Layer, it does not change the 
color of the ink as it passes over color on a different layer. For more general 
information on what Blend Modes look like when they are used, see the 
section on Layers.

Opacity: Controls the overall opacity of the cloned paint as it is applied.
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Hardness: Controls how hard the edge of the Cloner brush head is. The 
higher this value the sharper the edge line of the cloned stroke. Lower values 
cause cloned paint at the edge of the stroke to blend with the paint behind it. 

Autoflow: Sets whether the flow of cloned paint is continuous or only occurs 
when you move. If turned on, paint will be applied constantly while the mouse 
button is held down. If turned off, paint will only be applied as you drag.

Relative Offset: This defines how the Cloner Source Point behaves. When 
you paint with the Cloner paint is duplicated from the Source and applied 
under the cursor. As you paint, the Source Point moves to mirror the motion of 
the cursor.

If this option is turned on the Source Point stays at the same relative distance 
from the cursor between paint strokes so that every time you start painting it 
will be the same offset distance that it was when you defined it. This option is 
useful if you are duplicating a large area of paint.

If the option is turned off, every time you start painting the Source Point 
returns to the original location it was when you defined it, regardless of how 
much the cursor has moved. This option is useful if you want to repeatedly 
duplicate an area of existing paint in different locations on the canvas, 
because each time you start a stroke, the Source Point returns to its original, 
defined location.

Current Layer Only: Sets whether the Cloner replicates paint only from the 
current layer, or from every layer on the canvas. If turned on, paint from any 
layer the Source Point passes over will be replicated.

If this option is turned off, the following additional settings become available:

Include Canvas Color: If turned on, this option causes the Cloner to treat the 
Canvas color as paint and replicate it along with paint from any layers. If 
turned off, only actual paint is replicated.

Include Current Layer: If turned on, this option causes the Cloner to 
replicate paint from the layer it is painting on. If turned off, the Cloner will 
ignore any paint that it finds on the current layer.

Setting Clone Source.

All Cloner operations need a Source for the paint to replicate. You can define 
the Clone Source in one of two ways:

1. If you have not already defined a Source, the first time you click with the 
Cloner on the Canvas your Source point will be defined.

2. At any point when using the Cloner, hold down Alt (Windows) / Option (OS 
X) and click on the canvas to define the Source point.

A small crosshair will be left behind on the Canvas to indicate 
where the Source point is.

How the Cloner Source Point Moves.

As you paint, the Cloner Source Point moves in exactly the same way the 
cursor moves. For example, if you move to the right, the Source Point will 
move to the right. Understanding the relationship  between the Source Point 
and the Cursor is important when you are trying to clone large areas.

If Relative Offset is turned on, you can make as many paint strokes as you 
like to clone an area of paint, because the motion you make with the cursor is 
mirrored by the Source Point even when you are not actually painting:

Stroke 1 replicates part of the source area.

In this case the clone source is at the top  left, and a 
single stroke has been made to clone part of the 
watercolor dots at the bottom right.
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Stroke 2 starts in a different spot but replicates the 
correct part of the source area relative to the motion 
of the cursor.

So the second stroke continues to recreate the 
watercolor dots in the bottom right corner.

If Relative Offset is turned off, you must replicate the entire area of paint that 
you want to clone in a single stroke because the Source Point will reset every 
time a stroke ends.

Stroke 1 replicates part of the source area.

This looks the same as a Relative stroke because the 
Relative Offset toggle is only relevant between 
strokes, the tool behaves the same way during a 
single stroke regardless of the Relative value.

Stroke 2 clones form the same source as stroke 1 
even though my cursor is in a different position, so the 
Source Point is not in the same position relative to the 
cursor and I cannot complete replication of the source.

Instead, the watercolor dots are repeated again at the 
new stroke point.

This can be useful if you want to create multiple clones of a smaller object.

Stroke 1 replicates the entire object you want to clone.

Remember that you need to make sure that I complete 
the clone in a single stroke

Stroke 2 resets the Source Point to the original spot 
and you can just paint a new stroke to replicate the 
entire object again.

You can repeat this as often as you like.
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Eraser.

The Eraser lets you remove paint from the surface of the Canvas. It doesn’t 
just erase color, it will erase the texture of paint as well so you can use it to 
shape large volumes of paint that you have previously applied.

The Eraser has the following features:

1. Hardness: Even a soft eraser is hard enough that you can vary how much 
is erased by varying the pressure of your stroke. Light strokes only erase 
small amounts of paint, harder strokes erase more.

If the Eraser is used on a stroke of paint it will remove 
the physical mass of the paint before it removes the 
color. This can be useful if you have a very thick area of 
paint and want to thin it down a bit. Carving dents in to 
paint strokes with a light pressure eraser can produce 
some very interesting effects.

If you want to instantly erase everything under the eraser as you 
work, set its Pressure slider to 100% and its Softness slider to 
0%, that will give a hard edged, instant eraser. 

Settings:

Softness:Softness:

Controls how soft the edge of the erased area is. The 
softer the eraser, the more blurred the edge of the line it 
erases. To get a solid, hard edged eraser take softness 
all the way down to 0%.
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Paint Tube.

The Paint Tube can be used to lay down lines of thick paint on the Canvas for 
blending or adding texture. It adds a large amount of physical material so it is 
the ideal tool to use when preparing to smear paint with the Palette Knife.

The Paint Tube has the following features:

1. Wetness: The paint laid down by the Paint Tube is thick and wet so it can 
be easily smeared around.

2. Never Runs Out: The Paint Tube never runs out so you can make as long 
a line of paint as you like.

3. Thick: The paint applied by the Paint Tube is thick enough that it covers 
over the texture of the Canvas.

4. Shape: Single splotches of paint on the Canvas look different to the 
strokes you make, and can be used to make for interesting textures.

The Paint Tube has no settings of its own.

Single clicking with the Paint Tube causes it to leave only 
a spot of paint on the Canvas. The harder the pressure, 
the larger the amount left behind.

Glitter Tube.

The Glitter Tube lets you sprinkle colored particles of various shapes on to the 
Canvas. This can be used to build up  textures, add some sparkle to a 
painting, or even recreate images if used with a Tracing Image. Glitter is 
particularly good to use when you want a metallic look, as the many particles 
reflect the light in different ways.

The Glitter Tube has the following features:

1. Dryness: Particles of glitter are dry as they hit the Canvas so they cannot 
be smeared, but they can be smudged with the Palette Knife.

2. Flow: The tube continues to sprinkle without you needing to move it 
around, so you can build up large piles of glitter in a single spot if you wish.

3. Shape: There are five different options for the type of glitter you want to 
sprinkle.

Settings:

Glitter Size:Glitter Size:

Controls the size of the particles of glitter that are 
sprinkled. The higher the value the larger the particles.
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Multicolor:Multicolor:

Allows you to make the glitter particles change color as 
they sprinkle. The higher this value, the further the color 
of the particles will be from your currently selected paint 
color.

Glitter Shape:Glitter Shape:

Sets the shape of the particles that are sprinkled. The 
options are: Square, Circle, Ball, Grit, and Random.

Each option creates a slightly different texture when used 
on the canvas.

If you have a Tracing Image loaded and color is set to 
automatically sample from beneath each particle of glitter will 
adopt the color it is landing on. This allows you to easily build up 
an image using glitter.

Selection Tool.

The Selection Tool does not create strokes of paint on the Canvas, it is used 
to mark areas for other operations such as copy and paste, or transformation. 
If you want to prevent paint being applied outside a specific area of the 
Canvas you can use a selection as a mask and it is active paint can only be 
applied inside its area.

Full information on selections and what you can do with them can be found in 
the section on Selections. This section explains the settings of the Selection 
Tool and how to use it to make selections.

Settings:

Type: There are six types of Selection Tool available:

Rectangle: Creates rectangular selections by clicking and dragging 
on the canvas. Hold down Shift to create perfect square selections.

Ellipse: Creates elliptical selections by clicking and dragging on the 
canvas. Hold down shift to create perfect circle selections.

Polygon: Creates multi-sided polygonal selections. Click to place a 
corner point, then release the mouse button and click to place the 
next point.

To end the process and create the polygonal selection either double 
click on the last corner you want to create and a final edge will be 
linked back to the first point, or click on the first point again to close 
the line. 

Press Escape on the keyboard or select another tool to cancel 
polygon construction.

Freehand: Creates freehand selected areas. Click and drag to draw 
an outline around the area to be selected. When you release the 
mouse button the end of your line will be automatically connected to 
the start and the area closed.
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Magic Wand: Creates automatic selection areas using the color on 
the canvas as a guide. Click in an area to select the surrounding 
area of color similar to the point clicked. This mode has additional 
settings that are used to change how ArtRage identifies the area to 
select.

Paint Area: Allows you to paint an area that will be turned into a 
selection. As you paint, the area you want to protect from changes is 
filled in with red, you are painting a Mask. You can always use Invert 
Selection in the Edit Menu to turn the selection around after you are 
finished.

When you have finished painting your selected area, select another 
tool or selection mode to convert the ink you applied in to a real 
selection. 

This mode has additional settings that are used to change the shape 
of the paint stroke.

Unique settings for each type are listed below:

Magic Wand Type:

Spread: Controls how far the area to select will spread from the point you 
click. To select the area, ArtRage looks at the color of the point you clicked 
and expands outwards until it finds a different color, at which point it stops. 
The Spread value controls how different that color can be before the spread 
ends. The higher the Spread value, the more different it can be.

So a low Spread value means that if you click a blue spot on the Canvas, 
even a lighter blue could stop  the selection spreading. A higher Spread 
value means that the selection will expand further through the light blues 
but might stop when it hits green.

Antialias Edge: If this is on the edge of the selected area will be 
antialiased, selecting partial pixels to soften the selection. If you do not want 
to work with partial transparencies, turn this setting off.

Current Layer Only: When you click a point to make a magic wand 
selection ArtRage can either look at color only on the layer you clicked, or 
on all layers to find where it should stop expanding. If Single Layer is turned 
on, other layers will be ignored. If it is turned off, color on other layers is 
also taken into account as the selection spreads.

Paint Area Type:

Opacity: Adjusts the opacity of the selection. The higher this value the 
more the area will be selected. Lower values can create transparent 
selections. For more information see the section on Selections.

Hardness: Controls the hardness of the edge of the strokes made with the 
Paint Area selection tool. The higher this value the sharper the edge of the 
stroke. The lower the value goes, the more blurring you will see at the edge 
of the stroke.

Autoflow: If this is turned on the tool will automatically place ‘selection ink’ 
down on the surface of the Canvas as you hold the pointer still. This causes 
the selected area to build up  over time and is particularly visible if you turn 
Hardness down to 0%. If this is turned off, ink will only be applied as the 
pointer is moved.

If you want to paint a detailed selection make sure to set Mode to 
Add, or every stroke you paint will remove the last one you 
painted.

These settings are available for all types:

Mode: Controls how the next selection will be added to any current selection 
already on the Canvas. Available modes include:

Replace: Replaces the current selection with the new one.

Add: Adds the new selection to any current selection to create a new 
result.
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Subtract: Subtracts the area of the new selection from any current 
selection to create a new result.

Difference: Makes a new selection from any area of selection that is 
in either the current or new selection, but not in both.

Intersection: Makes a new selection from areas that are in both the 
current and the new selection.

For more information see the section on Selections.

Feather: Controls how soft the edge of the selection is. Feather creates a blur 
at the edge of your selected area. The higher the value the softer the blur will 
be. This setting is not available to the Paint Area type.

Clear Selection: Removes the current selection from the Canvas.

Invert Selection: Inverts the current selection.

Transform Tool.

The Transform Tool is used to adjust the shape, size, and position of paint and 
other objects that have already been placed on the Canvas.

The Transform Tool is used to select an item to transform. When you have this 
tool selected, clicking on an object on the Canvas will trigger a transformation 
overlay so that you can change its position, size, and rotation. For example, if 
you have a paint stroke on the Canvas you can click it with the Transform Tool 
and it will become available for transformation.

If you have a Selection active, clicking inside the selection with the Transform 
Tool will affect only the paint in its area.

More information on how to perform transformations can be found in the 
section on Transformation. This section explains the settings and use of the 
Transform Tool itself.

Settings:

Type: There are three types of Transform available:

Normal: Allows adjustment of scale and rotation using the handles 
and edges of the transform area.

Non Uniform: Allows non uniform transformations that can be used 
to skew the transform area.

Perspective: Allows perspective transforms that can be used to 
skew the transform area and apply perspective distortion.

A full description of each type can be found in the section on Transformation.

Select Layer: If this is turned off, the Transform Tool will only select items on 
the current layer when you click. If it is turned on, the Transform Tool will 
select the first item it finds underneath the point you clicked, regardless of 
which layer you have selected.
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In complex paintings the Single Layer option can be turned on to give you 
more control over what you are selecting when you click in the Canvas.

Color Sampler.

The Color Sampler allows you to sample colors from the Canvas and make 
them your current color. For more information on colors see the section on 
Colors.

To use the Color Sampler simply click on the Canvas. The color underneath 
the point you click is selected as the current color.

Settings:

Single Layer: If this is turned on the Color Sampler will only sample color 
from the current layer you have selected. If there is no paint on the layer 
where you click, nothing is sampled. If this is turned off the Color Sampler will 
sample whatever is under the pointer regardless of what layer it is on, and if 
there is no paint it will sample the Canvas color.

With Lighting: ArtRage has a light that creates the illusion of dents and 
lumps in paint strokes. If this option is turned on the Color Sampler will 
sample the color you see on the screen, so a red paint stroke that has a 
bristle dent might give you a dark red where there is a dent or a light red 
where there is a peak. If this option is turned off the Color Sampler will only 
sample the actual color of the pigment used to create a stroke, so your red 
paint stroke would produce red regardless of whether you click on the dark or 
light parts made by the bristles.
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Fill.

The Fill Tool is used to pour large areas of paint on to the Canvas that expand 
until they find a border they cannot flow over. If you want to create large areas 
of solid color, gradients, or patterns the Fill Tool is the tool to use.

The Fill Tool has the following features:

1. Dryness: Although the Fill Tool pours paint in to an area, that paint dries as 
soon as it touches the Canvas. This means it cannot be smeared, but it 
can still be smudged using the Palette Knife.

2. Automatic Fill: The Fill Tool automatically fills in areas on the Canvas, you 
do not need to manually define the area it will fill.

Settings:

Type: There are three types of Fill Tool available:

Solid: Fills areas of the canvas with solid color. Click to start 
‘flooding’ the canvas with color and the fill will spread outwards 
based on the tool settings listed below.

Gradient: Fills areas of the canvas with gradations of color. Click 
and drag to define the direction and size of the gradient based on the 
tool settings listed below.

Pattern: Fills areas of the canvas with a predefined pattern. Click 
and drag to define the direction and size of the tiles based on the tool 
settings listed below.

Each Type of Fill works in a different way. You can find explanations of how to 
apply them below.

All Fill Types have the following settings:

Blend Mode: The Fill Tool allows you to adjust the color of the poured paint 
by applying a blend mode as it spreads on the Canvas. Unlike Layer Blend 
Modes, the blend mode used by the Fill Tool is applied to the paint as it lands 

on other paint, it does not change the color of the paint if it is landing on a 
blank area of Canvas. The Blend Mode will also only apply to paint on the 
current Layer, it does not change the color of the paint as it passes over paint 
on a different layer. For more general information on what Blend Modes look 
like when they are used, see the section on Layers.

Opacity: Controls the opacity of the paint that is poured on to the Canvas. 
The lower this value the more transparent the paint.

The following settings are unique to certain Fill Types. You can also find 
detailed information on how to create different types of fills in the next 
sections.

Solid Type:

Spread: Controls how far the area to select will spread from the point you 
click. To select the area, ArtRage looks at the color of the point you clicked 
and expands outwards until it finds a different color, at which point it stops. 
The Spread value controls how different that color can be before the spread 
ends. The higher the Spread value, the more different it can be.

Antialias Edge: If this is on the edge of the filled area will be antialiased, 
selecting partial pixels to soften the selection. If you do not want to work 
with partial transparencies, turn this setting off.

Single Layer: When you click a point to fill an area ArtRage can either look 
at color only on the layer you clicked, or on all layers to find where it should 
stop expanding. If Single Layer is turned on, other layers will be ignored. If it 
is turned off, color on other layers is also taken into account as the paint 
spreads.
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Gradient Type:

Gradient: The Gradient Type allows you to select a gradient to use when 
applying the Fill. Click this control to open the gradient editor, or click the 
menu for options that allow the loading of gradients from disk or your 
collection. For more information on designing your own gradients see the 
Gradients section.

Gradient Type: The Type of Gradient that will be applied. Different types 
cause the gradient to be generated with a different shape on the canvas. 
For information on how each type works and how to apply it see Creating 
Gradient Fills.

Smoothing: Controls how smooth the steps between points in the gradient 
area. The higher this value the smoother sharp  transitions in the gradient 
will appear.

Reverse Gradient: Turn this on to flip  the start and end points of the 
gradient. This does not edit the gradient, it just adjusts the direction applied 
by the Fill tool.

Pattern Type:

Pattern: The Pattern Type allows you to select a color image to be applied 
as a tiled pattern within the fill area. Click this control for pattern selection 
options including loading from disk and selecting from your collection.

Lock Scale: If this option is turned on the scale of the image you use in the 
pattern fill will not change, every tile will be the size of the actual image.If 
you turn this off the scale of the tile will be defined by the distance you drag 
when creating the fill area. For more information on how this works see 
Creating Pattern Fills.

Scale: Controls the scale of the pattern image when the fill is generated. If 
Lock Scale is turned on, this value is used regardless of whether you drag 
to create the fill. If Lock Scale is turned off, this value will be used only if 
you single click to create the fill.

Flip Horizontal: When turned on, this option flips the pattern horizontally.

Flip Vertical: When turned on, this option flips the pattern vertically.

Creating Solid Fills.

The Solid Fill Type creates areas of solid color that spread outward from the 
point at which you click. The spread of the color is limited by the colors 
already on the canvas. The Spread slider indicates how different a color on 
the canvas must be before the Fill stops spreading.

The example below shows spread from the center of the dark blue circle, first 
with the Spread value at 0%, then with the Spread Value at 60%.

A 0% Spread means that as soon as the fill hits a color different to the one 
you clicked, it stops spreading. Here, the light blue has created a border it 
cannot spread past. A 60% Spread means that the fill will continue expanding 
over colors that are quite different to the one you clicked (here, the light blue) 
but will stop  at colors that are significantly different. This is why the fill stops at 
the red border.

Fills and Antialiasing.

Antialiasing is the process by which a digital line is made to appear smooth by 
varying the opacity of pixels along the edge. This makes angled lines and 
curves appear smooth despite the fact that your display is made up  of discreet 
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blocks (pixels). This also means that a Flood Fill operation can have problems 
where the fill area meets the edge of another line, because the antialiased 
pixels of the edge of your line are not the same color as the pixels inside the 
line itself. As a result you may see some fringing around the edge of the fill 
area where it met these partially opaque pixels.

Increasing Spread can help  to counteract this problem: If the Spread is slightly 
higher the fill area will extend further in to the line. In cases where this does 
not help, turning off the Antialiasing option in the Fill tool may help.

One trick if you find that you’re seeing fringes when doing a 
Flood Fill on to black line work is to set the Fill Tool Blend Mode 
to Multiply and increasing Spread: Where the fill area meets the 
line, it will vanish, so even if the fill area overflows the line slightly 
you should get a smooth edge!

Creating Gradient Fills.

Gradient Type Fills fill the entire available area with a color gradation, 
replacing any colors already on the Layer.

There are two ways to create them:

1. Click and drag on the canvas: The gradient will be created with its 
starting color at the point you clicked, and its ending color at the point at 
which you release. The direction of the gradient (see below) is defined by 
the direction of your drag. Note that all space in the canvas before your 
starting point will be filled with the starting color, and all space after the 
point of release will be filled with the ending color. Hold down Shift to 
constrain the angle of the line to 15 degree increments.

2. Single click on the canvas: The entire available area will be filled with 
the gradient you have selected, its direction will be treated as if you had 
clicked and dragged downwards.

If you create a Gradient inside a Selection, the gradient will not apply outside 
the area of that Selection. If there are Stencils on the canvas, the Gradient will 
not apply beneath them.

Gradient Types.

There are five types of gradient. Each type defines the shape the gradation of 
color will take when it is applied, and how click and drag works to adjust this.

Linear: The Gradient is created in a straight line. If you click and drag 
the starting color of the gradient is placed where you click, and the 
ending color is placed where you release.

Radial: The Gradient is created in a circular shape projecting 
outwards. The centre of the circle is the starting color of the gradient 
and is placed where you click, and the ending color is placed where 
you release.

Angle: The Gradient is created around a circular path like a clock 
face. The starting and ending colors of the gradient meet at the same 
point and the angle of that point is defined by the angle you drag.

Reflect: The Gradient is created in a straight line but repeats itself. 
The starting point and ending point of your drag will both be the 
starting color of the gradient, the ending color of the gradient will be 
placed half way between the two.

Diamond: The Gradient is created in a diamong shape projecting 
outwards. The centre of the diamond is the starting color of the 
gradient and is placed where you click, and the point at which you 
release defines the tip  of the diamond and is made the ending color of 
the gradient.

Creating Pattern Fills.

Pattern fills replace the contents of the available area with a predefined 
pattern that is tiled repeatedly to fill the space provided. The size of the 
pattern tiles and the angle at which they are placed is defined by how you use 
the fill tool on the canvas. There are two ways to do this:
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1. Click and drag on the canvas: The pattern will be created with its tiles 
aligned along the line you define. Hold down shift to constrain the angle of 
the line to 15 degree increments. If Lock Scale is turned off, the length of 
the line you drag defines the size of the tile: The starting point of the line 
is where the top  center point of the tile will be placed, and the ending point 
is where the bottom center point will be placed.

2. Single click on the canvas: The pattern will be created with tiles at the 
size defined by the Scale slider and oriented normally.

If you create a Pattern Fill inside a Selection, the Pattern will not apply outside 
the area of that Selection. If there are Stencils on the canvas, the Pattern will 
not apply beneath them.

Text Tool.

The Text Tool allows you to place editable text on your Canvas using standard 
fonts and formatting. For detailed information on how to work with text in 
ArtRage see the Text section. This section explains how to use the settings 
available in the Text Tool.

To add text with the Text Tool, just click where you want it to begin and start 
typing. If you click where there is already text, that text will be made active for 
editing.

When you have finished typing you can press Enter on your numeric keypad if 
you have one or select a different tool and text editing will be completed. If 
you press Escape while editing, the edit will be cancelled.

When you click to add new text to the Canvas a new layer is added 
specifically for the text item.

The Text Tool has the following features:

1. Editable: Text is not paint in the standard sense of the word. When you 
enter text on the Canvas it occupies its own special layer type and cannot 
be adjusted using tools like the Palette Knife until you flatten it. Until it is 
flattened, text can be freely edited and transformed so you can change 
your mind and adjust it after creation if you wish.

Settings:

Most of these settings will change either the next text you type in to a text 
layer, or any text that is currently selected. For more information see the Text 
section.

Text Size: The point size of the text. Point size is valid for 72dpi images, note 
that higher DPI will not adjust the font size accordingly.

Font: Allows you to select the font you want to use for the text.

Bold, Italic, Underline: These items turn on or off the indicated formatting for 
text.

Tools and Presets

60



Align: Controls the alignment of the text when you have more than one line, 
aligning it to either the Left, Right, or Center of its body.

Flattening Text.

As mentioned above, Text does not act like normal paint. In order to be able to 
edit it with other paint tools you need to ‘Flatten’ it. This can be done by 
locating the Text Layer you wish to flatten in the Layer Panel and using the 
Flatten option in its Text Menu.

For more information, see Layer Thumbnails.

When you flatten text the live text content is converted to paint on a standard 
paint layer. You will not be able to edit it after you have done this so make 
sure you either have a copy of the layer to work on later, or that you are done 
with all your editing.

Tool Presets.

Most of the tools in ArtRage have a large number of settings that allow them 
to be used in a wide number of different ways. For example, the single Oil 
Brush tool can create thick oil strokes, delicate thin washes, rough drybrushed 
smudges, and many more effects. This means that each tool is actually a 
collection of hundreds of other potential specific tools, each defined by what 
can be a very narrow range of settings from the available controls.

Tool Presets are used to avoid you having to remember the exact settings that 
go to make a specific type of tool, and allow you to set up  all of those settings 
with a single click. Presets store all of the settings of the tool they are created 
for, and can optionally also store the paint color and brush size at the time of 
creation.

The Presets Panel.

The Presets Panel is opened by clicking the 
Presets Pod. It gives you functions for selecting, 
storing and sorting presets for the current tool. 
When you select a tool the contents of the 
Presets Panel update to show you what you 
have available.

Presets are sorted in to groups for ease of use. 
You can select which group of presets you wish 
to display using the Group  control at the top  of 
the panel. The presets that are in the current 
group are displayed below in the main list.

Selecting Presets.

To select a preset from the list, click it. This will apply all of its settings to the 
current tool and the preset will light up. If you change any of the properties the 
highlight will disappear because the preset’s settings are no longer active.
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Presets that are listed with a dot next to them on the right hand side cannot be 
edited as they come installed with ArtRage. Presets without a dot are ones 
that you have added and you can edit them by right clicking on them.

So why does a preset lose its highlight when you change 
settings? Presets are exact combinations of settings, so if you 
change anything, the tool settings no longer reflect the content of 
that preset. That’s why the highlight vanishes.

Creating Presets.

If you want to create a preset, set up 
your tool in the state you want to store 
then click the New Preset button. 
When you click this button the New 
Preset Panel appears and you can set 
up details.

At the top  of the panel is a menu containing options for setting up  groups, and 
the option to add the preset to the Toolbox when it is created. For information 
on the Toolbox see the Toolbox and Workbench section later in this manual.

The next section of the panel allows you to select the Group  that the preset 
will be added to. Click the control to choose from a list of available groups. 
You can also set the name of the preset here.

If you want to set the icon for your preset click the icon button to the left of the 
name entry. This will produce a menu that allows you to use the default tool 
image for the current tool, load an image from disk, or sample an image from 
the Canvas.

If you want your preset icon to show what its tool strokes will look like and you 
have a sample on the Canvas select the Sample Preview Image option. When 
you select this a small panel will appear and the rest of the interface will fade 
out. Drag the small panel until its central preview area is over the part of the 

Canvas you want to sample and click the tick button. This will sample from the 
Canvas and assign that image to your preset.

Finally you are given the option to store Tool Size and Paint Color with the 
preset. If you store these properties, they will be set when the preset is 
selected. If they are not stored, the tool size and paint color will remain 
unchanged when the preset is selected.

When you are ready to create the preset click OK and ArtRage will generate 
the file for you. If you have selected a name that has already been used or 
there is a problem of another kind you will be notified and can choose how to 
resolve the problem.

Once you create a preset it is added to the User Preset Collection and you will 
find it in the appropriate Group of the presets panel.

Storing Size and Color.

The option to store Size and Color with your preset allows you to use presets 
in two different ways:

1. As tool types: If you do not store Size and Color, your preset represents 
a generic type of tool that you may use in different ways in different 
projects. For example, a stiff bristle brush, or a leaky airbrush. Selecting 
the preset sets the basic type of tool you are using and you can then 
apply that tool to various different jobs in the painting.

2. As specific tools for defined purposes: If you store Size and Color your 
preset represents a specific tool for a specific task. For example, if you 
are painting a portrait and working on the eyes you might want a specific 
soft brush at 10% size with a precise blue-green color. This is still just an 
Oil Brush, but it is for a defined task rather than for general use.

You may want to split your presets in to groups that reflect these different 
types of functionality. You may also find if you are using lots of specific tool 
presets that the Toolbox is useful. For information on the Toolbox see the 
Toolbox and Workbench section later in this manual.
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Managing Presets.

Any presets you add to ArtRage can be accessed from the User Preset 
Collection folder. The easiest way to get to this folder is by selecting Open 
User Tool Presets Folder in the Preset Panel menu.

Each preset is a file on disk so you can change their names and move them 
around in that folder if you like. Each Group  is a folder stored inside that 
folder, so if you add new folders you are adding new categories.

If you want to import a preset that someone else has sent you, you can use 
the Import Preset To Collection option in the Preset Panel menu. This allows 
you to select a preset to load and ArtRage imports it to the correct disk 
location for the currently selected Group.

Right click an item in the panel to delete or rename it from inside 
the application.
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Colors.

On the right hand side of the ArtRage window you will find controls for 
selecting and managing colors. Whenever you paint a stroke with a paint tool 
the color that is selected on the right hand side will be used to make that 
stroke. This section tells you everything you need to know about working with 
color.

Pods.

Color Pod: When the Color Pod is visible click it to open the 
Color Picker. Click and hold it to bring up  the Popup Color 
Picker for quick color selection. This Pod contains a preview 
of the currently selected color.

Samples Pod: When the Samples Pod is visible click it to 
open the Color Samples Panel. Click and hold it for a menu 
of Color Sample options.

Color Picker.

The Color Picker on the right hand side is used for selecting your current 
color. There are 5 important controls starting from the bottom right corner and 
working inwards:

1. Sizing Grip: The grip  at the bottom right can be clicked to close the panel. 
You can right click it for a set of options for scaling and tearing off.

2. Current Color Sample: This shows you the color you currently have 
selected. Click here for an options menu.

3. Metal Slider: Click and drag here to change the metallic value of the 
current color.

4. Large Color Arc: Contains 2 of the 3 components that make up your color.

5. The Small Color Arc: Contains the last of the 3 components that make up 
your color.

Selecting Colors.

In real life selecting colors involves picking the basic color you want then 
blending in other colors to make the exact color you want to see. In ArtRage 
you do something similar because the Color Picker is split in to two sections. 
The Small Color Arc is where you pick your basic hue, and the Large Color 
Arc is the mixing area in which you mix in black, white, and grey to create the 
final color to be used in painting.

Around the outer edge of the panel is the Small Color 
Arc. By default this shows a rainbow spectrum of 
basic colors. Click and drag inside this rainbow to 
select the basic color you want to use. For example, if 
you want a green of any kind, click in the green 
section of the arc.
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When you click in the green section the Large Color 
Arc updates to display the color you picked in various 
shades from black to grey to white. Now click in this 
section to choose how bright or how grey you want 
the green to be. This is a bit like a mixing palette 
where you blend the exact color you want.

When you click in the Large Color Arc, the Current 
Color Sample in the corner of the panel updates to 
show the exact color that is being loaded on the brush 
head when you paint the next stroke.

If you want your green to be a bit more yellow, you can click and drag in the 
rainbow spectrum again, towards the yellow tint. The Large Color Arc mixing 
area updates when you do this. Now you can select the exact brightness of 
yellow-green you want and the Current Color Sample updates to show the 
result.

So selecting colors involves:

1. Picking a basic hue from the Small Color Arc rainbow.

2. Picking how bright or grey you want it to be from the Large Color Arc 
mixing area.

3. Watching the Current Color Sample so that you know what color you have 
selected.

For information on other forms of color picking in this panel see the section on 
Color Modes below.

If you want to quickly sample color from your Canvas hold down 
Option (Mac OS X) / Alt (Windows) and click in the Canvas. This 
samples color directly.

If you want to quickly pick a color without going to the color 
picker, for example if you have hidden the interface, hold down 
Cmd + Alt (Mac OS X) / Ctrl + Alt (Windows) and click and hold 
down on the Canvas. This brings up a Popup Color Picker which 
you can use to select a new color.

Metallic Colors.

The Metal Slider on the Color Picker allows you to make 
your paint more metallic. The higher this value the more 
reflective the paint becomes. Even plain colors like white 
will look different when they are more metallic.

You can blend metallic paint with non metallic paint to create a partially 
metallic result.

Metallic paint works really well with the Glitter Tool.

Color Modes.

The Color Picker has a number of different modes that can be used to display 
color in different manners. The color options menu which can be found in the 
Tools menu or by clicking on the Current Color Sample allows you to select a 
mode for the Color Picker. Different modes cause the picker to change which 
properties of color are displayed in the Small and Large Color Arcs. These 
modes are:

HL / S, HS / L, LS / H  (Default): These modes break the color down in to 
three components: Hue (the basic tint), Luminance (how bright the color is, 



varying from black through pure color, to white), and Saturation (how grey the 
color is). In each mode, the last character indicates the property that is 
displayed in the Small Color Arc. By default, the Hue of the color is displayed 
in the Small Arc, which gives you the rainbow of colors to choose from.

RG / B, RB / G, BG / R: These modes break the color down in to three digital 
components indicating the amount of Red, Green, and Blue that make up the 
color. In each mode, the last character indicates the property that is displayed 
in the Small Arc.

RGB Color is a digital standard, but if you turn on Real Color 
Blending in the Color Options Menu ArtRage will simulate real 
world paint color blending.

Tint / Tone: The Tint / Tone Picker provides a 
slightly different method of selecting color. When 
you choose this mode the Color Picker updates to 
display a circular Hue Wheel and a diamond in 
which you can select the artistic tint and tone of 
your final color.

To select the basic color you want, click and drag 
in the circular ring around the outside of the 
picker. When you have selected a basic color you 
can use the diamond in the center of the picker to 
select how light, dark, and grey the final color will 
be. The final color is still displayed in the Current 
Color Sample.

Custom Color Pickers.

Custom Color Pickers are normal images that you can load in to the color 
picker for custom selection. This lets you create your own pickers for specific 
paintings or any case where you have a particular color set you want to use. 
The Color Options menu gives you access to the custom color picker system.

If you choose to load a new custom picker from disk you can select an image 
file that will be loaded in to the Color Picker, replacing the existing picker 
contents. If you choose to open the Custom Color Picker Collection you will 
be given the chance to select a Custom Picker already stored in the 
application.

Right click an item in the panel to delete or rename it from inside 
the application.

Selecting a Custom Picker.

If you want to load a Custom Color Picker from the collection of pickers 
already stored with the application just select ‘Custom Color Picker 
Collection’ from the color options menu. When you select this option the 
Custom Pickers Panel opens and you can choose a picker from your 
collection.

On the left hand side of the panel you see a list of groups, each of which can 
contain one or more custom pickers. Click a group  name to select it and its 
contents appear on the right.

Click one of the pickers that appears on the right and it will appear in the 
Color Picker. A lock icon on a picker indicates that it was installed by ArtRage 
and cannot be overwritten, you can still select it.

Adding a New Custom Picker.

You can add new custom pickers to your collection by loading them from disk 
or sampling them from your ArtRage Canvas. In the Custom Pickers panel 
you will see an Import Picker and New button above the pickers on the right. 
The Import Picker button allows you to select an image file from disk that will 
be loaded in to the current Group  you have selected, and can then be 
selected as normal.

If you click the New button the Custom Picker Creator appears. Drag the 
panel until the preview area in the middle is over the area you wish to sample 
and click the tick button. This will sample the are you selected and ask you for 



a file name. The file location has already been set to the correct folder for the 
group  you selected, so you can just save the file there. The picker will then 
appear in the Custom Pickers panel and you can select it as normal.

Using Custom Pickers.

When you load a Custom Color Picker it replaces the contents of the Color 
Picker. The Large Color Arc is taken up  by the custom picker you have 
selected, and the Small Color Arc becomes a Luminance slider, indicating the 
color you have selected in the Large Arc and its variance from black to white.

To select a color from a custom picker just click in the Large and Small Color 
Arcs as normal. To remove the Custom Picker go to the Color Options Menu 
(either in the Tools Menu or in by clicking the Current Color Sample) and 
select a mode for the Color Picker.

Precise Color Picker.

If you want to select a color using exact color values you can use the Precise 
Color Picker. The Precise Color Picker can be opened using the Color 
Options menu that can be found in the Tools menu, by clicking the Current 
Color Sample, or by selecting the Precise Color Picker option from the View 
Menu.

The Precise Color Picker allows you to select the exact color you want using 
RGB or HLS color values. Using the menu at the top  right you can change the 
picker’s display mode to use the standard modes listed in the section on Color 
Modes above.

The Precise Color Picker can be left open while you work. Some other 
interface items cause a Precise Color Picker to appear with OK and Cancel 
buttons. In this version of the Picker you can click the ‘Original’ button at the 
top left to reset the color.

Real Color Blending.

Most digital painting packages blend 
colors using an RGB color model. This 
color model is familiar to people who use 
painting software but does not produce 
results familiar to people who work with 
real paint. Real Color Blending mode 
allows you to change how ArtRage blends 
color so that it mimics real world pigments 
more closely.

Real Color Blending mode can be turned on in the color options menu which 
can be found in the Tools menu or by clicking the Current Color Sample. The 
Real Color Blending menu item can be turned on or off whenever you wish. 
Changing it will not affect any of the paint already on the Canvas, but any 
paint you blend after changing it will blend in the newly selected mode.

The most obvious example of how Real Color Blending changes the paint 
color can be found when you blend blue and yellow. Using an RGB blending 
model the resulting blend comes out somewhere between blue and grey. If 
you tun on Real Color Blending you find that the resulting color is green.

Real Color Blending is great when you are trying to mix colors, 
especially if you are used to real paint.

The Water Glass and Dirty Brushes.

Some tools in ArtRage can be set up  so that they do not completely reload 
their head with color at the end of every stroke. These tools pick up  color from 
the Canvas and remain dirty until they are cleaned manually.



If your tool needs to be cleaned manually you will see the 
Water Glass Pod appear next to the color picker. Clicking 
the pod will clean your brush head. The Water Glass will 
vanish if your current tool does not require manual cleaning.

If you don’t clean a brush you can get some interesting effects  
when you continue painting from paint that previously blended on 
the brush head.

Color Samples.

If you want to keep colors for later use you can store 
them as Color Samples. Clicking the Samples Pod 
opens up  the Samples Panel which lists all the 
samples available to you.

At the top  of the panel you will find a menu containing 
sample options and a button to add a new sample.

There are two types of Color Sample that can be added:

1. Regular Color Samples: Usually referred to simply as ‘Color Samples’, 
these Samples are listed in the Samples Panel and are available to all 
paintings.

2. Toolbox Samples: The Toolbox is a storage space for content specific to 
a particular painting. Toolbox Samples are samples that are stored in the 
painting only so do not appear in the Samples Panel unless that painting 
is loaded. For more information on the Toolbox see Toolbox and 
Workbench.

Both types of sample can be accessed from the Samples Panel. Toolbox 
Samples are listed at the end of the list in their own collapsible section. The 
menu at the top  of the Samples Panel contains options for both types as well. 
Toolbox Samples are accessed from a sub menu of that menu.

Selecting Color Samples.

To select a color using a Color Sample just click the sample in the Samples 
Panel. The Current Color Sample on the Color Picker will update to show the 
new selection.



Adding and Removing Color Samples.

There are a number of ways to add new Color Samples, all of which can be 
accessed using the Color Sample Options Menu in the Tools menu, or using 
the menu button on the Samples Panel.

The Add Sample button at the top  of the Samples Panel adds a regular Color 
Sample to the list. At the end of the list of samples, and the list of Toolbox 
Samples, is a + button that lets you add a sample to that section of the panel.

Each method of adding one or more samples from the menu is available for 
both regular and Toolbox samples, just select the appropriate option from the 
menu.

1. Add Sample: Creates a new sample using the current color.

2. Replace Samples: Replaces all existing samples of the indicated set with 
a new set of samples either from the collection of samples or by loading a 
file from disk.

3. Add Samples: Adds a new set of samples to the current samples in the 
indicated set either from the collection of samples or by loading a file from 
disk.

4. Export Samples: Allows you to save the samples you currently have in the 
selected set out to disk as an ArtRage Color Sample file.

5. Add To Collection: Allows you to add the entire set of either the Regular 
or Toolbox Color Samples to your Samples Collection.

6. Clear Samples: Clears out all current samples from the indicated set.

Individual samples can be removed by right clicking them and selecting the 
appropriate item from the popup menu.

Sample Names.

If you turn on the Show Samples With Names option in the Color Samples 
menu the sample panel will list each sample on its own line with its allocated 
name.

When this option is turned on, you will be prompted to enter a name for each 
sample that you add. If names have been assigned to samples but the option 
to display them is not turned on, the sample will have a tool tip  containing its 
name.

Sorting Color Samples.

There are a number of ways to sort your Color Samples, all of which can be 
accessed using the Color Sample Options menu in the Tools menu, or using 
the menu button on the Samples Panel.

The easiest way to identify the samples is to give them a name. You can 
select to show samples with or without names using the appropriate items in 
the Color Sample Options menu. If you are displaying them with names you 
will be prompted to enter a name each time you manually add a sample. If 
you do not wish to enter a name, just press Escape or click outside the name 
edit that appears. You can also rename your samples by right clicking them 
when you have names displayed and selecting the appropriate option from 
the popup menu.

There are a number of alternative sorting options available in the menu. Each 
option sorts the entire sample set in to ascending order based on a property. If 
you have already sorted them in to that order, selecting the same order from 
the Sort menu will sort them in to descending order.

Manual Sorting.

You can also sort your Color samples manually. Click and drag a sample in 
the list to change its position. Any manual changes will be removed if you 
choose one of the sorting methods listed above.



The Canvas.

The ArtRage Canvas is the sheet of material on to which all of your paint 
strokes go. It sits underneath your Layers and acts as a backdrop  for 
everything you do. This section explains how you can navigate around your 
Canvas and how to change its visual and textural properties.

Navigating the Canvas.

As you work with ArtRage you may find you want to change the position of the 
Canvas, or rotate it or zoom in or out to see different detail. There are a 
number of different ways to do this. Mouse and keyboard shortcuts provide a 
quick and easy way to move around, but the Canvas Positioner can be used if 
you want more accurate control.

Menu Options.

At the top of the View Menu you will find a Canvas Position menu that allows 
you to control zoom level and reset individual navigation properties of the 
Canvas. You will also find the Canvas Positioner option if you want to open 
the Positioner.

Mouse and Keyboard Shortcuts.

To navigate around the Canvas using the mouse:

Move the Canvas: Right click and drag and the Canvas will move.

Zoom the Canvas: Hold down Ctrl (Windows) / Cmd (Mac OS X) and right 
click and drag right and left, and the Canvas will zoom in and out.

Rotate the Canvas: Hold down Option (Mac OS X) / Alt (Windows) and right 
click and drag, and the Canvas will rotate.

Instead of using a right click you can use a left click if you hold down the 
spacebar. For example, to move the Canvas you can hold down the spacebar 
and left click and drag, to rotate the Canvas you can hold down the spacebar 
and the Option / Alt key and left click and drag.

If you have a Multitouch input device and are using an operating 
system that supports it you can use Multitouch Gestures to 
manipulate the Canvas.

1. Use two fingers to drag on the Canvas to move it.

2. Use two fingers and pinch inward or outward on the Canvas to 
scale it.

3. Use two fingers and twist on the Canvas to rotate it.

Canvas Positioner.

The Canvas Positioner can be kept open if you 
find you want to make many precise adjustments 
to the Canvas position while you are working with 
ArtRage. It can be opened using the easel button 
on the Menu Bar, or with the Canvas Positioner 
option in the View Menu.

Move The Canvas: Click and drag on the move icon in the panel to move the 
Canvas.

Zoom The Canvas: Click and drag up  and down on the magnifying glass icon 
in the panel to zoom the Canvas in and out. You can also click the percentage 
indicator text in the Zoom Button to set zoom level by entering a number.
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Rotate The Canvas: Click and drag in the outer ring of the panel, this causes 
the Canvas to rotate. The dot on the ring shows you the direction the top of 
the Canvas is pointing. If you click the arrows around the edge of the ring the 
Canvas will immediately jump  to that angle. You can also click the rotation 
indicator above the top arrow to set the rotation by entering a number.

You can close the Canvas Positioner by clicking the X button in the middle. 
You can move the Canvas Positioner by clicking and dragging in the area 
outside the rotation ring.

Behind the Canvas.

If you move the Canvas so that it does 
not fill the ArtRage window you will be 
able to see the area behind it. That 
area is tinted with a single color that 
you can adjust if you want to make the 
Canvas clearer.

In the ‘Interface’ section of the ArtRage 
Preferences Panel you will find the 
‘Background Color’ option which can be 
used to change the color beneath the 
Canvas.

You can also set the Background Color using a menu option if 
you Right Click the Canvas.

Workbench Mode.

Sometimes you might want to clear all the Pods and Panels off the Canvas 
and have a completely clean space to paint in. ArtRage lets you do this using 
Workbench Mode. You can find Clear Workbench mode in the ‘View’ Menu. If 
you turn this mode on, all the Pods and Panels that are currently overlapping 
the Canvas will vanish.

You can also turn Workbench Mode on and off by right clicking on the 
Canvas, or pressing the Enter key.

If you have two monitors, you can move all of your Panels to the 
second monitor, then active Clear Canvas Mode and have a 
completely clear ArtRage Canvas for painting, while still being 
able to use your controls.

Workbench Mode gives you access to a compressed form of the interface that 
allows you to work with as much of the screen clear as possible. For more 
information on how to use this, see the Toolbox and Workbench section later.

Canvas Properties.

The look of the Canvas and how other tools interact with it is controlled using 
settings that are available in the Canvas Panel. You can open the Canvas 
Panel using the Canvas Settings option in the View Menu.

This panel contains all of the options available for 
defining how your canvas looks.

At the top  of the panel is a preview of the current 
canvas, and if a preset has been selected its name will 
appear here.

Click the top  preview area to get a menu of canvas 
options including the ability to reset your canvas, store 
default canvases, and load presets from the Canvas 
Collection.

The following options are available in the Canvas 
Panel:

1. Canvas Lighting: The texture of the canvas and the paint strokes that 
you apply is created by a ‘Lighting’ system. Turning off the Canvas 
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Lighting removes all texture effects so paint texture will vanish and the 
canvas will appear perfectly flat.

2. Canvas Color: Click the color sample to choose the color of the canvas. 
Click and hold to bring up a Popup Color Picker for quick selection.

3. Opacity: Controls how opaque the canvas is. Transparent Canvases in 
ArtRage are represented by checkered squares. When Exporting files it is 
important to remember that a transparent Canvas is not understood by all 
file formats, and some other applications don’t recognize them even if the 
file format does. For more information see the section on Importing and 
Exporting.

4. Metallic: Controls how metallic the surface of the Canvas is. Metallic 
Canvases reflect light differently and if this value is high the Canvas 
Texture will become much more visible.

5. Grain and Pattern Tabs: These tabs give access to specific controls for 
the Canvas Grain and Canvas Pattern.

Canvas Grain.

The texture of the canvas is defined by a Grain image. The grain image 
defines the high and low points of the surface of the canvas which, in turn, 
interacts with the painting tools as you work.

When you select the Grain tab  a set of controls appear for selecting and 
manipulating the canvas grain.

1. Preview Control: This displays the current Grain image. Click in this area 
to select a new image either from disk or from the Grain Collection.

2. Grain Size: Controls how big the grain is. The higher the value the larger 
the grain will be.

3. Roughness: Controls how rough the Canvas Texture is. The value can 
be taken up  to 100% or down to -100% to invert the high and low points of 
the grain. The closer the slider is to its edges, the rougher the grain will be 
and the more it will affect paint strokes.

Canvas grain images are black and white, they use the brightness of the 
image to determine what is a high point and what is a low point in the texture. 
Dark patches will become dents in the Canvas, while light patches will 
become peaks.

You can create your own Grain Images and import them to the Grain 
Collection by clicking the grain preview and using the Resource Collection 
panel to import a new item.

Canvas Pattern.

Canvases can have colored patterns applied to them to represent colored 
variations in the surface. For example, a hand made paper might have tiny 
colored threads in it, or a natural surface such as wood or stone might have 
color variations.

When you select the Pattern tab  a set of controls appear for selecting and 
manipulating the canvas pattern.

1. Preview Control: This displays the current Pattern image. Click in this 
area to select a new image from disk or from the Pattern Collection, or to 
clear the current image.

2. Opacity: Controls how opaque the Pattern is against the canvas.

3. Scale: The Pattern image is applied in tiles to fill the canvas. This slider 
controls the Scale of the pattern image. 100% indicates that the Pattern 
will be at its normal image size.

Default Canvases.

Clicking the preview at the top  of the Canvas Panel opens a menu that allows 
you to set and clear the Default Canvas. If a Default Canvas is set ArtRage 
will use that canvas whenever a new file is created.

If you have a Default Canvas set you can clear it using the same menu. If no 
Default Canvas has been set ArtRage uses a basic paper when new files are 
created.
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Resizing the Canvas.

If you want to resize your Canvas there are two ways to do it: Resize the 
Canvas along with its contents, or expand or crop  the Canvas without 
changing its contents.

Resizing the Canvas is like taking a piece of patterned elastic and stretching 
it, the patterns expand with the elastic as it grows. Expanding or Cropping the 
Canvas is like taking a piece of paper with a picture on it and either sticking 
more paper to it to expand the space you can draw in, or slicing off part of the 
paper, reducing the area available for drawing in but not changing the size of 
the contents.

These two types of resizing can be achieved using the ‘Resize the Painting’ 
and ‘Crop/Expand the Canvas’ options in the Edit Menu. Both options bring up 
a panel that allows you to define the new target size for the Canvas.

Resizing.

To stretch or shrink the Canvas and all its 
contents select the ‘Resize the Painting’ option 
from the Edit menu. This option brings up  a 
resize panel that allows you to enter a new size 
for the painting.

The basic size settings in this panel work in exactly the same way as the ones 
in the New File Panel. See Creating a New File.

There are two important new settings:

Preserve Original Aspect: If this item is turned on, the size you entered will 
be automatically adjusted to maintain the original width to height ratio of the 
painting. For example, if you have a 200 x 200 painting (square aspect) and 
you have this item ticked, if you set Width to 300 Height will automatically 

adjust to 300 to maintain the aspect. If you want to change the aspect of the 
painting, turn this item off.

Percentage Size: You can size the Canvas to a percentage of its original size 
if you wish. Next to the Width and Height items are percentage text boxes that 
allow you to enter a percentage size to use.

If you edit the Pixels Per Inch setting when you are in Screen Mode the size of 
the Canvas will not change (remember that Pixels Per Inch just tells the 
printer how many pixels you want it to print in an inch, so you’re not actually 
changing the screen size of your painting when you edit that setting). The 
print size will update to reflect the change.

If you click OK the entire Canvas and all of its contents will be changed in size 
to match the new size you requested.

Cropping / Expanding.

To change the area of the Canvas without 
changing the size of its contents select the 
‘Crop / Expand the Canvas’ option from the 
Edit menu. This option brings up  a Crop/
Expand panel that allows you to enter a new 
size for the painting.

The basic settings in this panel work in exactly the same way as those in the 
Resize panel detailed above. There is one additional set of controls:

Position Of Contents: At the bottom of the panel is a preview showing you 
where your current Canvas contents will be inside the new area of the 
Canvas. When youchange the size using the controls at the top  you can drag 
the preview below around to position your painted contents.
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If your new Canvas size is smaller than your painted contents you will lose 
any content that is not on the Canvas after the resize. You can Undo the crop 
if you want to after it is completed.

The menu to the right of the content preview allows you to quickly select 
default positions for the content inside the new Canvas area.

If you click OK the Canvas will be resized to the new size but the contents left 
at their original size.

Crop to Selection.

The Crop  To Selection item in the Edit menu allows you to crop  the Canvas 
down to fit a selected area. Select the area you wish to appear in the new 
Canvas space and select this option. The Canvas will be trimmed to fit just the 
selection.
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Layers.

Layers are a powerful tool that can allow you to quickly make changes to your 
painting without damaging paint above or below, but understanding them can 
be difficult. This section explains what layers are and how to use them.

What are Layers?

Layers are like sheets of transparent paper that can be stacked on top  of each 
other and painted on. As many of these sheets can be stacked on top of each 
other as you like, and you can paint on any of them at any time. This means 
you can build up a painting by putting different parts of it on different sheets.

For example, a painting of an apple might start out with 
the table and background on their own layer, then on to 
a new sheet above you paint the apple itself.

The apple covers the table, but you could at any time 
erase it and still see the table behind because the table 
and apple are on their own sheets.

Layers can be used to simulate the drying of paint. Take the apple example 
again: If you paint the table on a real canvas, you would generally wait for the 
paint to dry before painting the apple over it. In our case, we paint the table on 
a Layer then add a new transparent Layer so that we can paint the apple. The 
table paint beneath is still there but it’s not mixing with the apple paint, so it’s 
like we’ve left the table to dry. Of course, if we want we can still go back and 
paint on the table layer and it will be like it was before, wet and smearable, but 
it still won’t blend with the apple.

When there’s a transparent area of a layer, we illustrate this in its preview by 
putting checkers in the hole. You can see this in the apple layer above.

As explained in the section on The Canvas above, all layers are transparent 
and sit on top  of the Canvas so you can see the Canvas Texture through 
them. If we make the background Canvas transparent we’d see checkers in 
our painting, not just the mini-preview. Don’t worry, those checkers won’t be 
there if you print your painting or Export it. They also won’t blend with your 
colors as you paint.

For more information on how to work with layers in ArtRage see The Layers 
Panel.

Types of Layers.

There are three types of layer in ArtRage:

1. Paint Layers: These are normal layers that can be painted on with all the 
normal painting tools.

2. Text Layers: These layers contain text that can be edited with the Text Tool.

3. Sticker Layers: These layers contain Stickers that can be edited using 
various tools.

For more information on how to recognize what type a layer is see The Layers 
Panel.
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Layer Groups.

Sometimes in a complex document that has many 
layers you might want to group them together to make 
it easy to locate them, to edit them, or to show or hide 
them while you are working on other things. In our 
apple example above, we might want to hide the apple 
so that we can see the table layer beneath and paint in 
the contents of the white hole. But what if the apple 
was painted on to its own set of layers, rather than just 
one?

In this example the apple and table layers have been 
grouped together differently. The apple is actually made 
up  of multiple layers of paint on top  of each other, 
which we can see when we open up  the Layer Group 
it’s in.

When the group is opened, we can see that the apple is made up of two 
different layers. The stalk is at the top, the main body of the apple is below. 
The advantage to placing these items in a group is that you can collapse it 
down so that you don’t need to see them when you’re working on other things. 
Better yet, if you want to make the apple smaller you can just make the Apple 
group smaller and everything inside it scales as well.

At the bottom of the Layer Panel is a button that allows you to create 
a new Layer Group.

Blend Modes.

Blend Modes can be used to tell layers to interact with layers beneath them in 
different ways. By setting Blend Modes you can make paint darken paint 
below, tint it, or otherwise adjust it. ArtRage provides a number of Blend 
Modes, including standard ones from Adobe Photoshop and some of its own.

The default Blend Mode applied to each Layer is ‘Normal’, which means that 
paint will sit on top  of paint on the layer beneath and cover it over like normal 
paint on a surface. There are four other modes specific to ArtRage.

Tint: The tint mode takes the color of the paint on your 
layer and tints the paint underneath it. In this example the 
blue stroke has applied a blue tint to the darker grey 
stroke beneath. Use this mode if you want to apply color 
to something that has none, or tint the color below with a 
new color above.

Shadow: The shadow mode darkens paint beneath it, 
allowing you to make subtle adjustments to the shading 
of paint from a layer above. In this example the grey 
stroke has darkened the stroke underneath.

Highlight: The highlight blend lightens paint beneath it, 
allowing you to make paint brighter by applying paint 
above it without washing it out to plain white. In this 
example the green stroke has lightened the stroke 
underneath.

Watercolor: This blend mode is a special mode that can enhance the look of 
your Watercolor strokes if you are painting on multiple layers. 

Other Blend Modes are from Adobe Photoshop and may not produce 
predictable results, they are included so that you can pass documents back 
and forth easily between the two applications without losing data.

For details on how to apply Blend Modes to Layers see the Layer Panel 
section.
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Bump Blend Modes.

ArtRage also allows you to change the way the volume of your paint builds up 
over multiple layers. There are three available Bump Blend Modes:

Maximum: The default mode. ArtRage uses the thickest 
volume of paint on all layers, as if the strokes were all on 
the same surface.

Replace: ArtRage uses the volume of the topmost layer, 
as if it had cut through the layers beneath.

Add: ArtRage adds the volume of the top  layer to the 
volume of the bottom layer, as if the top  stroke was laid 
on top of the bottom one.

For details on how to apply Bump Blend Modes to Layers see the Layer Panel 
section.

The Layers Pod.

When the Layers Pod is visible click it to show the Layers 
Panel. Click and hold down on it for a menu of layer options. 
The Layers Pod shows a preview of the contents of the 
current layer.

The Layers Panel.

The Layers Panel contains all the controls you need for 
creating and manipulating layers. It contains a visual stack 
of all of your layers with previews of their contents and 
controls for each of them.

The + button adds a new layer above the current layer. 
The Folder button adds a new layer group. The trash can 
button deletes the current layer. The menu button provides 
options for the current layer.

This section contains information on how to use the various options available 
in this menu and in the layer thumbnails.

Layer Thumbnails.

The top  area of the Layers Panel is taken up by a list of 
layer entries. Every layer you have in your document is 
represented here by a thumbnail that has additional controls 
for manipulating that layer.
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The layer thumbnails are stacked in their vertical order on the Canvas, so the 
topmost thumbnail is the topmost layer visible in your painting. When you 
create a new layer it is added on top of the currently selected layer.

The current layer is lit up  in the stack. This is the layer you will be applying 
paint to if you paint a stroke on the Canvas. To select a layer for painting, click 
the thumbnail.

When your mouse hovers over the thumbnail a set of buttons becomes 
available. The buttons fade out when your mouse pointer leaves the area of 
the layer unless they are indicating that the layer has a special state. Which 
buttons appear depend on the type of layer you are pointing at:

Layer Visibility: Click to set whether the layer is visible on the 
Canvas. If the layer is not visible, the eye icon loses its central dot. 
This button stays visible if the layer is hidden.

Layer Opacity: Click and drag up  and down on this button to change 
the opacity of the layer. The circle fills in to indicate how opaque the 
layer is. If you hover the mouse over this button the Tooltip  will 
indicate your precise opacity. Click this button to enter the opacity 
value manually. This button stays visible if the layer is not 100% 
opaque.

Menu Button: Click for a list of layer options. When you use the 
layer thumbnail menu button rather than the menu bar layer options 
menu item or the menu button at the bottom of the Layers Panel the 
options refer to the layer you clicked, not the current layer.

Layer Locks (Paint Layers Only): This button allows you to lock 
various aspects of the layer to prevent editing. If the lock icon is open 
then nothing is locked, if it is closed then some aspect of the layer 
has been locked. Locks can be applied as follows:

1. Lock All: This option prevents any changes being made to the 
layer.

2. Lock Transparency: Locks the layer so that no new areas of 
paint can be added. Existing paint can be changed but where 
there is no paint on the canvas already, no new paint will be 
added when you make a stroke.

3. Lock Paint: Locks the layer so that no new areas of paint can be 
added and existing paint cannot be modified by paint strokes.

4. Lock Position: Locks the layer so that it cannot be scaled or 
moved by the Transform tool.

This button stays visible if any lock is applied to the layer.

Text Options (Text Layers Only): Click for a set of options for the 
text layer. This button is always visible for text layers.

Sticker Options (Sticker Layers Only): Click for a set of options for 
the sticker layer. This button is always visible for sticker layers.

Layer Blend Mode: This button is only visible if you have selected a 
layer blend mode other than ‘Normal’ from the layer options menu. 
The icon indicates the current mode if it is Tint (T), Shadow (-) or 
Highlight (+). Any other mode is indicated by an ellipsis. Click the 
button to select a new Blend Mode for your layer.

Layer Groups.

Layer Groups are represented by two icons in the stack of thumbnails: A title 
bar and a grip. Click the name in the title bar or the grip  to open or close the 
group.
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When a group  is open all the layers it contains are displayed between the title 
bar and the grip and the folder icon on the group title bar will open up.

The group  menu button on the right side of the title bar gives you options for 
the group including setting the group name and opacity value.

Naming Layers.

If you want to give a layer a name so that it is easier to locate in the future 
click the Menu Button on the layer thumbnail and select the ‘Set Layer Name’ 
option. Enter a layer name and click OK and the thumbnail will update to show 
the new name. If you enter a blank name, the layer name will vanish from the 
thumbnail.

Creating New Layers.

To create a new layer click the ‘+’ button at the bottom of the Layers Panel. 
You can also select the ‘Add Layer’ option from the layer options menu. If you 
want to make a copy of the current layer select the ‘Duplicate Layer’ option 
from the layer options menu.

If you are using a tool that relates to a special layer type such as the Sticker 
Spray or Text Tool you do not need to create a new layer to use them. If you 
have a Paint Layer currently selected, clicking with either of those tools 
automatically creates a new layer of the correct type for their content. If you 
have already added a layer but have not added any paint to it, clicking in that 
layer with the Text Tool or Sticker Spray converts the layer to the appropriate 
type for editing with the tool.

If you try to paint with a painting tool on a non Paint Layer ArtRage will 
automatically create a new layer for the paint to go on.

You can create a new Layer Group  using the folder button at the bottom of the 
Layer panel or by selecting the Add Layer Group  option in the layer options 
menu. When you create a new Layer Group  it is added above the currently 
selected layer.

Moving Layers.

You can move layers around in the stack to change the appearance of your 
Canvas. To move a layer click and drag it up and down.

While you are dragging, an arrow in the stack indicates where the layer will be 
dropped when you release the mouse button.

If the arrow points between the title bar and grip  of a Layer Group the layer 
will be dropped in to the group. If the group  is closed, the layer will not be 
visible in your stack when you drop it.

Exporting Layers.

The layer options menu allows you to export the contents of a single layer to 
an image file. Because layers have transparency, you should export to a file 
type that supports transparency such as PNG  if you are exporting a single 
layer.

The Export Layer To Channels option exports the layer to a series of files that 
contain the different values that make up  an ArtRage layer including the color 
of the layer, its paint volume and its reflectivity. This option can be used if you 
want to import layers from ArtRage in to a 3D package for rendering.

Merging and Flattening Layers.

You can merge multiple layers in to a single one if you are sure you do not 
want to edit them independently any more. This can save memory in large 
documents, or allow you to blend paint that was applied to different layers. To 
do this use the layer options menu.

Merging the current layer down causes the currently selected layer to merge 
with the layer directly beneath it. Merging all layers causes the entire painting 
to be merged in to a single layer. The contents of Layer Groups can also be 
merged in to a single layer by using the option menu in the group title bar.
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When layers are merged, any layers that are hidden are discarded. The 
merged result is intended to look like the Canvas you can currently see so 
before merging all layers or a layer group make sure that the right layers are 
visible.

If you want to use standard paint tools on a Sticker Layer or a Text Layer you 
will need to convert the layer to a Paint Layer. The Text and Sticker icons that 
appear at the top  right corner of the layer thumbnail for those layer types 
provide an option to flatten the layer to paint. This converts the layer to a Paint 
Layer.

When you flatten a text or sticker layer you can no longer edit it using the 
original tool that created it. So if you want to edit text you add to a layer, avoid 
flattening that layer.

When a text or sticker layer is merged with any other layer it is automatically 
flattened.
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Selections.

ArtRage allows you to mark areas of your Canvas with a Selection. When an 
area is selected the operations you carry out are limited to that specific area. 
For example if you select an area then paint, the paint will only be applied 
inside the area you selected. Think of Selections as easy masking tools 
allowing you to block off areas of the Canvas you do not want to change.

This section explains what you can do with selections and how you can 
manipulate them. For information on basic selection creation see the 
Selection Tool section.

Working With Selections.

The Edit Menu provides some basic tools for manipulating selections. Select 
All selects the entire Canvas, while Deselect All removes any current selection 
you have. Invert Selection selects the opposite of your current selection. 
Select Layer Contents is used to create a selection that matches the paint on 
the current layer.

Do not use Select Layer Contents before you use the Transform 
Tool, or you will leave semitransparent pixels on your Canvas. If 
there is no selection the Transform Tool will transform all the 
contents of the layer automatically.

When you have a selection active it is outlined on your 
Canvas by a series of animated dashes. Everything 
inside those dashes is selected, everything outside is 
unselected.

If you have used a feathered selection the dashes indicate the area of the 
selection that is 50% opaque or more, there may be an area outside the 
dashes that can still have paint partially applied.

When you have a selected area it limits where paint can be applied on your 
Canvas. Painting outside the selection will not apply any paint, painting inside 
it will apply as much paint as the selection allows.

If you use Copy or Cut in the Edit Menu when a selection is active the 
contents of the selection will be copied to the clipboard.

If you click with the Transform Tool inside a selection the contents of that 
selection will be transformed. For more information see the Transform Tool.

Partial Selections.

If you have a feathered selection or if you have painted a 
less than 100% opaque selection using Paint Selection 
mode, your selection will contain pixels that are less than 
100% selected. This is the equivalent of adding masking 
tape that allows some but not all of the paint you apply 
through.

If you paint over a partial selection your painted result will be less than 100% 
opaque.

If you Cut the contents of a partially selected area only some of the paint will 
be removed, leaving some of it behind.

Selection Shortcuts.

While you are creating selections using the Selection Tool there are a number 
of keyboard shortcuts you can use to make the process faster.

While you are dragging to create a selection:
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1. Hold down Shift when using the Rectangular or Elliptical tool type to lock 
the selection area to a square or circular aspect.

2. Hold down Option (Mac OS X) / Alt (Windows) to drag the selection from its 
center point outwards.

3. Hold down the Spacebar after you have started to drag to drag the position 
of your entire selection without changing its size.

If you already have a selection created:

1. Hold down Shift before dragging a new selection to Add the new selection 
to the old one.

2. Hold down Option (Mac OS X) / Alt (Windows) before dragging a new 
selection to Subtract the new selection area from the old one.

3. Hold down Shift and Option (Mac OS X) / Alt (Windows) before dragging a 
new selection to have the result be the intersection of the old and new 
selected areas.

4. When dragging your second selection, if you had any keys held down you 
can release them after the drag has started and press them again to 
constrain the aspect of your selection or create it from its center point as 
with the instructions above.

These shortcuts do not work when using the Paint Area tool type. Some of 
these options do not work when using the Magic Wand tool type.

When there is a selection active:

1. Press or hold down the arrow keys on your keyboard to move the selection 
1 pixel at a time.

a. Hold down the Shift key to move 10 pixels at a time.

2. Click and drag inside the selection when the Selection Tool is active to 
move it.
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Transformations.

If you want to change the size, position, or rotation of something on your 
Canvas you can use the Transformation system. This system allows you to 
take all or part of a layer, a sticker, or text that you have entered and freely 
edit these properties. Items that can be transformed are: Paint Layers, Text 
Layers, Sticker Layers, and Stencils.

You can start a transformation either by selecting the 
layer you wish to transform and using the Transform 
option in the Edit Menu, or by selecting the 
Transform Tool and clicking the object you want to 
transform.

When an object is ready to be transformed the 
transform area is outlined with a set of handles that 
can be used to manipulate object.

Your cursor will change as you pass over the handles and areas of the 
transform area to indicate that you can drag. Exactly what happens when you 
click and drag there depends on the type of transformation being applied.

Normal Transformations.

If you use the Normal Transformation Type in the Transform Tool (or if you 
trigger a Transformation using a menu option) you will be able to scal, move, 
and rotate the object you are transforming as follows:

1. Corner Handles: Click and drag these inward and outward to scale the 
object. If your object allows it, you can scale the horizontal and vertical 
axes differently. Hold down Shift to force the transformation to be applied 
equally to both axes and maintain the original aspect of the object.

2. Outside the Corner Handles: Click and drag just outside the corner 
handles to rotate the object around its center point. Hold down Shift to 
constrain rotation to 15 degree increments.

3. Edge Handles: Objects that allow you to scale the horizontal and vertical 
axes independently display handles on the edge of the transform area. 
Click and drag these handles to scale that axis only.

4. Inside the Area: Click and drag inside the transform area to move the 
object. Hold down Shift to constrain movement to one axis only.

5. Outside the Area: Click and drag outside the transform area to accept 
and end the transformation.

6. Right Click inside the Area: Opens a menu of options that can be 
applied to the object you are transforming.

7. Arrow Keys: You can move the object you are transforming using the 
arrow keys. Press a key to move it 1 pixel in that direction, or press Shift 
and an arrow key to move it 10 pixels.

If you are transforming a single sticker on a Sticker Layer that 
has multiple stickers you can press the Tab key to accept the 
transformation and move the outline to the next sticker, or Shift + 
Tab to move it to the previous sticker.

If you have a Multitouch input device and are using an operating 
system that supports it you can use Multitouch Gestures to 
manipulate the object you are transforming.

1. Use two fingers to drag on the object to move it.

2. Use two fingers and pinch inward or outward on the object to 
scale it.

3. Use two fingers and twist on the object to rotate it.
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Non Uniform Transformations.

The Transform Tool allows you to apply a Non Uniform Transformation. This 
type of Transformation changes the behavior of the Corner Handles that 
appear on the transform area.

While Normal Transformations retain the original 
rectangular shape of the transform area, Non Uniform 
Transformations allow you to drag individual corners out 
of line with their neighbors. This means you can stretch 
the object out of its normal shape.

Click and drag a Corner Handle to stretch the object.

As you stretch it, the entire contents of the transform area 
deform to fit the new outline you have created.

Hold down Shift while you drag a Corner Handle and the 
other Corner Handles will mirror its motion.

For example, if you Shift-Drag the bottom left Corner 
Handle to the left, the bottom right Corner Handle will 
move right, and the top Corner Handles will move 
horizontally towards each other.

Non Uniform Transformations do not present Edge Handles to drag.

Perspective Transformations.

Perspective Transformations work line Non Uniform Transformations in that 
they allow you to drag a corner independently of the connected corners. 
When you do this, ArtRage treats the new shape as if it was a 3D surface that 
has been tilted. This causes the contents of the transform area to deform in a 
slightly different way to that of a Non Uniform Transformation, applying 
perspective to the result.

Non Uniform Transformation Perspective Transformation

In the Non Uniform version you can see that the circle has been ‘squashed’ 
inside the transform area. In the Perspective version the circle is ‘tilted’ as the 
bottom left handle is dragged up, retaining its original shape projected in 3D.

Transforming Layers.

If you transform a layer or group  of layers the outline will be drawn large 
enough to contain the layers you are transforming.

If the layers being transformed include text or sticker layers and you transform 
the group  in a way those layers cannot support (squashing them along one 
axis for example) you will be prompted before the transformation is applied. At 
this point you can choose to flatten the non Paint Layers so they can be 
squashed, leave them as their current layer type and transform them as much 
as possible, or cancel the operation.

When you transform layers ArtRage turns off its lighting effects to 
speed up the process of positioning. When you accept the 
transformation the lighting effect turns back on and you will see 
the texture of your paint again.
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Tracing and References.

ArtRage provides a range of tools to help you recreate existing images as 
paintings or guide you while you paint: Tracing Images and References.

Tracing Images are existing images that can be loaded in to ArtRage and 
projected on to your canvas to help you choose colors as you paint.

References are items that are pinned to the canvas to give you a guide while 
painting. They can be existing images, ‘scraps’ of paper to sketch ideas on or 
mix paint on, or views that display parts of your canvas while you work.

This section explain how to use these systems.

Pods.

Tracing Pod: If you do not have a Tracing Image loaded, 
clicking this Pod opens a file picker to allow you to load one. 
If you do have a Tracing Image loaded, clicking this Pod 
opens the Tracing Panel. Click and hold for a menu of 
Tracing Image options. This Pod contains a preview of the 
current Tracing Image if there is one.

Refs Pod: Clicking this pod opens the Reference Panel. 
Click and hold for a menu of Reference options. The Pod 
indicates how many References you currently have 
available.

Tracing Images.

A tracing image is an existing image of any kind, such as photos or images 
produced in other software, that is loaded in to ArtRage and projected on to 
the Canvas like a film projected on to a wall. This allows you to use it as a 

guide for shapes as you paint, and you can even use it to set the color that 
will be applied for each stroke. Using a tracing image allows you to recreate 
existing images using the painting tools in ArtRage and give them your own 
artistic touches.

Tracing Images are saved with your painting but if you export or 
print the painting they will not be visible. They are guides to 
painting projected on to the Canvas rather than paint on a layer.

The Tracing Panel.

If you have a Tracing Image loaded and you click the 
Tracing Pod, or if you use the Tracing Panel option in the 
View menu, the Tracing Panel appears. This panel allows 
you to load or clear Tracing Images and manage their 
properties.

The preview at the top  of the panel shows the current tracing image, it can be 
clicked to load a new one. Beneath the preview are three buttons for showing 
or hiding the tracing image, transforming it, and accessing the tracing options 
menu for setting the various properties of your image. At the bottom of the 
panel is an Opacity slider used to set how visible your tracing image is on the 
Canvas.

Managing Tracing Images.

You can load a tracing image using the option in the tracing options menu in 
the Tools menu or on the Tracing Panel. This menu also allows you to clear 
the current tracing image. Clearing the image removes it completely, unlike 
hiding it which leaves it invisible but still usable.

The Convert Tracing Image To Paint option in the tracing image options menu 
allows you to convert the current tracing image to paint on the current layer. 
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When you select this option the tracing image is immediately recreated as 
paint on the Canvas so you can smear and work with it as if it was an 
imported image. 

Converting a tracing image to paint does not remove the tracing 
image, it will remain visible on top of the converted layer. To see 
the converted paint color without the tracing image on top, just 
hide or clear the image.

Automatic Color Selection.

ArtRage can automatically select colors from the currently loaded tracing 
image as you paint. The first time you load a tracing image this happens 
automatically, but you can turn the feature on or off using the tracing options 
menu in the Tools menu or on the Tracing Panel.

When the automatic color selection option is on the color picker updates to 
indicate this. Click the text to turn automatic selection off if you wish.

Every time you start a paint stroke with this option on ArtRage selects the 
color that is under your pointer in the tracing image. This lets you concentrate 
on the shape and flow of the strokes rather than the color.

You can still use the automatic color selection feature of Tracing 
Images if your image is hidden or at low opacity, those controls 
only display how visible it is to you.

Positioning Tracing Images.

The tracing options menu in the Tools menu or on the Tracing Panel allows 
you to set the scale of your tracing image. The options in the Tracing Image 
Scale menu allow you to control whether the image is stretched to fit inside 
the Canvas, stretched so that it retains its original shape but fills as much of 
the Canvas as it can, or repeated to fill the Canvas if it is too small to do so on 
its own.

The Manual Scale and Tile options allow you to use the Transform button on 
the Tracing panel to move and scale your tracing image as you wish. At any 
point while you are doing this you can use the reset option in the Tracing 
Image Scale menu to reset the image back to the center of your Canvas.

You can only click the Transform button on this panel if your 
Tracing Image is set to Manual Scale mode.
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References.

References are pieces of paper that are pinned to your canvas to act as a 
visual guide or aid to painting. There are three types of Reference, each of 
which has different properties:

Reference Image: An image such as a photograph that is pinned 
to the canvas to act as a visual guide.

Scraps: Scraps are mini-canvases you can paint on. They are 
pinned to the canvas and can be used as mixing palettes or test 
areas for painting without altering your canvas.

Views: Views are alternative ‘windows’ in to the canvas. A view 
can be set to display all or part of the canvas and lets you zoom 
and pan independent of the main canvas window to view other 
areas while you work.

This section explains the differences between the three types and how you 
work with them from the References Panel.

The References Panel.

When you click the References Pod the References 
Panel opens. In this panel is a list of all the References 
currently available.

Each item in the list has an icon at the top right indicating 
what type of Reference it is. Clicking that icon brings up  a 
list of menu options for it.

At the bottom of the list is a set of buttons for adding new 
References and accessing general Reference menu 
options.

When you hover the mouse over one of the References 
in the list, a Show/Hide button appears. Click it to toggle 
the visibility of the Reference. This button will remain 
visible when your pointer moves away from it if the 
Reference is hidden.

Manipulating References.

You can add or remove References using the Reference Options menu in the 
Tools menu or from the References Panel. To remove an individual Reference 
either use its menu in the list in the References Panel or right click the 
Reference itself for options.

You can manipulate the size, position and rotation of a Reference by clicking 
and dragging on its area in various ways.

1. Move: Click and drag in the control tray at the bottom of the reference, or 
right click and drag the reference anywhere inside its body.

2. Scale: Click and drag in the white border at the corners of the reference.

3. Rotate: Click and drag in the white border on the edges of the reference.

If you have a Multitouch input device and are using an operating 
system that supports it you can use Multitouch Gestures to 
manipulate the Reference you are transforming.

1. Use two fingers to drag on the Reference to move it.

2. Use two fingers and pinch inward or outward on the Reference 
to scale it.

3. Use two fingers and twist on the Reference to rotate it.
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You can drag References anywhere on your desktop, they do not need to stay 
inside the area of the canvas.

Right click a Reference for additional options you can use to hide or remove 
the reference.

Reference Controls.

Every Reference has a set of controls that appear underneath it in a ‘tray’ that 
slides out when your mouse is pointing at the Reference. These controls allow 
you to access the Reference Options menu for the specific Reference, and 
manipulate its contents.

Different types of Reference have different controls and options detailed 
below but there are some controls common to all Reference types:

Type Icon: You can tell what type of Reference an item is by looking 
at its Type Icon. Click the icon to get a menu of options for the 
specific Reference.

Internal Scale: You can change the scale of the contents of the 
Reference by clicking and dragging on this control. This does not 
scale the Reference, it scales the image you can see inside it.

Internal Position: You can change the position of the contents of the 
Reference by clicking and dragging on this control. This does not 
move the Reference, it moves the image you can see inside it.

Reference Images.

Reference Images are pre-existing images that can be 
pinned to the canvas to act as a guide while painting. 
When you create a new Reference Image you will be 
asked to load an image from disk.

Reference Images display the name of the file that created them in their 
control tray.

Hold down Alt (Windows) / Option (OS X) to sample color from a reference 
image.

Scraps.

Scraps are mini-canvases that can be painted on using 
the current tool.

Scraps can be used as mixing palettes, pieces of paper 
for jotting down notes or ideas, or surfaces for 
experimenting with tool settings without having to edit 
your main canvas.

Scraps use whichever tool is currently selected in the main tool picker and 
whatever color is currently selected in the main color picker.

Scraps have their own Undo / Redo system that can be accessed using the 
Undo and Redo buttons on the Scrap’s tool tray.
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You can sample color from a scrap by holding down Alt 
(Windows) or Option (OS X) and clicking inside it.

Views.

Views are alternative displays of your canvas 
that update live as you paint.

Painting in a View will apply paint to the main 
canvas in the area the View indicates, on the 
current layer, and any paint applied in the 
main canvas will be displayed live in the View.

Views allow you to keep  track of specific areas of the canvas when you need 
to monitor how changes you are making might be adjusting areas you’re not 
zoomed in to or not looking at directly.

Use the Internal Scale and Internal Position controls to change 
which part of the canvas is displayed by your View.
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Stencils.

Stencils are used to create precise shapes or lines on your Canvas. They 
work just like a piece of plastic or wood placed on the Canvas, allowing you to 
paint over them without the paint applying to the Canvas beneath, or draw 
around them to make outlines.

Stencil Modes.

Stencils come in three different types which have different properties on your 
Canvas: Stencil, Ruler, and Guide. Stencils you place on the Canvas can be 
switched between these modes whenever you like.

Stencil: A stencil just prevents paint from being applied 
underneath it on the Canvas. Stencils appear red on the 
Canvas.

Ruler: Rulers help  guide your cursor to create lines on 
the Canvas. Rulers appear grey on the Canvas.

Any Stencil can be turned in to a Ruler but only the 
default Ruler object has measurement marks along its 
length.

When your cursor approaches a ruler and ‘bumps’ 
against it, it will stick as if it was a pen against a physical 
ruler.

You can then draw roughly along the edge of the ruler 
and a straight line will be generated.

The easiest way to draw a line that starts against a ruler 
is to start drawing on the ruler itself. Start drawing on the 
ruler and the stroke will start on the Canvas against the 
ruler edge.

When you draw against a ruler your paint does not go 
underneath it.

Guide: Guides work exactly like Rulers but they do not 
prevent paint from being applied to the Canvas 
underneath them. This allows you to use a guide to 
precisely plot out the centre line of a stroke with paint 
applied on either side. Guides appear blue on the 
Canvas.

Stencil Transparency.

Like real world stencils, ArtRage stencils have solid areas and areas that let 
paint through. Unlike real world stencils however, ArtRage allows your stencils 
to be partially transparent. 

A stencil with different levels of transparency allows differing amounts of paint 
through to the Canvas. If you load an existing image as a stencil the different 
levels of brightness in the image define the transparency.
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Loading a photograph as a stencil lets you lay down paint on top 
of it and see the image beneath when it is removed.

The Stencils Pod.

Clicking this pod opens the Stencils Panel. Clicking and 
holding it brings up  a menu of available Stencils for easy 
selection, and other useful Stencil menu items.

The Stencils Panel.

The Stencils Panel contains all the stencils available for use in ArtRage. In 
this panel you can select and organize your stencils and import new ones 
from disk. On the left side of the panel is a list of groups of stencils. When you 
select a group the right hand side of the panel updates to show the stencils 
that are available in that group.

A lock icon on a stencil indicates that it was installed by ArtRage and cannot 
be overwritten, you can still select it.

Right click an item in the panel to delete or rename it from inside 
the application.

The ‘Active’ Group.

The Active group contains a list of all the stencils you 
have currently placed on your Canvas. Each stencil is 
represented by a preview and when your point at it with 
your cursor two buttons fade in. The Eye button is used 
to show or hide the stencil, and the Menu Button 
provides options for that specific stencil on the Canvas.

If a stencil is hidden the Eye button remains visible when the cursor leaves 
the area of the preview.

The stencil preview indicates the rotation of the stencil and the current mode it 
is in through its color.

Manipulating Stencils.

To use stencils you have to add them to your Canvas. Stencils are utilities like 
panels or References so they do not appear in the final printed picture or if 
you Export a copy of your painting, they sit on the Canvas and act as guides 
or masks and can be moved and deleted without damaging paint.

Adding and Removing Stencils on the Canvas.

To add a stencil that is already in your collection to the Canvas you can either 
click its preview on the right of the panel or click and drag its preview. If you 
click and drag, the stencil will appear on the Canvas and you can position it 
before releasing the mouse button.

Stencils in the Active group cannot be clicked to add to the Canvas.

If you want to load a stencil from disk and place it directly on the Canvas 
without importing it to the stencil collection, use the menu button at the top 
right of the Stencils Panel and choose ‘Select Stencil From Disk...’. This 
allows you to load an image to use as a stencil, it can be done for Rulers and 
Guides too.
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You can also add a stencil to the Canvas by selecting ‘New Stencil From 
Layer Contents’ from the Stencil Options Menu. This option creates a stencil 
that surrounds the contents of the current layer.

To remove a stencil from the Canvas right click it and select the remove option 
from the popup  menu. You can also use the menu button for the stencil 
preview in the Active Stencil group of the Stencils Panel.

Positioning Stencils.

Once a stencil is on the Canvas you can position it freely. Because you may 
need to start a paint stroke on top  of a stencil you can’t just click and drag 
them to move them. To move a stencil you should select the Transform Tool 
and click the stencil you want to move.

For information on how to use the transformation outline to position the stencil 
see the section on Transformations.

Stencils have a Pin that attaches them to the Canvas. The pin is also used as 
the point around which stencils will rotate and scale. To move the pin click and 
drag on the pin head.

You can also position stencils by Right Click Dragging them. 
Right click drag to move, Cmd (Mac OS X) / Ctrl (Windows) + 
Right Click Drag to rotate. Option (Mac OS X) / Alt (Windows) + 
Right Click Drag to scale.

If you have a Multitouch input device and are using an operating 
system that supports it you can use Multitouch Gestures to 
manipulate the Reference you are transforming.

1. Use two fingers to drag on the Reference to move it.

2. Use two fingers and pinch inward or outward on the Reference 
to scale it.

3. Use two fingers and twist on the Reference to rotate it.

You can also use the right click menu for the stencil on the Canvas, or the 
menu button for the stencil in the Active group  of the Stencil Picker to flip  the 
stencil, set its angle precisely, or invert it.

The Reset options in the stencil’s right click menu allow you to set the stencil 
to its actual 1:1 scale for pixel precision, and reset the pin to its default central 
position.

The Straight Line Ruler.

At the top of the Rulers group  in the Stencil Panel is the 
straight line ruler. This ruler can be rotated and changed 
in length using the grips at either end. Click on the grip 
and drag it to the point you want the ruler to end.

The straight line ruler displays pixel dimensions for your painting 
and a print dimension value for your current units and Points Per 
Inch setting in the New File Dialog or Resize Panel. These can 
be adjusted from the right click menu on the Stencil.

Stacking Stencils.

You can stack stencils on top of each other for 
cumulative effect. This works for all modes of stencil so if 
you want to create complex ruler paths, just place rulers 
against each other and draw around them.
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Adding Stencils to the Collection.

New stencils and groups of stencils can be added to the collection using the 
Stencils Panel. At the top  left of the panel is a New Group  button that allows 
you to add a new group, and on the right of the groups is an Import Stencil 
button that allows you to import a new stencil from disk.

When you select the Import button you are presented with a file dialog in 
which you can choose an image to import. The image you select is imported 
in to the current group. If there is already a stencil with the same name as the 
image you will be asked to change the name and try again.

Your Stencil Collection exists on disk as a series of folders representing 
groups and files representing stencils. You can access the folder in which all 
of your user stencils are contained using the ‘Open User Stencils Folder’ 
option in the Stencil Options Menu.

Creating New Stencils.

If you create a stencil using the ‘New Stencil From Layer Contents’ option in 
the Stencil Options Menu it will not appear in the collection. To add it to the 
collection right click the stencil on the Canvas or use the stencil’s menu button 
in the Active group and select Store Stencil In Collection.

A file dialog appears pointing to the location of your user stencils and you can 
save the stencil there.
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Stickers.

Stickers are individual images that can be peeled off a sheet and stuck to your 
Canvas, or sprayed on to the Canvas using the Sticker Spray tool. Stickers 
can be anything from objects such as sparkly gold stars, pebbles, and leaves 
to artistic effect stickers that simulate painting styles. This section shows you 
how to use stickers in your painting and how to create new ones.

Sticker Properties.

Stickers can contain more than just color information. 
Each sticker can have its own texture and even its own 
reflectivity, like a transparent plastic domed sticker you get 
from the supermarket.

Stickers can be tinted when they are added to the Canvas, and 
have their opacity and shadow adjusted. If you want to place a 
rock in to a scene you might not want it casting a shadow, but if 
you’re sticking a gold star or seashells to a photo the shadow 
can look good.

Normal layers lose quality when you change their size or rotate them, but 
stickers can be sized and rotated as much as you like without damaging their 
contents.

Flattened and Floating Stickers.

The most important property of a sticker is whether it has been flattened or 
not. Flattened stickers are applied to the Canvas as if they had been painted 
on and they cannot be edited in way normal stickers can. Floating stickers can 
be moved, scaled, and rotated as much as you wish.

When you apply a single sticker to the Canvas by peeling it off a sticker sheet, 
it will always be Floating. When you use the Sticker Spray to can choose to 
have it either spray Flattened or Floating stickers. For more information see 
the Sticker Spray.

The Stickers Pod.

Clicking this pod opens the Sticker Collection Panel. 
Clicking and holding produces a menu of available Sticker 
Sheets for easy selection. Select a sticker sheet and it 
opens for use.

The Stickers Panel.

The Stickers Panel contains all the sticker sheets available for use in ArtRage. 
In this panel you can select and organize your sticker sheets and import or 
create new ones. On the left side of the panel is a list of groups of sticker 
sheets. When you select a group  the right hand side of the panel updates to 
show the sheets that are available in that group.

A lock icon on a sticker sheet indicates that it was installed by ArtRage and 
cannot be overwritten, you can still select it.

When you click a sticker sheet on the right hand side of the panel it opens up 
and you can use it to apply single stickers to your Canvas.

Right click an item in the panel to delete or rename it from inside 
the application.
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Sticker Sheets.

Stickers are organized in to sheets like the 
collections of stickers you can buy in stationary 
suppliers. There might be a sheet of numbers 
or letters, a sheet of shapes or a sheet of types 
of leaf.

When you click a sticker sheet preview in the 
Stickers Panel the sheet opens up for use.

Adding Single Stickers to the Canvas.

If you want to add stickers to the Canvas one by one you can do so using a 
sticker sheet. To open a sticker sheet, locate it in the Stickers Panel and click 
its preview. When you click the preview the sheet opens up for you to use.

To add a single sticker from the sheet to the Canvas just click it and it appears 
on the Canvas. If you prefer, you can click and drag it from the sheet to the 
desired point on the Canvas.

When you complete the drag, or finish the single click, the sticker appears on 
the Canvas with a transformation outline. For more information on using the 
transformation outline see Transformations.

A single sticker on the Canvas is represented by an entry in the Layers Panel. 
In that panel you will see the sticker you just added along with an icon 
indicating it is a sticker. You can drag it around in the Layers Panel the same 
way you would any other layer. For more information see Layers.

Adding single stickers is great if you want to place some specific 
items at precise points on the Canvas, such as oranges on a 
plate, or seashells on a photo border.

Spraying Stickers on the Canvas.

Sometimes you want to add many stickers to the Canvas at once. The Sticker 
Spray lets you do this by automatically selecting stickers from a sheet and 
spraying them on to the Canvas as you paint with it.

For full information on the basic settings of the Sticker Spray see the Sticker 
Spray section.

When you spray stickers to the Canvas they are either sprayed as flat or 
floating. Flat stickers will spray directly on to existing paint layers, but floating 
stickers will create a new sticker layer if there is not one already selected. 
Even though the floating stickers all apply to a single layer they can still be 
individually manipulated, the layer is just a way of collecting all the stickers 
you spray with the tool together so that you don’t end up with thousands of 
layers in your painting!

Manipulating Stickers.

Floating Stickers on the Canvas can be positioned and adjusted after they 
have been created. Flattened stickers are just paint on the Canvas so you can 
smear and blend them like paint but you cannot change their nature once they 
have been applied.

Moving Stickers.

Because stickers are part of the Canvas they must be used moving the 
Transform Tool. To move a sticker select the Transform Tool and click the 
sticker to transform. The transformation outline appears around the sticker 
and you can use that to scale, rotate, and move it. For more information on 
the transformation outline see Transformations.

If you have a layer with multiple stickers on it you can press the 
Tab key while transforming a sticker to select the next one to 
transform, or Shift + Tab to select the previous one.
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If you have a Multitouch input device and are using an operating 
system that supports it you can use Multitouch Gestures to 
manipulate the Sticker you are transforming.

1. Use two fingers to drag on the Sticker to move it.

2. Use two fingers and pinch inward or outward on the Sticker to 
scale it.

3. Use two fingers and twist on the Sticker to rotate it.

Changing Sticker Color Properties.

Stickers can have their basic tint and opacity adjusted after they are applied. 
Right clicking a sticker brings up a set of options that can be used to adjust 
these properties.

Stickers are objects on the Canvas so their layer must be 
selected to make them active before they can right clicked.

Changing the sticker tint brings up  a Precise Color Picker that allows you to 
tint the sticker as you want. Changing the sticker opacity lets you enter an 
opacity percentage manually.

Sticker Shadows.

Right clicking a sticker gives you the option of 
changing its shadow properties. The Shadow 
Panel gives you control over the size, position, 
color and opacity of the shadow using sliders. 
Click and drag in the preview to the left to set 
the position manually.

You can click the color sample to select color using a Precise Color Picker, or 
click and hold to use a Popup Color Picker.

Erasing Stickers.

To erase a single sticker layer you can delete its layer as you would any other 
layer using the menu button that appears when the cursor points at the layer 
in the Layers Panel.

If you have more than one floating sticker 
on a layer you can erase single stickers 
using the Eraser Tool. Select the layer 
with the stickers on and select the Eraser 
Tool, then click the stickers you wish to 
erase and they will disappear. 

Because floating stickers are real objects on the Canvas, stickers behind ones 
you erase are still whole so they will show through from underneath.

Sticker Spray Variation.

The Sticker Spray has a large number of properties that are used to decide 
the appearance of the stickers that are sprayed. These are controlled in the 
Sticker Spray Variation panel. To open this panel click the ‘Spray Variation’ 
button on the Settings Panel when the Sticker Spray is selected, or select the 
option from the View menu.
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The Spray Variation Panel is laid out in a large grid that gives you a number of 
Properties that can be adjusted down the left hand edge, and Values used to 
adjust them along the top edge.

Each Property can be adjusted by as many Values as you wish, by a certain 
amount varying from -100% to +100%. With 10 Properties and 14 Values this 
gives you an enormous number of potential adjustments you can make to the 
spray.

Every time the Sticker Spray goes to spray a sticker on to the Canvas it uses 
the information defined in the Spray Variation Panel to decide which sticker to 
spray, and what properties to apply to it as it sprays.

Setting Variation.

Each Property on the left that is used by the Sticker Spray can be set to vary 
based on the Values on the top. For example the Scale Property could be set 
to vary based on the Pen Pressure, meaning the harder you press as you 
paint the larger the sprayed sticker can become.

Each slot in the grid contains a token that indicates the current state of the 
variation being applied to the Property by the Value.

No Token: If there is no token in the slot then no variation is 
applied to the Property by the indicated Value.

Green Token: A green token indicates a positive variation 
(1% to 100%) applied to the Property by the indicated Value. 
For example Scale set by Pen Pressure using a green token 
makes the scale Increase as Pen Pressure increases.

Red Token: A red token indicates a negative variation (-1% 
to -100%) applied to the Property by the indicated Value. 
For example Scale set by Pen Pressure using a red token 
makes the scale Decrease as Pen Pressure increases.

To set a variation, click and drag up  and down in its slot. If you drag up  the 
variation becomes positive (a green token appears). If you drag down, the 
variation becomes negative (a red token appears). As the value changes the 
token adjusts like a clock face to indicate the approximate value at a glance.

As you point at various slots an information outline will appear showing 
exactly what properties are being adjusted and the amount of adjustment.

To set a value back to 0, invert it, or set it manually in text just right click the 
slot and use the options there.

If you click on any column or row text header you can clear, 
invert, or set the value for that entire row or column!

If multiple Values are used to vary a single Property each Value is calculated 
in turn. For example if you have X Distance and  Pen Pressure varying Scale, 
the eventual scale is decided by adjusting by its X Distance variation then 
adjusting that result by its Pen Pressure variation.

Variation Properties.

The following properties of the spray and stickers can be adjusted in this 
panel:

1. Sheet Row, Sheet Column: Tells the Sticker Spray which Column or 
Row of the sheet to choose stickers from as it sprays. Sticker sheets do 
not have to be laid out in a grid but ArtRage identifies an approximate 
column and row value for the stickers on a sheet when you import it.

2. Scale: Tells the Sticker Spray how large each sticker should be.
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3. Rotation: Tells the Sticker Spray how much rotation to apply to each 
sticker.

4. Hue, Luminance, Saturation: Tells the Sticker Spray what tint should be 
applied to each sticker.

5. Alpha: Tells the Sticker Spray how opaque to make each sticker.

6. Offset: Tells the Sticker Spray how far to place each sticker from the 
cursor point.

7. Sticker Sequence: Tells the Sticker Spray what order to select stickers 
from the sheet as it places them.

Variation Values.

The following values can be used to adjust Properties in this panel:

1. Base Value: A set value is applied to the property. Eg. Scale at +100% 
makes each sticker as large as it can be.

2. Random: A random value is applied to the property. The larger the 
variation amount the greater the random value can be from 0. Eg. Alpha 
at Random -100% makes the each sticker vary between fully opaque and 
fully transparent.

3. Sequence: The index of the sticker in the stroke is applied to the 
property, so the fifth sticker to be placed is index 5 for example. This value 
loops, if it reaches the minimum amount the Property can be it resets to 
the maximum and vice versa. Eg. Luminance at Sequence -2% makes 
each sticker slightly darker than the last.

4. Tracing H, L, and S: The color values of the Tracing Image are applied to 
the property. Eg. If the H, L, and S properties of the sticker are set to vary 
100% based on the Tracing H, L, and S, the stickers will adopt the color of 
the tracing image beneath them. Note that these values are offsets from 
0, so the color may not match completely if the sticker color is varied 
heavily from a basic red.

5. Tracing Alpha: The transparency of the Tracing Image is applied to the 
property. Areas outside the tracing image are considered to be fully 
opaque. If your Tracing Image has an alpha channel its alpha value is 
used to vary the property. If no tracing image is loaded the currently 
selected color is used Eg. Sticker Alpha at Tracing Alpha 100% varies the 
sticker opacity significantly.

6. Pen Pressure, Pen Tilt, Pen Rotation: If your input device supports 
these features the property is varied based on the value your input device 
indicates. Eg. Size at Pen Pressure 100% makes the sticker get larger the 
more pressure is applied.

7. Stroke Direction: The direction you are painting in is applied to the 
property. Eg. Sticker Rotation at Stroke Direction 100% rotates the sticker 
so that it points in the direction you are drawing.

8. X Distance, Y Distance, Center Distance: Uses the location of your 
stylus in the Canvas to define the property. X and Y distance refer to the 
left to right and top  to bottom distances, so low X distance is at the left of 
the Canvas, low Y distance is at the top. Center Distance refers to the 
distance from the center of the Canvas, so low Center Distance is right in 
the middle. Eg. Size at Y Distance -100% makes the stickers smaller the 
closer they get to the top of the Canvas.

9. Airbrush Wheel, Pen Twist: If your input device is a stylus that has an 
Airbrush Wheel or that supports barrel rotation, the property is adjusted by 
variations in those values. Eg. Rotation at Pen Twist 100% makes the 
sticker rotate as you rotate your stylus.
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Object Sprays and Image Brushes.

There are two default sets of values you can apply to the variation system 
using the menu button in the Spray Variation Panel:

Set Up Settings For Object  Spray: Sets up  the variations so that the Sticker 
Spray will produce a spray of random objects from your selected sticker 
sheet.

Set Up Settings For Image Brush: Set up  the variations so that the Sticker 
Spray will produce a continuous stroke of paint that adopts the currently 
selected color (or Tracing Color if color selection is automatic) as if it was a 
shaped brush head.

Image Brushes are really just a single sticker on a sheet that is used to place 
shaped impressions of color on the Canvas continuously as you paint. They 
do not blend paint like other painting tools but they can be used to create a 
huge range of artistic brush types that have very specific appearances, such 
as sparse bristle brushes and matted hair brushes.

These two default settings give you a starting point for creating new Sticker 
Spray presets.

Adding New Sticker Sheets.

Before they can be used, sticker sheets must be added to the sticker 
collection. This section explains how to do that.

Importing a Sticker Sheet.

At the top of the Stickers Panel is an Import button. This button allows you to 
locate an ArtRage sticker sheet file and select it for import. When you select 
the sheet it is copied to the correct folder for the current sticker group visible 
in the panel.

You cannot import a sticker sheet that has the same name as a sheet already 
in the category. If you try to do so you will be asked to rename the sheet and 
try again.

Once the sheet has been imported it should be visible in the list of sheets for 
the current category and can be selected from the picker or used in the 
Sticker Spray.

Creating a Sticker Sheet.

To create a new sticker sheet click the New button in the Stickers Panel. 
When you click this button the New Sticker Sheet Panel appears. There are 
three main control sections:

1. At the top of the panel you can select the group  to put the sticker sheet in 
and the name to use for it. The Menu Button allows you to create a new 
group and import an existing sticker sheet to edit if you wish.

2. On the left of the panel is a preview of the current component of the sticker 
sheet you are working on.
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3. On the right is a series of slots that can be filled with images. Each slot 
represents a property of the sticker on a back or front layer. Each slot can 
be clicked to load an image (or the ‘...’ button can be clicked), and when an 
image is loaded the ‘x’ button can be clicked to remove it.

4. At the bottom is a pair of sliders that allow you to indicate how many 
columns and rows of stickers you are importing in your image.

Stickers are constructed from two layers each containing optional color, 
texture, gloss, and metallic images. The contents of the Upper Layer sit on top 
of the contents of the Lower Layer, but by creating combinations of images 
you can create complex multilayer effects such as stickers that have texture 
underneath a smooth glossy dome, giving your stickers internal highlights as 
they are moved around on the Canvas.

To Create The Sheet:

1. Prepare your images (see below).

2. Click each of the slots on the right and load in the image that will be used 
for its property.

a. You can click a slot that already has something in it to see it previewed 
on the left.

3. Select how many columns and rows are in your sheet.

4. Select a group and name for the sticker sheet.

5. Click OK.

When you click OK the name of your sheet is checked. If you are attempting 
to overwrite an existing sheet you will be warned and allowed to continue or 
cancel and choose a new name. If the sheet you are attempting to overwrite is 
one of the sheets installed with ArtRage you will be asked to choose a new 
name, you cannot overwrite those sheets.

You can drag images between slots. Click and drag the image 
from a slot to make a copy of it in another slot.

Sticker Sheet Images.

Images are used to tell the stickers what color they are, what texture they 
have, how glossy they are and how metallic their color is. You can prepare 
one or more of these images for your sticker sheet.

The panel that creates sticker sheets constructs them by importing items from 
a grid. When you create your images, make sure they are all the same size 
and that the areas of interest inside them are laid out identically in a grid.

Color Image:

The most important image for most sticker sheets is the Color Image. Without 
a Color Image the sticker will just be a texture on the Canvas.

The Color Image supports 32-bit color, that is to say 
full color with a transparency map. Any type of 
image can be used as the Color Image but only 
types that support transparency, such as PNG, can 
give ArtRage this additional information.

If you do not use a Color Image that has transparency, your stickers will be 
square. If you want them to take on the shape of the item you are creating 
(such as the baubles in this example) make sure they have a transparent 
background. The checkerboard in the example above indicates transparency. 

If you have a Color Image on the Upper and Lower Layers of the sticker the 
Lower Layer will be covered by any non transparent area of the Upper Layer.
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Texture Image:

The Texture Image gives a textured surface to the sticker. Without it the 
sticker is just a flat piece of paper on the surface of your Canvas.

The Texture Image is a greyscale height map in 
which the brighter areas indicate the higher points of 
the texture.

To create a Texture Image it is usually wise to take 
the shape of the items you have placed in your 
Color Image and create your texture based on 
those.

If the Color Image has transparency, there will be no sticker substance where 
the image is completely transparent and your texture will not show through. 

Here, we have created a height map  for the baubles that will create a curve 
over the surface of sphere, note how the height map  goes from dark at the 
edges to light in the center. Also note how the position of the detail in the 
Texture Images matches identically the position of the detail in the Color 
Image.

Gloss Image:

The Gloss Image defines which parts of the surface of the sticker are shiny. 
Generally, shiny parts will only be visible where there is texture that changes 
the angle of the surface so that light reflects.

The Gloss Image is a greyscale image that follows 
the same requirements as the Texture Image. 
Lighter areas are more glossy, darker areas are 
more matte.

Metallic Image:

The Metallic Image defines which parts of the surface have metallic reflection. 
Metallic reflection changes the color of the surface where light reflects from it 
so the easiest way to see it is to have texture as well as your Metallic Image.

The Metallic Image is a greyscale image that follows 
the same requirements as the Texture Image. 
Lighter areas are more metallic, darker areas are 
more plastic.
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Text.

The Text Tool allows you to create editable areas of text on your Canvas. 
These areas can be moved, scaled, and rotated freely and still edited. For 
more information see the section on the Text Tool. This section explains how 
to use the text system while you are editing.

Working With Text - Text Edit Mode.

To create a new text item select the Text Tool and click on the Canvas. If you 
have clicked a blank area of the Canvas a new text layer is created and a 
blinking caret appears showing where text will be entered.

If you click on text that is already on the Canvas that text becomes editable, 
no new layer is created.

While the caret is visible you are in text editing mode. To exit this mode and 
accept the changes you have made either press the Enter key on your 
numeric keypad, or if you do not have one select a different tool or click 
anywhere other than on the Canvas. If you wish to cancel your edit, press 
Escape on your keyboard and your text will be reverted to its original form. 
While editing text you can also use the Undo and Redo buttons on the 
ArtRage Menu to undo or redo the last edit.

While you are editing text you can select characters to 
apply specific formats to. Click and drag over the 
characters you wish to select, or hold down the Shift key 
and use the Arrow Keys on your keyboard to navigate to 
the end of the area you wish to select.

If you make changes in the Text Settings Panel while text is selected, the 
selected text will be changed.

Remember that Text Layers cannot be painted on, a new layer 
will be created if you try to paint on one.

When you type text the current color is used for each character. Clicking in the 
Color Picker will not turn off text editing mode so you can still use it to change 
colors as you type.

Text supports metallic color too! Turn the metallic value up and 
the texture of your Canvas will make the surface of the text 
reflect in metallic fashion.

If you copy characters from another application you can paste them in to your 
current text item using the Paste shortcut key while you are in text edit mode.

Manipulating Text.

If you are not in text edit mode, you can edit a piece of text by selecting its 
layer and clicking it with the Transform Tool. This creates a transformation 
outline you can use to edit the position, scale, and rotation of the text. For 
more information see Transformations.

If you are currently editing text you can transform it by clicking and dragging 
on the Canvas.

1. Move: Click and drag outside the area of the currently editable text to 
move it.

2. Scale: Hold down Option (Mac OS X) / Alt (Windows) and click and drag 
outside the area of the currently editable text to scale it.

3. Rotate: Hold down Cmd (Mac OS X) / Ctrl (Windows) and click and drag 
outside the area of the currently editable text to rotate it.
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Image Adjustment and Filters.

ArtRage provides three basic forms of image adjustments and filters which 
can be found in the Edit Menu: Blur Layer, Adjust Layer Colors, and Add 
Noise.

ArtRage also supports Adobe Photoshop format Filters. You can find a list of 
installed filters in the Edit menu under Filters. Selecting a Filter from that list 
will launch its interface and allow you to apply its effects to the current 
ArtRage layer.

If you try to adjust a non Paint Layer you will be asked to flatten 
the layer before the panel opens, you can only apply adjustments 
to Paint Layers.

Blur.

If you want to apply a blur to the contents of 
the current layer select the Blur Layer option in 
the Edit Menu.

The preview image at the top  of the panel 
shows what the layer will look like after blur. 
Drag in the preview to select the area of the 
Canvas you want to display. As you change 
settings the preview will update instantly and 
the contents of the canvas will update as they 
can with a more detailed preview to avoid 
slowing you down.

The ‘Blur Radius’ slider adjusts how much blurring is applied. Click OK to 
apply the blur, or Cancel to close the panel and leave the canvas unchanged.

Color Adjustment.

If you to make changes to the color on a layer 
select the Adjust Layer Colors option in the 
Edit Menu. This brings up  the Adjust Colors 
Panel.

The preview image at the top  of the panel 
shows what the layer will look like after color 
adjustment. This preview works like the one in 
the Blur Panel described earlier. 

Click OK to apply the changes, or Cancel to 
close the panel and leave the canvas 
unchanged.

The following settings are available in the 
Adjust Colors Panel:

1. Brightness, Contrast: Adjusts the brightness and contrast of the image, 
ranges from -100% to +100%.

2. Hue, Color: Adjusts the hue and saturation of the image, ranges from 
-100% to +100%.

3. Flatten Layer To Bitmap: Causes the texture of the paint to be flattened 
to pixel colors rather than rendered dynamically. Select this if you want 
your color adjustment to work on the highlights and shadows in the bumps 
and dents of the paint on the layer.

4. Colorize With Paint Color: Causes any completely grey areas of the 
layer to be tinted with the currently selected paint color. Set the ‘Color’ 
above 0% slider to adjust how much tint is applied.
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Add Noise.

This filter allows you to add simple noise to any 
paint that has already been applied to the 
layer.

The preview image at the top  of the panel 
shows what the image will look like after the 
noise has been applied. Drag in the preview to 
select the area of the canvas you want to 
display.

The following settings are available in the Add 
Noise Panel:

1. Intensity: Controls how much noise is applied to the image. The higher 
the value, the more noise will be applied.

2. Gaussian Falloff: If this option is turned on the noise generation system 
uses a Gaussian Falloff model, which changes the general smoothness of 
noise application.

3. Monochrome: If this option is turned on the noise that is applied will be 
monochromatic, shifting between darker and lighter variants of the current 
paint color. If it is turned off the noise that is applied will have hue 
variations.

Compatible Filters.

Because Photoshop filters were not written specifically for ArtRage only some 
of them are compatible. ArtRage supports .8bf format filters only (including 
8BF type filters on Mac OS X), other types of plugin will not work.

A list of incompatible filters is maintained by the application so if your filter 
does not appear it may already have been determined to cause problems 
when running in ArtRage.

Ambient Design cannot provide support for any third party plugin used in 
ArtRage or guarantee that it will operate correctly. If you are having problems 
getting a filter going or want to know if something will be compatible before 
purchase, please ask in the Technical section of the ArtRage Forums at http://
www2.ambientdesign.com/forums. Someone there may be able to answer 
your questions.

Adding Filters.

There are two ways to add Filters to ArtRage. The first is to install them to the 
ArtRage Filters Folder, and the second is to tell the application to look in an 
existing filters folder for another application.

You must restart ArtRage after installing Filters for it to detect them.

Installing in the ArtRage Filters Folder.

The ArtRage Filters folder is located in the ArtRage User Contents folder. This 
folder does not exist until it is required so before you install filter go to the 
Tools menu and in the User Content menu select Open ArtRage Filters Folder. 
This option creates the folder and opens it for you.

You can now install filters to the folder. The location of this folder varies 
depending on your operating system, and in some cases can be hidden by 
default. If you need to locate it for an installer to work please open the folder 
using the menu option and use your operating system tools to locate the 
folder in relation t the rest of your folders.
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Scanning External Folders.

It can sometimes be easier to tell ArtRage to scan an external folder to locate 
Filters. To add folders to the list of items to be scanned use the Filters section 
of the Preferences Panel which can be found under the Edit menu.

The Filters section presents you with a list of folders that will be scanned for 
filters. If you have filters installed for another application or outside the 
ArtRage Filters Folder click the + button and locate the folder that contains the 
filters on disk.

When you point the mouse at a filter in the list an ‘x’ button appears. Click that 
button to remove the folder from the list.

You must restart ArtRage after changing the list of filter folders for changes to 
take effect.

Filters and Layers.

Because they were not designed to work with ArtRage, Photoshop  Filters do 
not recognize the additional information ArtRage stores with its layers such as 
the volume of paint on the Canvas and how wet it is. This means that when 
you apply a filter to a layer in ArtRage the layer is converted in to a flat image 
and while you can still work on it with the painting tools it will not smear as 
easily as before.

If you use a filter on a Sticker or Text layer you will be prompted to flatten the 
layer to an image first so that it can be edited.
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Preferences.

ArtRage provides two main areas of customization that are accessed from the 
Edit menu: Application Preferences and Keyboard Shortcuts.

The Preferences Panel.

The Preferences Panel presents a series of categories of settings for various 
elements of the product. To open the panel use the Preferences Panel item in 
the Edit menu.

The Preferences Panel contains a series of groups of settings. Click a grey 
header and its settings will become available. Click again and the group  will 
close.

The menu at the top  right allows you to reset your preferences and manage 
which groups are open.

Some settings require that you restart ArtRage for them to take effect, you will 
be prompted if you change anything that will require this.

Interface.

Settings for controlling the look and feel of ArtRage come under the Interface 
group. These settings are:

Tooltip Delay: Controls how long you must hover over an object before its 
Tooltip appears.

Play  Sounds, Play  Animations: Controls whether ArtRage plays sounds and 
animations for panels and events.

Show Menus In Menu Bar (Mac OS X Only): If this option is turned on the 
ArtRage menus will appear in the ArtRage menu bar as well as the OS Menu 
Bar. This can be useful if you are using ArtRage on a second monitor that 
does not have an OS menu bar on it.

Background Color: Allows you to set the color of the workbench behind the 
Canvas. This color becomes visible if you move the Canvas. Click to set using 
a Precise Color Picker, click and hold for a Popup Color Picker.

Control Tint Color: Allows you to set the tint color applied to controls. The 
color sample can be clicked for a Precise Color Picker or clicked and held for 
a Popup Color Picker.

The Menu button allows you to store custom tints in the list of available tints 
below and manage the current tint color.

The list of custom tints presents a series of default ArtRage tints and a set of 
custom tints that you have defined. Custom tints appear in the list below the 
standard tints. Click a tint in the list to select it.

Advanced Preferences.

Settings that control advanced functionality within the application.

Temporary File Storage: ArtRage allows you to select where temporary files 
that are used to save memory, such as undo and temporary layer files are 
stored. Use the control at the top  of the Advanced Preferences page to select 
a location, or reset to default.

The default location is your operating system’s default temporary file location.

IMPORTANT: Do not choose removable media for this location 
because if the location suddenly becomes unavailable you may 
lose layer or undo data. External media such as USB media can 
also cause significant slowdowns in the application.

Multithreading: Allows you to turn on or off support for Multithreading on 
multiple core processors in ArtRage.

JPEG Quality: Allows you to set the desired quality for exported JPEG 
images. The higher the value, the higher the quality will be and the larger the 
file on disk.
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Store Backup Files: ArtRage can automatically back up  your files as you 
save them. If you’re working on an important project or have any stability 
issues this system allows you to keep  previous versions available. The slider 
indicates how many backup files will be stored, from 0 to 26.

When the value of the slider is above 0, whenever you save a file ArtRage first 
renames the original version of that file on disk, adding ‘_Gen<X>’ to the end 
of the filename, where <X> is replaced by a letter of the alphabet from A to Z.

Each time you save, any previous generations that were backed up are 
renamed as well, increasing their letter of the alphabet by one to indicate their 
age. When the number of backed up  files reaches the limit defined by the 
Store Backup  Files Slider, the oldest one is deleted when the new file is 
saved.

For example, if I have created a new painting and set Store Backup Files to 2:

1. The first time I save, I name the file ‘Test.ptg’ and that file is saved.

2. Next time I save, my original file is renamed to ‘Test_GenA.ptgback’ and a 
new Test.ptg is saved with my new data.

3. Next time I save, my ‘Test_GenA.ptgback’ file is renamed to 
‘Test_GenB.ptgback’, the file I saved previously is renamed to 
‘Test_GenA.ptgback’ and the new data is saved as Test.ptg.

4. If I then save again, because my limit is set to 2, the original file I saved, 
which is now named ‘Test_GenB.ptgback’ is deleted so that the GenA file 
can be renamed GenB, the last saved version can be renamed GenA, 
and the new file can be saved as Test.ptg.

To reload one of the older generations, drag the file on to 
ArtRage and re-save it using a new name, the new file will be 
saved as a PTG file.

Force Whole Pixel Placement: If this option is turned on ArtRage will limit 
the placement of items such as text, selections, and transform operations to 
whole pixel boundaries. Sub  pixel placement (if this option is turned off) can 
be used to place items between pixel boundaries but can result in blurred 

edges where the edge of an object exists between whole pixels in the 
document.

If you don’t understand Whole Pixel v. Sub Pixel systems, leave 
this option turned on.

Input Device.

Settings that control how your input device works.

Cmd/Ctrl + Mousewheel = Zoom: Some systems that use a touch interface 
use mouse wheel events to scroll objects (like the Canvas) rather than zoom 
them. If this is turned on, the Cmd (Mac OS X) / Ctrl (Windows) key must be 
held down when the mousewheel is used to zoom the Canvas. Use this if you 
experience odd zooming behavior while using touch gestures.

Use Realtime Stylus (Windows Only): Realtime Stylus is a Windows service 
for integrated screen tablet input devices. Some graphics tablets do not 
interact well with Realtime Stylus so if you find you are experiencing odd 
behavior such as strokes not recognizing pressure, strokes moving the 
Canvas rather than painting, or strokes only painting a single dot, try turning 
this off, your tablet device may not be interacting well with the operating 
system.

Precise Tablet (Windows Only): Some graphics tablets support a high 
resolution input mode that creates more precise strokes. Unfortunately some 
graphics tablets do not support this but incorrectly report that they do, this can 
cause problems with strokes failing to complete or appearing incorrectly. If 
you are having problems with your paint strokes try changing this setting.

Use Touch Input (Windows Only): Allows you to turn on or off ArtRage 
support for the Windows 7 Touch Screen system. If this is on you can use 
Multitouch gestures on a Windows 7 machine to manipulate various objects in 
the application.
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Cursors.

Settings that control the appearance of your cursor. Select the type of cursor 
you want to display using the large buttons.

If you have a Precise Cursor selected, the Magnify Precise Cursor option 
makes it larger and more visible. Some tools that use Outline Cursors display 
a Precise Cursor by default if your tool size gets very low.

The Opacity slider is available when the cursor is set to Precise, and allows 
you to control the opacity of the cursor on the screen.

Can’t find your cursor? Make sure Opacity isn’t 0%! You can use 
the default shortcut keys 2, and 3 to set the cursor to Outline or 
Tool mode to make it visible in the meantime.

Filters.

Allows you to set additional folders to be scanned for filters. See the Image 
Adjustment and Filters section for more information.

Panels.

Settings that control your panels globally.

Scale, Rotation: Sets the scale or rotation of all panels.

Reset Panel Positions: Resets the position of all panels after restart.

Automatic Updates.

Allows you to turn off the automatic online check for updates ArtRage 
performs weekly.

Keyboard Shortcuts.

Keyboard Shortcuts in ArtRage can be adjusted to suit your requirements. 
The Keyboard Shortcuts Panel can be opened from the Edit menu.

The menu at the top  right presents load and save options for sets of shortcuts 
and the ability to reset them or revert them to the previous set. The list below 
contains groups of similar shortcuts that can be customised, and any key 
combination currently allocated to them. Click the grey title bar of a group  to 
open or close its contents.

Editing Shortcuts.

Shortcut events can have multiple entries. This can be useful if there is more 
than one way you wish to access a shortcut. For example ‘Zoom In’ may 
require Cmd/Ctrl ‘+’ as well as Cmd/Ctrl + Shift + ‘=’ depending on your 
keyboard layout. Existing shortcut key combinations can be modified, and 
new ones added.

1. Add A Key  Combination: Point at the name of the shortcut you wish to 
edit and a ‘+’ button appears. Click it to add a new key combination to that 
event.

2. Remove A Key  Combination: Point at the key combination you wish to 
remove and click the ‘x’ button that appears.

3. Edit  A Key  Combination: Point at the key combination you wish to edit 
and click the ‘...’ button that appears.

On Mac OS X changes you make to the shortcuts will not be available until 
you restart the application.

Entering Key Combinations.

If you Add or Edit a key combination you will be presented with an entry 
dialog. Simply press the key combination you wish to use and it will appear in 
the dialog. Then click OK to apply it.
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If you have chosen a key combination that is already in use you will be 
prompted to either remove the old one and store this new one, or cancel.

Some characters are reserved and cannot be applied to shortcuts: Tab, Enter, 
Space, and Escape, among other keys cannot be used in key combinations.
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Package Files.

Package Files are a convenient way to share custom content with other users 
by gathering items together in to a single file that can then be installed on 
another computer. Each Package File can contain multiple different types of 
custom content including Stencils, Stickers, Presets, and even Scripts. 
Installing a package file places all of its contents in to the correct folder on 
disk and store a receipt which allows you to uninstall the contents later if you 
wish.

Installing and Managing Package Files.

Package files have a filename that ends in ‘.arpack’ and a ‘wrapped present’ 
icon. If you have installed ArtRage already, you can install a Package either 
by double clicking it (this will launch ArtRage and start the installation process) 
or by dragging it on to the ArtRage window. You can also find an option in the 
File Menu to install a Package file.

When you start the installation 
process, the Install Package panel 
appears. This panel lets you know 
about the contents of the package 
and allows you to select which files 
to install.

The space at the top of the panel 
tells you about the content and its 
author. The space below is a list of 
all of the files that are contained in 
the package.

Grey items with an arrow next to 
them represent groups. Each group 
will be installed as a group of 
resources in the appropriate panel. 

For example, a Stickers group  named ‘Art Papers’ will add and ‘Art Papers’ 
group to the Stickers Panel. 

To Select Files To Install: If an item has a tick next to it, it will be installed. If it 
has a cross, it will not be installed. Click the item to change whether it will be 
installed. Clicking on a group’s tick will change all of the contents of the group.

To Open and Close Groups: To open or close groups, click the name of the 
group. The list will update to show or hide its contents.

Click ‘Install’ when you are ready to install and ArtRage will install the files you 
selected from the list.

File Naming.

During installation, ArtRage will list all of the files that are being installed so 
that you can see what is being placed in your resource collection. If a file with 
the same name as the one being installed already exists in the collection, the 
file being installed will be given a new name. The Install Package panel will let 
you know the names of items that have been changed and a full report can be 
saved at the end of installation.

Repairing Packages.

If you try to install a Package that has been installed before, ArtRage will ask 
you if you want to repair the installation. Repairing a Package re-installs the 
files from the Package to make sure that any damaged or lost files work 
correctly.

Tracking Installed Packages.

You can see a list of all the Packages you have installed by selecting Show 
Installed Packages from the File Menu.
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The Installed Packages panel displays a list of all the Packages you have 
installed down the left. Select a package from the list to display information 
about it, and a list of all the files it installed on the right hand side of the panel.

Uninstalling Package Files.

To uninstall a Package, select Show Installed Packages from the File Menu. 
Select the Package you wish to uninstall from the list of installed Packages on 
the left then click the Uninstall button. When you uninstall a Package, all the 
files that it created will be removed from your collection.

Creating Package Files.

To create a new Package, select Create Package from the File Menu. When 
you select this option, the Create Package panel appears. This panel allows 
you to set up  the contents of your Package, including information for the end 
user and the files it contains. Once you have set up  contents the Package can 
be Built to create the final file.

The top  section of the panel allows 
you to set information regarding the 
Package that will be displayed to 
anyone who installs it. Information is 
optional, you do not need to enter 
any information here.

ArtRage will not display empty 
information i tems, so i f your 
Package has no preview, no preview 
area will be displayed when the 
package is installed.

To set a Preview image, either click in the Preview Image section to select an 
image to use, or drag the image from your computer on to that section. The 

image needn’t be 400 x 80 pixels but it will be scaled to that size when it is 
loaded so it may look unusual if it has different dimensions.

Click in the Package Name, Package Author, and Package Description 
sections to set those values. The name of your Package does not need to be 
unique.

Adding Items to Packages.

The contents of Packages are sorted in to named groups. When the Package 
is installed each group  will become a new category in the user’s resource 
collection. Each group can contain only one kind of resource (for example, a 
group can contain Stencils, or Stickers, but not both).

You can create groups of different types of resources that have the same 
name (for example, you could have a group  of Stencils named ‘Art Papers’ 
and a group of Stickers also named ‘Art Papers’).

You will need to add a group before you can add any contents to the Package. 
To do this, click ‘Add Group’ and select the type of resource you want to add 
from the popup list presented.

When you have selected the type of resource you want to add, enter a name 
for the group and it will appear in the list indicating which type of resource you 
have selected and the name you have chosen.

You can rename the group  by clicking the ‘...’ button, add an item by clicking 
the ‘+’ button, or delete the group  by clicking the ‘X’ button. Click the group 
name to expand or collapse it in the list.

If you add a group of Presets you will have to choose which tool 
your Presets are for, but if you add Presets for a different tool to 
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that group, a new group will automatically be added for the 
correct tool.

Adding Files to Groups.

Once you have added at least one group to a Package you can start to add 
files. There are two ways to add a file: Click the + button on the group titlebar 
to add a specific file form a menu, or drag a file from a folder on your 
computer on to the group titlebar to add it.

1. Using the + Button:

When you click the + button on the titlebar of a group a popup  menu appears 
containing all of the items in your current resource collection for the type of 
resource your group represents.

The menu allows you to add an item that you already have in your own 
collection, or select ‘Add From Disk...’ to locate a file on disk for the group.

Types of resource that do not have a collection (Color Samples, for example) 
just present the ‘Add From Disk...’ option.

2. Dragging Files to the Group Titlebar:

If you want to add a file that is not in your current collection, you can drag it 
directly from a folder on your computer. Drag the file on the group  titlebar and 
it will be added to that group  if it is of the correct type. For example, if I drag 
an Image file on to a Stickers group, it will not be added. You can drag more 
than one file at a time.

If you are adding Presets to a group  in this manner, the type of preset you are 
adding is not important, ArtRage will automatically create groups for the 
presets you drag. For example, if I have a group of Oil Brush Presets called 
‘Matt’s Presets’ and I drag a Watercolor Preset on to the group  titlebar, a new 
group  of Watercolor Presets titled ‘Matt’s Presets’ will be created and the file I 
dragged in added to that group.

Building the Package File.

When you have set up  the contents you want to include in the new Package, 
you need to Build it. Building a Package takes all of the files you have 
selected for inclusion and writes them out to a single file for easy installation 
later.

When you are ready to Build the Package File click the ‘Build...’ button at the 
bottom right of the panel. You will be asked to enter a name for the file and the 
file will then be built. When the user installs the Package the name you set in 
the Package Information section will be displayed to the user, so it does not 
matter if the file name has to be abbreviated.

A Package file must be Built before it can be shared. If you make 
any changes to the contents listed in the Package Creator after 
Building, you must click Build again to add those changes to the 
Package file before you share it.

Important: If you leave the Package Creator, its list of contents 
will be cleared. If you want to save your current working contents 
to make changes later, you must save a Template (see below).

Package Creator Templates.

Packages that have been built cannot be loaded in to the Package Creator for 
editing later. The contents of the Package Creator panel are just a list of files 
that will be included in a Package when you build it so if you want to be able 
to edit a Package later, to make changes to its contents or information, you 
need to store a Package Template. Package Templates are files that store the 
layout of your Package Creator, including all the information, groups, and files 
you have added.
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You can save a Package Template using the menu button next to the ‘Add 
Group’ button in the panel. From this menu you can Save and Load Template 
files.

If you close the Package Creator without saving a Template for your current 
layout, you will be prompted to save.
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Script Files.

Script Files are a way to record and play back the process of creating a 
painting so that it can be played back later to reconstruct the painting from a 
clear canvas, stroke by stroke. Script files are easy to share with other users 
and can also record annotations, allowing you to make notes while you paint 
to display during playback for the easy creation of tutorials.

Because Script Files record the process of making each stroke rather than the 
result they can be played back at different resolutions, allowing you to 
recreate paintings at different sizes. Advanced users can also edit script files 
directly via a text editor, changing properties of the painting and the scripting 
language includes the ability to write C style code functions to create special 
effects.

Recording Script Files.

To record a Script, select ‘Record Script...’ from the File Menu. When you 
select this item, the Record Script panel appears.

This panel allows you to select what will be included in the Script file when it is 
recorded.

Including the current painting in your script means that when anyone plays it, 
the contents of your canvas as they are when you select Record will appear 
before the script is played.

Turning the ‘Include Current Painting’ option on will cause the script file to be 
larger, because all painting information (including any layer contents) will be 
added to the script.

If the canvas is blank, or if the person playing the script does not need the 
current contents in order for the script to work, do not turn this option on. For 
example, if you have already painted a face and want to record the process of 
adding an eye as a tutorial, you might include the current painting so that the 
face is visible when the script is played. In general, this option should be 
turned off.

Important: Including the current painting in your script prevents 
the script being played back at larger size later. Do not turn the 
option on unless you specifically want paint that is already on the 
canvas to be included in script playback.

If you do need to include the current painting, consider Merging 
all Layers before you record the Script, this will cut down on the 
size of the eventual Script File.

Advanced Users: You can write script files manually. For 
information on how to do this see the Advanced Scripting section 
later in this manual.

Controlling Recording.

While the Script is recording, the Recorder Panel appears. This panel allows 
you to control the process of recording and add Annotations if you are using 
ArtRage.

The top  line of the Recorder Panel tells you what the 
Recorder is currently doing. If you Pause recording, the top 
line will pulse to let you know that nothing is being recorded.

The buttons on the second line of the panel allow you to 
Pause or Resume recording, or Stop  recording completely. 
When you Stop  recording you will be prompted for 
information before the Script is saved.
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If recording is paused, nothing you do in ArtRage will be 
recorded. This means the Script may not play back correctly if 
you paint while paused.

he buttons below allow you to add Annotations to the Script. Annotations are 
used to provide information to the person who is playing the Script. More 
information is available regarding Annotations later in the manual.

Pausing and Idle Time.

If you stop painting at any point during recording and do nothing  in ArtRage, 
this is recorded as idle time. When a user plays back your Script they will be 
given the option to accelerate playback, which removes all idle time from 
playback, otherwise the script will pause during playback until the idle time 
expires. Users are given the option to skip idle time manually if it occurs 
during playback.

If you are going to be away for an extended period during recording, consider 
pressing Pause on the Recorder Panel. While recording is paused idle time is 
not recorded so there will be no pause in the action during playback.

Saving Your Painting While Recording.

If you save your painting while recording, the script is saved with it. If you then 
quit, recording will start again when you reload the painting later to continue 
working on it. This will continue until you specifically end recording. 

Ending Recording.

When you are read to end recording, click the Stop  button on the Recorder 
Panel. When you click this button, the Save Script Panel appears. This panel 
allows you to enter information for your script and save it, or cancel and 
discard the recoded script.

If you Cancel in this panel, you will be given the opportunity to 
continue recording from where you left off, or to discard the script 
entirely.

The information requested in this panel is optional, you do not need to enter 
any information here. ArtRage will not display empty information items, so if 
your Script has no preview, no preview area will be displayed when it is 
played.

To set a Preview either click in 
the Preview Image section to 
select an image to use, or drag 
the image from your computer 
on to that section. The image 
needn’t be 400 x 80 pixels but it 
will be scaled to that size when it 
is loaded so it may look unusual 
if it has different dimensions.

Click in the Script Name, Script Author, and Script Description sections to set 
those values. The name of your Script does not need to be unique.

When you are done editing information, click OK and you will be asked to 
save the Script to a ‘.arscript’ file. That file is the file that will be played back in 
the future.
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Script Annotations.

Annotations allow you to present additional information to someone during 
Script playback. While the script is being recorded you can add three types of 
Annotation depending on the kind of information you want to present: Notes, 
Tips, and Spotlights.

Notes are messages that appear and interrupt the flow of 
the script. When the Note appears, playback is paused until 
the user clicks Continue. Use Notes when you have 
complex in format ion that requi res reading and 
understanding before the script continues.

Tips look like Notes but the script continues to play while the 
Tip  is visible and the Tip  vanishes when the original Author 
wants it to vanish. Use Tips when you want to illustrate 
something that is currently happening and doesn’t require a 
lot of explanation.

Spotlights appear on the canvas as a dark or light blurred 
patch with a hole in the centre. They are used to highlight 
important areas of painting while you work. Spotlights 
remain on the canvas until the Author dismisses them. There 
can only be one Spotlight at a time.

Spotlights can coexist with Notes and Tips, so you can add 
a Spotlight then add a Note to explain what it is highlighting. 
Use them to focus the user’s attention on an area of the 
canvas during script playback.

Adding Notes and Tips.

To add a Note or a Tip, click the appropriate button on the Recorder Panel. 
When you do this, a Note Editor appears:

Enter your text in the space provided in the bubble then click the tick to add 
the Note or Tip.

The bubble will automatically adjust its height fit its contents as you type.

The green handles on either side of the bubble are used to change its width. 
The bubble will resize its height to fit its contents as you do this.

The target  button indicates where the ‘tail’ of the bubble will sit when the Note 
or Tip  appears. You can move the tail by clicking and dragging on the target. It 
can go anywhere inside the dark border of the Note Editor.

You can click and drag in the dark border to move the Note Editor. When the 
Note or Tip  is displayed, the dark border will not be visible, it is only displayed 
here to contain editing controls.

If you are creating a Note, the ‘Continue’ text will be visible in the bubble. This 
is to show you how the final bubble will look when it is displayed.

Dismissing Tips.

Tips remain on the canvas during recording until you want to dismiss them. 
For example, you could create a Tip  that says ‘Part 1: The Eyes’ and leave it 
on the canvas until you have finished drawing the eyes for a portrait, then 
dismiss the tip  when you go on to the next task. As an author, you add the Tip 
when you want it to appear, then as you are recording you click it to close it.
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When you add a Tip to the canvas while 
recording, it looks like this. Click the tip  when 
you want to remove it. When the script is 
played back, this is the point at which it will 
vanish from the canvas.

When playback ends, any open Tips are automatically closed. You can have 
as many open as you like during playback.

Adding Spotlights.

To add a Spotlight click the Add Spotlight button on the Recorder Panel. When 
you do this, all other panels fade out and the Spotlight Editor appears.

The target button in the centre can be clicked 
and dragged to move the spotlight. This 
represents the centre of your point of interest.

The radius button that sits on the edge of the 
Spotlight can be dragged to change its size.

The Menu Button allows you to select whether 
this is a Dark or Light Spotlight. Use Dark 
Spotlights (the default) on light canvases, and 
use Light Spotlights on Dark canvases.

When you have positioned and sized the Spotlight, click the tick button to 
okay its addition to the Script.

If you move a Spotlight so that the OK and Cancel buttons are off the screen, 
they will shuffle to the other edge to make sure they are visible. If you lose 
them for any reason you can press Enter to okay the Spotlight, or Escape to 
cancel it.

Playing Script Files.

To play a Script select ‘Play Script...’ from the File Menu. When you select this 
option you will be prompted to save your current Painting if there are unsaved 
changes, then asked to select a ‘.arscript’ file to play. Once you have selected 
a file the Play Script Panel appears.

This panel contains any information 
that was saved with the Script file, 
including its title, its author, a 
description and a preview.

It also allows you to make two choices 
about how the Script will be played 
including speed and whether the 
result will be the same size as the 
original painting.

If you choose Accelerate Playback, any idle time that was recoded in to the 
script by the author will be ignored. This speeds up  the process of playback. If 
you do not turn this option on you will be given the option to manually skip  any 
idle time as it occurs during playback.

Accelerating playback also accelerates the paint strokes.

Playing the Script at its original size causes a new canvas to be created at the 
indicated size when you click Play. If you would prefer the Script to play back 
at a different size, turn off the Play at Original Size option and enter the size 
you would like to use using the Screen Size or Print Size controls.

Click Play when you are ready to start the Script playing.
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Selecting Different Sizes.

If you opt to play back the script at a custom size you are provided with full 
control over the sizing of the new file as per the new file dialog. This allows 
you to set the size in pixels or screen units.

Because the Script records the process of painting rather than the resulting 
image, playing Scripts back at different sizes allows you to recreate them as if 
they had originally been painted at that size. The result is a higher quality way 
to scale images.

Normal image scaling takes the resulting picture and stretches it, which 
reduces the quality of the paint strokes. Script scaling using the Play Script 
Panel re-paints the script at a different scale, so each paint stroke has the 
same quality as one painted by hand.

While ArtRage scales the path of the strokes 
and the properties of the brush as best it can, 
you may find that the results of a Script played 
back at larger scale do not look identical to the 
original result. In general however, the result 
should be very similar.

In this example the paint stroke was created at 
200 x 200 pixels in size and recorded in a 
script. The two examples below show the 
difference between scaling the image up  200% 
and playing back the script at 200%. The 
scaled image is fuzzier and lower quality, while 
the Script image is crisp  as if the stroke had 
been originally painted at that size.

Scaled to 200% Script Played at 200%

Controlling Playback.

While a Script is playing the Playback Controls panel appears. This panel 
contains controls that you can use during playback. While a Script is playing 
you cannot interact with any other control in ArtRage.

The top  bar indicates what the Player is currently 
doing. If you have chosen not to accelerate 
playback and the script contains idle time (time 
where the author was not doing anything during 
recording) the top  bar will update to indicate how 
long until the idle time ends, and a ‘Skip’ button 
that allows you to skip past the idle time.

Click the Pause button to pause playback, or continue if it has been paused.

The percentage indicator tells you how far through the Script you are. Note 
that this is not based on time but on the number of events that were recorded.

Click the Stop  button to stop playback. When you do this, the Playback 
Controls Panel vanishes and your canvas is left in the state it was in at that 
point in the script.
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If you play a Script through to the end, the Playback Controls panel will vanish 
of its own accord.

Notes, Tips and Spotlights.

Notes and Tips are messages left by the Script Author to help  explain what is 
happening.

If a bubble appears that has a ‘Continue’ button at the 
bottom, the Script will pause until you click inside the 
bubble. This is a ‘Note’.

If a bubble appears that does not have a ‘Continue’ 
button at the bottom, the Script will continue to play. You 
cannot dismiss these manually, they will vanish when the 
Script Author wants it to. This is a ‘Tip’.

If a dark blurred area with a hole in the middle appears, 
the Script will continue to play underneath it. This is a 
Spotlight and it will vanish when the Script Author wants it 
to.

Spotlights are used to draw your attention to important 
parts of the canvas while the Script is playing.

Advanced Scripting.

ArtRage Scripts are text files that store data in a human readable format. This 
allows you to edit the contents of the Script directly and change its properties, 
or create entirely new scripts from scratch using the ArtRage Scripting 
Language. The Scripting Language allows you to instruct the application to do 
anything that can be done by a user, and also includes mathematical and 

string operators, and the ability to script functions that can be called as the 
Script is played.

The Scripting Language is not covered in this manual, but full details can be 
found in the ArtRage Scripting Guide here: http://www.artrage.com/advanced-
scripting.html

Scripts that are created manually should be saved with the ‘.arscript’ suffix 
and can be loaded in to the application via the standard Play Script option in 
the File Menu.
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Toolbox and Workbench

When you’re working on a project that uses a small set of tools you might not 
want to have the entire interface visible constantly. The ArtRage Toolbox lets 
you gather a set of tools, colors, and utilities that are relevant to the specific 
project you’re working on in to a single panel that can be used in place of the 
main interface. When you’ve gathered your tools together, Workbench Mode 
lets you collapse the entire interface in to a single toolbar and work in a 
focused environment without distraction.

This section explains how to use the Toolbox and Workbench.

The Toolbox.

The Toolbox Panel is a place where you can store 
tools, colors, and utilities that are relevant to a specific 
painting. The contents of the Toolbox are stored with 
the painting itself so that when you reload it, the 
Toolbox is restored.

When you store an object in the Toolbox it appears in 
the Toolbox Panel. Objects are sorted in to groups for 
ease of location. Clicking on an object in the Toolbox 
Panel activates it, the actual effect of which varies 
depending on the object type (see below for details).

When objects are added to the Toolbox they are 
automatically pinned to the Workbench Pinboard. The pin 
icon next to the object in the Toolbox Panel can be clicked to 
unpin or re-pin them.

Alt (Windows) / Option (OS X) Click an item in the Toolbox to 
remove it quickly.

The following objects can be added to the Toolbox. Each object is listed with 
information on how you add it, and what happens when you click it in the 
Toolbox:

Color Samples.

Color Samples stored in the Toolbox are stored for the current painting only. 
They also appear in the Samples Panel.

Adding Color Samples: You can add Color Samples to the Toolbox either by 
choosing the Add options from the Toolbox Samples menu item found in the 
Color Samples menu, or by using the Add Sample button at the top  of the 
Toolbox. once you have at least one Color Sample in the Toolbox there will be 
an add button in the list of available samples.

Clicking Color Samples: When you click a Color Sample in the toolbox, that 
sample is made the current color.

Layers.

Any Layer in your painting can be added to the Toolbox. This can be useful if 
you’re working on a specific subset of layers in a larger document and want 
quick access to them.

Adding Layers: Right click the Layer you want to add in the Layers Panel 
and choose the Add to Toolbox option. You will be prompted to enter a name 
for the item. This does not change the name of the Layer, it just labels the 
item in the Toolbox.

Clicking Layers: When you click a Layer in the Toolbox that Layer becomes 
the active Layer. If you right click a Layer in the Toolbox its options menu 
appears.

Tracing Images.

A Tracing Image that has been loaded can be added to the Toolbox. When 
stored, it retains all of its settings including scale and opacity.
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Adding Tracing Images: When you have a Tracing Image loaded, use the 
Add To Toolbox option in the Tracing Menu to store it in the Toolbox. You will 
be prompted to enter a name to label the item in the Toolbox panel.

Clicking Tracing Images: When you click a Tracing Image in the Toolbox the 
image is loaded and its settings are restored. It is important to note that 
Tracing Images stored in this manner don’t store the actual image, they store 
a reference to the file on disk that was used to create the image. If that file 
does not exist, the item cannot load.

References.

Any Reference Image, Scrap, or View that is currently in the painting can be 
stored in the Toolbox.

Adding References: Right click on the Reference or select its menu in the 
References Panel and choose the Add To Toolbox option. You will be 
prompted to enter a name to label the item in the Toolbox panel.

Clicking References: When you click a Reference in the Toolbox its visible 
state is toggled. This allows you to quickly show and hide References you are 
using. If you right click the Reference in the Toolbox, its options menu 
appears.

Stencils.

Any Stencil that is active in the painting can be stored in the Toolbox. Stencils 
that have not yet been added to the painting cannot be added.

Adding Stencils: Right click on the Stencil on the canvas, or use the menu 
for the Stencil in the Active category of the Stencils Panel and select the Add 
To Toolbox option. You will be prompted to enter a name to label the item in 
the Toolbox panel.

Clicking Stencils: When you click a Stencil in the Toolbox its visible state on 
the canvas is toggled. If you right click a stencil in the Toolbox its options 
menu appears.

Custom Color Pickers.

Any Custom Color Picker in your Collection can be added to the Toolbox.

Adding Custom Pickers: Right click the Picker in the Custom Pickers Panel 
and choose the Add To Toolbox option. You will be prompted to enter a name 
to label the item in the Toolbox panel.

Clicking Custom Pickers: Click a Custom Picker in the toolbox to activate it 
in the Color Picker.

Manual Sorting.

You can rearrange items in the Toolbox manually. Click and drag an item in 
the list to change its position. Note that you can only rearrange items inside 
their specific category. For example, a Reference can only be rearranged 
inside the References section of the Toolbox, you can’t drag a Reference in to 
the Stencils section.

Saving Toolboxes.

The contents of the Toolbox are automatically saved with your painting and 
restored when you load it. There may be cases where you want to save a 
Toolbox to disk for use later however, and you can do this using the menu 
button in the Toolbox Panel.

Because some of the items that are stored in the Toolbox are only relevant to 
a specific painting file however, not all items will be saved. Any item in the 
Toolbox that represents an active item in your painting will not be saved when 
you export the Toolbox to its own file. This includes:

1. Layers.

2. Stencils.

3. Reference Images, Scraps, Views.
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Items that represent either a file on disk or an object that does not rely on a 
specific painting will be saved when you save the Toolbox file.

The Workbench.

The Workbench is a compressed interface mode that clears away all of the 
panels on the screen and replaces them with a single toolbar that sits on the 
edge of the ArtRage window. Workbench Mode is designed to give you a 
focused environment for working, and contains quick access to important app 
functionality as well as a Pinboard for storing custom objects that are relevant 
to your current work.

Activating Workbench Mode.

Workbench Mode can be activated by selecting the Workbench option in the 
View Menu, by right clicking the canvas and selecting Workbench Mode, or by 
pressing Enter (the default shortcut key).

When Workbench Mode is activated any interface controls that are on or 
overlapping the canvas vanish. This means that panels you have moved 
outside the main ArtRage window will remain visible. For example, if you have 
dragged panels to a second monitor they will not vanish when entering 
Workbench mode.

When you leave Workbench mode, any panels that were hidden will be 
restored.

The Workbench Toolbar appears when you enter Workbench Mode.

Workbench Toolbar Layout.

The Workbench Toolbar is laid out in to individual segments that contain 
controls of a specific type. Layout can be either horizontal or vertical 
depending on its docked location.

You can change the edge of the window the Workbench Toolbar 
is docked to using the Menu button on the Toolbar itself.

The X Button: Ends Workbench Mode and restores 
normal panels.

The Menu Button: Click for access to all of the ArtRage 
Menus and Workbench docking options.

Tool Selector: Indicates which tool is active. Click to 
select another from a menu.

Tool Size: Indicates the size of the current tool. Click to 
enter tool size manually, or click and drag to change tool 
size smoothly. Drag left and right if the Workbench 
Toolbar is docked at the top or bottom, or drag up  and 
down if it is docked on the left or right.

Current Color: Indicates the current paint color. Click for 
a Color Picker to select color manually. Click and hold to 
get a Popup Color Picker.

Layer Preview: The preview of the current layer you are 
painting to. This item updates as you paint. Click for a 
Layer Panel, or right click for the options menu for the 
current Layer.
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Presets Pod: Click to open a Presets Popup Panel.

Settings Pod: Click to open a Tool Settings Popup 
Panel.

Samples Pod: Click to open a Color Samples Popup 
Panel.

Toolbox Pod: Click to open a Toolbox Popup Panel.

Tracing Pod: Click to open a Tracing Popup Panel. If no 
Tracing Image is loaded, clicking this pod prompts you to 
load one.

References Pod: Click to open a References Popup 
Panel.

Stickers Pod: Click to open a Stickers Popup Panel.

Stencils Pod: Click to open a Stencils Popup Panel.

Canvas Zoom: Click to set the canvas zoom level 
manually, or click and drag to change it smoothly. Drag 
left and right if the Workbench Toolbar is docked at the 
top or bottom, or drag up and down if it is docked on the 
left or right.

Shift click this button to zoom in a step. Alt (Windows) / 
Option (Mac OS X) click it to zoom out.

Canvas Positioner: Click to open a Canvas Positioner 
Popup Panel.

The Pinboard: The rest of the space in the Workbench is 
the Pinboard, which contains any custom items you have 
pinned to it. For more information, see below.

Workbench Popup Panels.

Many of the buttons in the Workbench Toolbar open a Popup Panel. Popup 
Panels are exactly the same as the normal panels they represent, but their 
position is docked to the Toolbar and they vanish when you click outside 
them. You can also press Enter or Escape to close a Workbench Popup 
Panel.

If you trigger a Popup  Panel for a panel that is already visible on the screen, 
the original panel vanishes. It will reappear when you leave Workbench Mode. 
If you want to display a full, non vanishing panel when in Workbench Mode, 
hold down Shift and click on the appropriate Pod in the Toolbar.

Showing and Hiding the Toolbar.

At the Right or Bottom edge of the Toolbar is an arrow pointing to 
the edge of the window. Click that to retract the Toolbar off the 
screen.

When the Toolbar is retracted a small arrow button appears in the 
corner of the window. Click this to bring the Toolbar back.

Pressing Tab will Show or Hide the Toolbar.
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The Pinboard.

Any space in the Workbench Toolbar that is not taken up  with its normal 
buttons is available for custom items. This is called the Pinboard. When you 
add an item to the Toolbox it is automatically pinned to the Pinboard so that it 
is available for use when in Workbench Mode.

The icon that appears to the left of items in the Toolbox Panel 
indicates whether the item is pinned to the Pinboard. Click it 
to toggle the value.

When there are more items than can fit on the Pinboard, a set of scroll arrows 
appears allowing you to scroll through rows of items.

Some items have identifier icons indicating the type of object they represent. 
This is common for items that may appear either blank or similar in nature.

You can unpin an item from the Pinboard by Alt (Windows) / 
Option (OS X) clicking it there.

Because some projects use a wide range of tools that may all be stored in the 
Toolbox, you can unpin objects from the Pinboard if you would like to create a 
smaller, focused set for use during painting.

For example, if you are working on a portrait and want to focus on a single 
aspect such as the eyes, you might want to pin only those tool presets, layers 
and color samples relevant to the eyes to your Pinboard, even though the 
Toolbox might contain tools for all aspects of the portrait.

Pinboard Color Samples.

Pinboard Color Samples exist in their own area of the Pinboard that can be 
sized manually. This allows you to keep  as many Samples as you like on the 
Pinboard without reducing the space available for other items. If you have 
more Samples than can be shown in the Workbench toolbar, the Samples 

area of the Pinboard can be scrolled independently of the rest of the 
Pinboard.

To change the amount of space available for Samples on the 
Pinboard, click and drag the Resize handle that sits to the side of 
the Samples section. Increasing the space available for Samples 
decreases the space available for other items on the Pinboard.

Manual Sorting.

You can rearrange items on the Pinboard manually. Click and drag an item in 
the list to change its position.
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Stylus Controls.

ArtRage includes support for two sets of advanced features available with 
some graphics tablets and stylus based screen input devices:

1. Stylus Properties: Stylus properties such as Pressure, Tilt, and Barrel 
Rotation.

2. Stylus Recognition: The ability to recognize individual styluses as they 
are brought close to the tablet.

These two sets of features are supported via the Stylus Properties and Stylus 
Control Center.

Important: These features require that your graphics tablet or 
stylus input device support them. If these features do not work for 
you, check the specifications of your input device.

In addition, some features such as barrel rotation or airbrush 
wheel support require special stylus types.

Stylus Properties.

ArtRage includes support for the following stylus properties:

Pressure:

This tracks how hard you press on the surface while 
using the stylus.

The Pressure slider in the Tool Settings Panel is used to 
offset the incoming pressure value, increase it to make 
changes in pressure have a larger effect on the canvas, 
decrease it to reduce the pressure.

Tilt:

This tracks the angle of the stylus relative to the flat 
surface of the tablet.

Some tools such as the Airbrush change the shape of 
their spray automatically when the stylus is tilted.

Tilt Angle:

This tracks the rotational angle of the stylus around the 
surface of the tablet.

The view on the left is from above as you look down on 
the tablet, the pen is like the hands on a clock face, its 
rotational position is the Tilt Angle.

Airbrush Wheel:

Some styluses, usually of the airbrush stylus type, have 
an additional wheel control.

The wheel sets the absolute value of the property it is 
attached to, it’s like a slider in the Tool Settings Panel 
when you use it.

Twist:

This tracks the barrel rotation of the body of the stylus 
around its vertical axis.

Most styluses do not support this property. If your stylus 
does not, the direction of the stroke tends to define the 
Twist value of the brush head as you paint.

ArtRage allows you to assign the Pressure, Airbrush Wheel, and Twist 
properties of a stylus to individual settings in each tool.
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This is done via the Stylus Properties Panel, 
which can be opened using the  Set Stylus 
Properties menu option which can be found by 
clicking the Preset Block at the top  of the Tool 
Settings Panel.

The Stylus Properties Panel contains a list of all of the stylus properties 
supported by the tool. For example, the Oil Brush supports Pen Pressure, 
Airbrush Wheel, and Pen Twist.

Beside each property is a list of Tool Settings that will be affected by that 
property. For example, in this image the Oil Brush Size is being affected by 
Pen Pressure. As you press harder, the brush size will increase.

Some Tool Settings support an ‘invert’ value represented by a check box next 
to their entry in the property list. Turning this check box on causes the 
relationship of the property and value to be inverted.

For example, if I turn on Invert for the Pen Pressure’s Size property in the Oil 
Brush, pressing harder with the stylus will cause the brush to become smaller.

Each setting is listed with an X button that allows you to delete it. If you delete 
a setting, the Property it was assigned to will no longer affect that setting.

If a property has the potential to affect more settings, there will be an ‘Add 
Setting’ entry listed next to it. Click that entry to get a list of all the settings that 
property can modify.

Not all settings can be modified by stylus properties. Some settings are locked 
to specific properties or unavailable for modification due to their nature. In 
general, properties that would be associated with the brush are modifiable, 
while properties that define the base nature of the paint are not. This is due to 
the painting simulation running in the background, which tracks properties of 
your media in a natural manner.

For example, the Loading of a brush head defines how much paint is on the 
brush at the start of a stroke, so it is not possible to modify that value after the 
stroke has begun.

Stylus Recognition.

Some graphics tablets and other stylus based input devices support the ability 
to recognize unique styluses. ArtRage allows you to take advantage of this 
feature in the Stylus Control Center, which lets you assign specific tool 
settings to specific styluses.

The Stylus Recognition system does not just recognize different types of 
stylus (eg. Normal, Airbrush etc.), it recognizes different styluses of the same 
type. This means that if you have multiple styluses you can assign specific 
tools to each and switch styluses to change tool settings.

To open the Stylus Control Center, select the Stylus Control Center option 
using the menu accessed by clicking the Preset Block at the top  of the Tool 
Settings panel.

Stylus recognition works by monitoring the stylus that is currently in use. 
When you bring a new stylus close to the tablet, the settings that were 
assigned to that stylus are applied (including tool type, color, size, and any 
additional settings).
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Stylus Control Center.

The Stylus Control Center allows 
you to assign properties to each 
unique stylus ArtRage has detected 
in use.

At the top  of the panel is a checkbox that allows you to turn off stylus tracking. 
If this option is turned off, ArtRage will not store or assign settings to the 
styluses you use.

The menu button at the top  of the panel allows you to save out sets of settings 
that you have assigned, or load them back in again later.

The main bulk of the panel is taken up  with a list of styluses and their 
assigned properties. Every unique stylus that has been brought close to the 
tablet while ArtRage is running is listed here.

The left hand side of the list indicates the type of stylus that 
has been detected, and any name you have given it.

Types of stylus recognized include a generic ‘Stylus’, a Wacom Airbrush 
Stylus (which supports Airbrush Wheel properties), and a Wacom 6D Art Pen 
Stylus (which supports Pen Twist properties). Click the name area to assign a 
name.

On the right hand side of the list you can see the 
Tool that has been allocated to the stylus and 
the name of the Preset if a preset was selected. 
The tool icon is displayed, or the preset icon if 
there is one.

If no settings have been assigned to the stylus, this is indicated here in the 
list.

On the right hand edge of the list are a Lock and Menu icon for each 
stylus.

The Menu item is used to assign the settings of the current tool to the stylus, 
or clear out settings. The menu also allows you to remove from the list any 
stylus that is not currently being used.

The lock icon is used to lock the currently assigned settings (or lack thereof) 
to the current stylus so that they do not change. 

The last stylus to have been detected is lit up in the list.

Working With Stylus Recognition.

Stylus recognition and how settings are allocated can be confusing at first. 
The basic model is this:

1. When a stylus is brought close to the tablet for the first time, it appears in 
the list with no settings assigned.

2. When a different stylus is brought close to the tablet, the tool settings at 
the time are assigned to the last stylus, then the new stylus becomes 
active.

3. If you then bring the first stylus back to the tablet, its tool and settings are 
applied in the interface.
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So you can see that this process is driven by stylus changes. Until a different 
stylus is brought close to the canvas, no changes will be applied to the 
settings allocated to the current stylus.

If you only use one stylus, you won’t notice any difference in behavior, your 
settings will never be allocated to the current stylus.

If you don’t specifically lock a stylus in the list, you will notice that every time 
you bring a stylus close to the tablet the tool settings that were applied when it 
was last used are restored.

This means that you can use different styluses to represent different tasks in a 
painting, using each one as if it was a specific real world tool.

Locking Stylus Settings.

Locking stylus settings makes a small change to the workflow. When you turn 
on the lock for a stylus, the settings (or lack thereof) that are currently 
assigned to it will be locked on and will never change.

If no lock is applied, changes you make to settings while using a stylus will be 
stored when you switch styluses. For example:

1. I use Stylus A and select Oil Paint.

2. I bring Stylus B  to the tablet - Stylus A now has oil paint allocated. I switch 
to Watercolor.

3. I bring Stylus A back to the tablet and Oil Paint is selected. I now switch to 
Palette Knife.

4. I bring Stylus B  back to the tablet - Stylus A now has Palette Knife 
allocated.

So we can see here that changes I make while using Stylus A will be kept 
when I return to Stylus A. If I want to make sure that Stylus A is always Oil 
Paint when I bring it to the tablet, regardless of what I change after I bring it to 
the tablet, I would turn on the lock for Stylus A after Oil Paint has been 
allocated to it in step 2.

Manually Allocating Stylus Settings.

If you prefer, you can manually control the settings that are allocated to each 
stylus and avoid changes being made. To do this:

1. Bring a stylus close to the tablet.

2. Click its lock icon in the Stylus Control Center list.

3. Set the tool settings up as you want them.

4. Use the Menu Button for the stylus in the Control Center list and select 
Assign Current Settings.

The current settings are assigned to the stylus and because the lock is turned 
on, they will never be automatically changed.
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Paint Symmetry.

The Paint Symmetry system automatically creates mirrored strokes on the 
canvas as you paint, and allows control over properties such as how many 
mirrors are created and the center point of symmetry.

Paint Symmetry can be activated and controlled from the Paint Symmetry 
menu in the Tools Menu.

When Symmetry is turned on any stroke you make on the canvas will be 
mirrored in other positions based on the settings you have selected. There are 
two important settings that define how this works:

1. Number of Segments: This value defines how many different symmetry 
segments there are. Your stroke is repeated in every segment on the 
canvas.

2. Type of Symmetry: This value defines whether the repeated strokes are 
directly mirrored, or rotated around the center point.

How these two settings define the look of the mirrored paint is explained 
below:

The dotted lines on the canvas indicate the lines of 
symmetry between Segments. These are the ‘mirrors’ 
that reflect your paint.

As you paint in a segment outlined by a dotted line, 
your paint stroke is repeated in the other segments. 
Exactly how the strokes are repeated is defined by 
the Type of Symmetry (see below).

You can set the number of segments by selecting the Set Number of 
Segments option in the Symmetry Menu.

If you are using Mirrored Symmetry (see below) the number of 
segments must be an even number.

The Type of Symmetry you have selected defines how the paint in each 
segment behaves. There are two types:

Mirrored Symmetry: This type of Symmetry treats 
the lines between the segments as mirrors that reflect 
the painted content.

In this example, as the arrow in the top left was 
painted towards the right, the right segment produced 
an arrow that painted itself towards the left.

Rotational Symmetry: This type of Symmetry treats 
the lines between the segments as slices of a 
clockface and anything you paint in a slice will be 
repeated exactly in the next slice, rotated to angle 
around the center of symmetry.

In this example, as the arrow in the top left was 
painted towards the right, the right segment produced 
an arrow that also painted towards the right hand 
edge of its segment.

The Type of Symmetry can be set using the options in the Symmetry Menu.

Manipulating Symmetry.

When you turn Paint Symmetry on the Symmetry Puck appears in the middle 
of the canvas. This puck sits at the central point of the symmetry system (the 
point around which Rotational Symmetry will rotate).
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This icon represents Mirrored Symmetry.

This icon represents Rotational Symmetry.

You can click the central button of the Symmetry Puck to open the Symmetry 
Menu. You can also manipulate the puck itself to edit symmetry properties:

1. Click and Drag the Puck to move the center of symmetry. Hold down Shift 
to constrain movement to a single axis.

2. Hold down Ctrl (Windows) / Cmd (OS X) and Click and Drag the puck to 
rotate the axes of symmetry. Hold down Shift as well to constrain rotation 
to 15 degree increments.

3. Hold down Alt (Windows) / Option (OS X) and Click and Drag the puck to 
change the number of axes. Note that if you are in Mirrored Symmetry 
mode the number of Axes will always be even.

There are two options in the Symmetry Menu that control how you can 
manipulate the axes of symmetry:

1. Show Symmetry  Control: This option sets whether the Symmetry Puck 
is visible. If it is not, you can show it again using the Symmetry Menu in 
the Tools Menu.

2. Allow Axis Drag: If this option is turned on you will be able to rotate the 
axes of symmetry by clicking and dragging on the dotted lines on the 
canvas. This is turned off by default to prevent accidental editing of the 
axes.

Painting with Symmetry.

When Symmetry is on you are not limited to painting in a single segment or 
‘within the lines’. The lines act as mirrors, but your paint strokes can pass over 
them as much as you like. This means that the stroke you are painting can 
interact with other strokes that are being automatically created.

Most tools interact seamlessly with this system, acting as if you were 
manually painting multiple strokes at the same time. Some tools do not 
interact with Symmetry, or display other special behaviours:

1. Sticker Spray: If the Sticker Spray is set to spray with random variation 
the shape of your stroke will remain the same in each segment but any 
random property applied will be randomized for each segment 
independently unless Variation Symmetry is turned on in the Sticker 
Spray.

2. Selection Tool: The only type of Selection that is mirrored while you 
create it is the Painted type. Selections override the symmetry system and 
if you have a selected area only paint that is created by symmetry inside 
that area will be applied.

3. Transform Tool: The Transform Tool ignores Symmetry.

4. Sampler Tool: The Sampler Tool ignores Symmetry.

5. Fill Tool: The Fill Tool ignores Symmetry.

6. Text Tool: The Text Tool ignores Symmetry.

7. Stencils and Rulers: Stencils and Rulers are ignored by the Symmetry 
system.

Paint Symmetry

130



Gradients.

Any system in ArtRage that makes use of Gradients allows you to either 
select an existing one from the Gradient Collection, or create a new one using 
the Gradient Editor.

What are Gradients.

Gradients are automatically generated color progressions that blend between 
individual color points over a distance. For example, a Black to White gradient 
starts of black and over the length defined for its creation becomes white in a 
smooth blend.

Gradients in ArtRage can contain as many colors as you like, and can also 
blend between opacity values independent of those colors. You could for 
example have a gradient that is pure red along its length but blends from 
opaque to transparent.

The Gradient Editor.

The Gradient Editor Panel is accessed by clicking on a Gradient Control. 
When you click the control, the Gradient Editor appears with the current 
gradient displayed at large size.

At the top  of the panel are controls for 
selecting the Main and Secondary 
c o l o r s ( s e e l a t e r f o r m o r e 
information), and a menu that allows 
you to load and save gradients.

Beneath that is the gradient itself then 
controls for the selected point.

Above the gradient you will see circular points indicating 
the Color that has been assigned to that postion.

The currently selected point for editing is connected to the 
gradient.

Below, you will see circular points indicating the Alpha value 
(opacity) that has been assigned to that position.

Between each point is a smaller circle that indicates the Center Point of the 
blend between the surrounding points. 

When you click on any of the dots, the controls at the bottom of the panel 
update to provide options for that type of dot (see below for details).

You can click and drag on any dot to move it around.

Adding Gradient Points.

You can add a new gradient point just by clicking in the area above (for color) 
or below (for opacity) the gradient preview.

When you add a Color Point it takes on the color of the gradient at the point it 
appears, so the gradient’s appearance does not change. When you add an 
Alpha point, it takes on the opacity of the gradient at the point it appears.

Editing Gradient Points.

There are three types of point that can be edited in the Gradient Editor:
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1. Color: A point that sets the color of the gradient.

2. Alpha: A point that defines the transparency of the gradient.

3. Center Point: A point that defines the center point of a blend between two 
other points.

Clicking one of these points in the Gradient Editor brings up  a set of controls 
specific to that type of point.

As you move points around, their properties move with them and the gradient 
updates dynamically. Dragging a color point for example will move that color 
along the length of the gradient. The color of the gradient is calculated by 
blending between each point and its surrounding points.

Pressing Tab  cycles to the next gradient point in the area you currently have 
selected. Pressing Shift Tab cycles to the previous point.

If you drag a point very close to another point, the gradient 
between those points must occur over a very short distance so 
you get a sharp transition.

Gradient Color Points.

The following controls are available for Gradient Color Points:

1. Delete: Deletes the point. There must be at least two points in the 
gradient.

2. Position: The position of the point along the entire length of the gradient. 
0% puts the point at the far left, 100% at the far right.

3. Color: There are three options for Color, accessible via the menu button 
next to the Color Sample. Click the menu button to choose Main, 
Secondary, or Custom color, or click the Color Sample for a color picker 
that allows you to set custom color directly. Click and hold the sample for 
a Popup Color Picker.

The three color types work as follows:

1. Main: The current Paint Color is the Main Color. If a Gradient Point is set 
to use the Main Color, the paint color at the time the gradient is created 
will be used for that point.

2. Secondary: A secondary fixed color that is set inside the gradient editor 
directly. Because ArtRage supports imported gradients from Photoshop, 
the Secondary Color is required to represent the Background Color in 
those gradients. When the gradient is generated, the Secondary Color at 
the time is used for this point.

3. Custom: If you set a point to use a Custom Color, the color you set for 
that point will be used when the gradient is created, regardless of the 
current paint color.

Combinations of these three color types can create different effects. For 
example:

1. To create a gradient that goes from Current Paint Color to black, set the 
first point to Main, and the second to Custom (black). Every time the 
gradient is applied, the first color will be the current paint color.

2. To create a gradient that goes from black to white, set the first point to 
Custom (black) and the second to Custom (white). Because both points 
use a fixed, Custom Color, the gradient will always be black to white.

Because Main and Secondary color points can change, the 
preview of your gradient may look different as you change paint 
color.

Gradient Alpha Points.

The following controls are available for Gradient Opacity Points:

1. Delete: Deletes the point. There must be at least two points in the 
gradient.

2. Position: The position of the point along the entire length of the gradient. 
0% puts the point at the far left, 100% at the far right.
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3. Opacity: The opacity value of the gradient at that point, from 0% to 100%.

Center Points:

Center Points are automatically generated between each Color Point and 
each Alpha Point. They represent the half way point of the blend between the 
surrounding points. By default, Center Points appear half way between the 
points, so the blend is evenly distributed.

When you click a Center Point you are presented with a Position slider that 
can be used to set the position of the point between the surrounding points.

By moving the half way point of the blend in position you can change the bias 
of the progression between the surrounding values.

For example if I have a Blue point and a Red point and I 
move the Center Point towards Red more Blue will be 
visible: The half way color between Red and Blue occurs 
closer to Red so there is less ‘red space’ in the blend.

Center Points cannot be deleted.

Adding a Gradient to the Collection.

When you have finished editing your Gradient you can choose the Add To 
Collection menu item in the Gradient Editor. You will be asked to select a 
group  and name for the new gradient then the file will be created and the 
collection updated.

Importing Gradients.

ArtRage allows you to import Photoshop  Gradients either to disk or to your 
collection.

To import a gradient in the Gradient Editor select the Load From Disk option in 
its menu. This allows you to select either Photoshop  Gradient Files (.grd) or 
ArtRage Gradient Files (.argrad). To import to the collection, open the 
Gradient Collection Panel and choose the import option.

Photoshop Gradient Files can contain more than one Gradient. When you 
choose a grd file to import from, a panel appears listing all of the available 
gradients in that file. When importing to the collection you can hold down Shift 
and click on multiple files to select them for import. When loading a gradient in 
the Gradient Editor you can only select one.
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Grids

ArtRage allows you to display a set of Grid Overlay lines on the Canvas and 
Reference Images, with a variety of sizing and positioning options.

Canvas Grid Overlay.

The Grid Overlay can be activated and configured from the Grid 
Panel which is accessed either from the Grids menu in the Tools 
menu or from the Grids button on the toolbar.

The Grid Panel allows you to show or hide the Grid 
Overlay and configure its properties including the 
appearance and layout of the overlay.

Some of the controls on this panel are only available 
when Show Grid is turned on, unavailable controls will 
be greyed out.

Snap  To Grid and grid layout settings work regardless 
of whether the grid is visible or not.

The Grid Panel contains the following controls:

1. Show Grid: Turns the visible Grid Overlay in the canvas On or Off. When 
the Grid is not showing, Color and Opacity options are not available.

2. Snap To Grid: Sets whether operations on the Canvas snap  to the 
current grid lines. Snap  To Grid affects the placement of paint strokes, the 
creation of Selection Sets, Stencil movement, and other operations that 
happen inside the Canvas area.

3. Color: Sets the color of the Grid Overlay. Click for a Color Picker to select 
color manually. Click and hold to get a Popup Color Picker.

4. Opacity: Sets the opacity of the Grid Overlay.

5. Spacing: Allows you to select how the Grid Overlay is spaced on the 
canvas, either by Pixel distance between grid lines or by selecting the 
number of Grid Squares horizontally or vertically. The slider below 
changes to allow the value to be set once you have selected either 
method.

6. Center Grid: The Grid Overlay is laid out either by calculating the first line 
from the top  left of the canvas if this option is off, or by calculating how 
many lines there need to be and then centering those on the canvas if this 
option is on.

Reference Image Grid Overlay.

Reference Images also support the Grid Overlay. References can be set to 
mirror the current Canvas Grid Overlay by turning on the Show Grid option in 
the menu for each Reference.

Reference Menus can be accessed using the Type Icon for the Reference 
either in the References Panel or on the Reference Image itself.

The Reference Image Grid Overlay adjusts to reflect changes made to the 
Canvas Grid Overlay so you can use the Grid as a structural guide when 
recreating references on your canvas.

Working With Grids.

Grids can be used either as a visual guide or to create snap  points for some 
operations on the canvas.

When working with Reference Images Grids can be used as an aid to 
recreating the proportions of the source Reference on the canvas by turning 
on the Reference Grid Overlay and using it as a visual indicator of the 
distance between points in the Reference.
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When working on the Canvas, Snap To Grid can be turned on to create 
defined start points for paint strokes, and create accurate positioning points 
for selection sets and other items.

Note that the natural paint strokes generated by ArtRage are not always 
suited to harsh grid angles so the paint stroke may not follow the grid corners 
exactly as you paint a stroke.

Items on the Canvas such as Text, Selections, Stickers, and Stencils do 
conform to Grid corners when Snap  To Grid is on so the Grid lines can be 
used for precise placement in these cases.

Snap  To Grid can be on even if the Grid Overlay is not visible. If 
your paint strokes look like they are sticking to invisible lines, 
make sure that Snap To Grid is turned off!
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Credits.

ArtRage and the ArtRage Brush Man Logo are registered trademarks of 
Ambient Design Ltd. in the USA and New Zealand.

This manual is ©2014 Ambient Design Ltd.

Dramatis Personae: Andy Bearsley (Backbone Engineering, OS Support & 
Toolkits), Matt Fox-Wilson (UI and Application Design and Engineering, 
Manuals), David Jenner (Quality Assurance and Beta Management). Uwe 
Maurer (Business Development). Athena Kekenes (Tool and Panel 
iconography and visuals). Miriam Schneider, Jim Williams & Pavel Puchenkov 
(Additional Engineering). Hannah Starret Wright (Community Management & 
Support). Michael Blyth (ArtRage Website Engineering). Tycho (A Cat).

Additional network code by Mike van Bokhoven.

ArtRage makes use of the Freetype Text Rendering System. More information 
can be found at www.freetype.org.

Product names used in this documentation are used for purposes of clarity 
only. All registered trademarks are the property of their respective owners.

Additional Resources:

Byron Callas: Stickers (Art Clippings - Fluffy, Plastic Dots, Textured Dots, 
Tube Dots. Character Sets - 36 Numbers. Stamps - Jellyfish). Presets (Sticker 
Spray - Broad Fluffer, Fluff Explosion, Fluffer Brush, Jellyfish, Jellyfish 
Random). Gloop Tool Sample Painting.

Hans Deconinck: Stickers (Brush Heads - Multibrush, Soft Bristles). Presets 
(Sticker Spray - Speckled Multibrush).

Stefano Fiore: Canvases (Art Papers - Diagonal Grain, Sandy Paper, Swirly. 
Canvas - Smooth Canvas. Rough - Concrete, Stucco). Grains (Canvases - 
Coarse Canvas, Special - Stone 1, Stone 2, Stone 3, Techno 1, Techno 2). 
Stickers (Brush Heads - Art Brush 1 - 15, Ribbon 3D, Stamps - Angled Hair). 
Presets (Palette Knife -  Blurred Frosting, Frosted Spots, Harsh Chaos, Heavy 
Blurred Frosting, Small Frost. Sticker Spray - Cloud Brush 2, Cloud Brush 
Soft, Dirty, Dirty Soft, Eclectic, Eclectic 2, Impressionist, Japanese Ink, 
Mimosa, Modern, Smudge, Stains 2, Stains, Van Gogh 2, Ironic, Ribbon 3D, 
Dense Fur, Frizzy Hair). Pencil Tool Sample Painting.

Justine Hawryluk: Colors (Oil Spectrum). Stickers (Glossy - Black Gloss, 
Citrus Gloss, Cyan Gloss, Emerald Gloss, Navy Gloss, Orange Gloss, Pink 
Gloss, Purple Gloss, Red Gloss, Yellow Gloss, Multicolor Gloss).

Colin Henry: Stencils (Grids - Borders, Circle Bands, Diagonal, Dot, Square).

Gaeton Laprade: Stickers (Art Clippings - Paint Splats. Brush Heads - 
Airbrush Spat 3D, Airbrush Spat, Sea Foam, Shrub  Brush 3D, Shrub  Brush. 
Hair & Fur - Hair Brush 2. Stamps - Barbwire, Bubble, Chain, Curled Leaves, 
Grass Brush, Holiday Lights, Marching Ants, Particles, Paw Prints, Sparkles, 
Wheat. Stickers -  Gold Coins, Ladybug, Popcorn Strands, Shiny Star, Xmas 
Bulbs, Xmas Gifts, ZapPowBlam). Presets (Sticker Spray - Airbrush Spats, 
Airbrush Spats 3D, Gift Boxes, Gold Coins, Lady Bug, Paint Splats, Paw 
Prints, Popcorn Strand, Star Glitter, Xmas Bulbs, Xmas Gifts, ZapPowBlam, 
Barb  Wire, Bubbles, Chain, Holiday Lights, Marching Ants, Particles, Particles 
2, Particles 3, Sparkles, Hair Brush 2, Grass 4, Leaves, Sea Foam, Shrub 
Brush, Shrub Brush 3D, Tree Shrub, Wheat).

Paul Lee - Paint Roller Sample Painting.

David Manuel: Canvases (Canvas - Essential Canvas. Paper - Hatched 
Paper, Sketch Paper, Watercolor Paper). Grains (Canvases - Canvas Grain, 
Hatched Canvas. Papers - Sketch Paper, Watercolor Paper). Stickers (Brush 
Heads - Clutter Brush, Crackle & Swirl, Fluff Brush, Fluff Brush Shaded, Soft 
Puff, Sparse Bristles, Very Sparse Bristles. Hair & Fur - Fur Curly Seq, Fur 
Curly, Fur Layering, Fur Loose Whispy, Fur Soft Gathered, Fur Soft Wave, Fur 
Wooly Blur, Hair Brush, Hair Frosted Tips, Hairs. Stamps - Dune Grass, Fir 
Branch, Mossy, Mossy 2. Stickers - Flower Children, Flower Children Red 
Base). Presets (Sticker Spray -  Rooster Tail, Sparse Bristles, Texturing Brush, 
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Very Sparse Bristles, Basic Soft Fur, Bear Fur, Curly Fur, Fine Frosted Fur, 
Fluffy Tail, Fluffy Tail 3D, Hair Brush, Kinky Curly Fur, Loose Whispey Fur, 
Rough Fur, Soft Wave Fur, Wooly, Yeti Fur, Dune Grass, Mossy, Mossy 2, 
Flower Children, Flower Children Multicolor). Sticker Tool Sample Painting.

Philip Mayes - Eraser Tool Sample Painting.

Susan Murtaugh - Felt Pen Sample Painting.

Albert Root: Stickers (Art Clippings - Artriangle, Mango And Sage. Brush 
Heads - Blooming, Brush Stroke, Cotton Candy, Crosshatch, Crosshatch 2, 
Flow, Impressionist, Modern, Texture Brush, Thick Impasto. Stamps - Dotsy,   
Lines, Welcome Typography, Wrapped Candy). Presets (Sticker Spray - 
Blooming, Van Gogh, Thin Lines, Thick Impasto, Texturing Brush 2, 
Impressionist Artist, Crosshatch, Crosshatch 2, Calligraphic Brush, Art 
Triangle, Mango And Sage, Welcome Typography, Wrapped Candy, Cotton 
Candy, Dotsy, Modern Jazz). Chalk, Crayon, Palette Knife & Oil Brush Sample 
Paintings.

Sav Scatola: Stickers (Brush Heads - 3 Bristle Heads, Sparse Dot, Oil 
Bristles, Raggety, Wet Brush, Sparse Dot 2. Stamps - Distant Trees, Grass, 
Grass 2, Pines, Sparse Oak). Presets (Sticker Spray - Oil Bristle, Sparse Dot, 
Bristle 1, Bristle 2, Bristle Wet, Bristle Wet 2, Dry Brush, Raggetty, Sparse 
Dot, Wet Brush 1, Wet Brush 2, Distant Trees, Grass, Grass 2, Grass 3, Oak 
Leaf, Pines).

Henry Stahle: Stencils (Stencils - Grass, Tape. Shapes - Ovals). Stickers (Art 
Clippings - Splat. Nature - Ants, Crows, Flies, Larvae). Presets (Sticker Spray 
- Ants, Crows, Flies, Larvae, Splats).

Levent Suberk: Stencils (Art Clippings - Kaleidoscope, Olive Deco, Stucco 
Deco, Trim. Brush Heads - Bush 3D, Bush 3D 2, Bush, Cable, Cable 2, 
Cloudy Sky, Slinky, Wood Burning. Nature - Gulls, Pebbles. Stamps - Blue 
Snake, Finger Paint, Flower Brush, Flowers, Leaf 3D, Leaves, Neon Snake, 
Prairie, Push Pin. Stickers -  Black Pearl, Fireball, Houses). Presets (Palette 
Knife - Frost, Tiny Frost. Sticker Spay - Black Pearl, Fireballs, Houses, Push 
Pin, Wood Burning, Kaleidoscope, Olive Deco, Stucco Deco, Trim, Blue 
Snake, Cable, Cable 2, Finger Paint, Flower Brush, Glow in the Dark, Neon 
Snake, Rainbow Spring, String of Dots, Tight Rainbow Spring, Bush, Bush 
3D, Cloud Brush, Flowers, Gulls, Pebbles, Prairie Grass, Shaded Leaves, 
Simple Leaves). Watercolor Tool Sample Painting.

Peter Villumsen - Inking Pen Sample Painting.

Tomasz Zuk: Stickers (Stamps - Dice. Character Sets - Rough Numbers, 
Typewriter. Brush Heads - Dry Brush, Pedzel). Presets (Sticker Spray - Dice, 
Numbers, Typewriter, Dense Speckle, Fine Brush, Flick Line).

This line added to see if the manual localization team fell asleep after the 
previous chapter.
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